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About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of Salesforce.com. Unlike a traditional release notes
document that includes only a simple list of enhancements, the Salesforce.com Release Notes give you everything you need
to get up and running with the new features and enhancements in the latest release.

What's Included in the Release Notes

For every new major enhancement, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practice tips to help you maximize the benefit of the functionality
• Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functional change included in the latest release—everything from email enhancements, to increased limits
for rules, to new supported languages, to search enhancements.

Let the Release Notes be your guide to success with the latest release from salesforce.com!

Your Feedback Matters

We know how important the Release Notes, online help, and documentation are to your company's success with Salesforce.com.
To continually improve the content we deliver to you, we want to know what works and what doesn't. Let us know!

• Feedback forms—Every HTML documentation page, both in the online help and in our developer guides at Developer
Force, includes a feedback form for you to submit your suggestions, corrections, and feedback about the documentation.
Let us know what you think!

• IdeaExchange—We're listening to your ideas too. Spring '10 includes some of your top ideas. Visit IdeaExchange for a
complete list of ideas coming in Spring '10.

• Documentation Enhancements on page 193—We're continually working to improve the documentation for you. Check
out these new and updated tip sheets and guides.

Want to be notified whenever we publish new documentation or make significant updates to existing documentation? Follow
us on Twitter: @salesforcedocs.

3

About the Release Notes

http://wiki.developerforce.com/index.php/Documentation
http://wiki.developerforce.com/index.php/Documentation
http://ideas.salesforce.com/
http://twitter.com/salesforcedocs


Summary of Spring '10 Features and Impact on
Salesforce.com Users

Spring '10 has features that immediately impact all users after the release. You may want to communicate these changes to
your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit
from the new functionality.

The following table summarizes the Spring '10 features and whether they will have an immediate impact on users. Review
the feature details for the applicable Salesforce.com Editions.

Sales Cloud Enhancements

Email

Contact
salesforce.com to

enable this
feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators.
No setup
required.

Automatically
visible to all users.

No setup
required.

Feature

Email Services—Converting Text
Attachments to Binary Attachments

Email Templates—Preview and Test Emails

Sending Email—Default Task Type

Global Visualforce Email Templates

Marketing Automation

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Campaign Member Responses Mass
Update When Campaign Advanced
Setup Status is Edited
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Opportunities, Products, Opportunity Products, Price Books, Schedules, and Quotes

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Quotes

New Opportunity Save Behavior for All
Organizations

Syncing with Quotes

Quotes Information on Custom Reports

Field-Level Security on Discount Field

Subtotals on Opportunity Products

Inline Editing for Opportunity Fields

Products Included in Professional
Edition

Opportunity Products Included in
Professional Edition

Price Books Included in Professional
Edition

Schedules Included in Professional
Edition

Salesforce CRM Content

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Apex Triggers for ContentVersion

Salesforce CRM Content Included in
New Organizations
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Salesforce Mobile

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Mobile Chatter—Limited Release

Mobile Lite Enhancements

Rich Text Area Fields—Beta

Salesforce Mobile for BlackBerry
Enhancements

Salesforce Mobile for iPhone
Enhancements

Salesforce to Salesforce and Partner Relationship Management

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Partner Portal Welcome Component for
Home Page Layouts

Partner Portal Users No Longer API
Enabled

Salesforce to Salesforce Enhancements:
Removal of Required Field Mappings
for Opportunities

Work with Portal Button

Portal Health Check

Other Sales Cloud Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Calendar & Activities Enhancements:
Branded Event Invitations
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Calendar & Activities Enhancements:
Enhanced Design for Event Invitations

Adding a Description to Attachments

Action Link Order Change

Service Cloud Enhancements

Salesforce CRM Call Center

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Available to
Enterprise and

Entitlement Management

Unlimited Editions
with the Service

Cloud.

Computer-Telephony Integration (CTI)
2.0: Custom Screen Pops

Community

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Answers
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Customer Portal

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Work with Portal Button

Portal Health Check

High Volume Customer Portal Users

Salesforce Knowledge

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Salesforce Knowledge in the Partner
Portal

Custom Report Types for Article Data

Setting an Article's Field-Level Security

File Field Support in the Article
Importer

Printable View for Articles

New API Object for Articles

Describe Calls for Data Categories

Metadata API Component for Data
Category Groups

SOQL and SOSL Clauses to Filter
Articles Based on their Categorization
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Other Service Cloud Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Work with Portal Button on Accounts
and Contacts

Category Group Visibility Settings for
Customer Portal and Partner Portal
Roles

Collaboration Cloud Enhancements

Salesforce Chatter

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Salesforce Chatter—Limited Release

Custom Cloud Enhancements

Administration and Sharing

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Enhanced Security for Custom Object
Permissions

Portal Health Check
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Analytics

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Available as
Developer Preview

only.

The New Report Builder—Developer
Preview

Custom Dashboard Tables

See a Dashboard's Running User

New Visibility Option for Report and
Dashboard Folders

Dashboard Finder Improvements

Updated Labels for Metric and Table
Dashboard Components

Apex and Visualforce

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Force.com Apex Code Enhancements

Debug Logs

Debug Log Filters

Monitoring Debug Logs

System Log Console

Visualforce Enhancements

Global Visualforce Email Templates
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Customization

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Deprecation of S-Controls

Sophisticated Data Modeling with
Multilevel Master-Detail Relationships

Rich Text Support—Beta

Lookup Filter Beta Enhancements

Increased Maximum Limit for Rules

Globalization and User Interface Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Translation Workbench Enhancements

Bulgarian and Greek—New Languages
Supported

Global Visualforce Email Templates

New User Interface Theme

Packaging

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Patch Updates for Packages—Limited
Release

Packageable Standard Action Overrides
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Search

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Enable Sidebar Search Auto-Complete

Enable Single-Search-Result Shortcut

Auto-Complete Enhancements

Security

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Salesforce.com Certificate and Key
Management

My Domain—Limited Release

Number of Remote Access Application
Authorizations Increased

No Framing Allowed on Login Page

Sites Doesn't Support SAML

Sites

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Workflow for Sites

Force.com Sites: Authenticated Sites
Generally Available
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Web Services API and Developer Tools

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Force.com Development as a Service

Sandbox to Production—Change Sets
Beta

Force.com Web Services API
Enhancements

Force.com Bulk API Enhancements

SOQL Enhancements

Adobe Flash Builder for Force.com
Developer Preview

Workflow and Outbound Messaging

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Increased Maximum Limit for Rules

Personalized Email Alerts

API Version Added to Outbound
Messages

Workflow for Sites
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Documentation Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

New: The Force.com Workbook

New: Developer Cheat Sheets

Update: Force.com Fundamentals

Update: Force.com Cookbook

Update: How to be Successful with
Salesforce.com

Update: Salesforce.com Style Guide for
Documentation and User Interface Text

Update: Salesforce.com Field Reference

Update: Syntax Highlighting and
Clipboard Copy for Developer Guides

Update: Documentation on Supported
Locales, Currencies, and Time Zones
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Quotes
Available in: Enterprise, Unlimited, and Developer Editions

A quote is a record showing proposed prices and other information for products and services. You can create a quote from an
opportunity and its products.

Each opportunity can have multiple associated quotes, and any one of them can be synced with the opportunity. When a quote
and an opportunity are synced, any change to line items in the quote will sync with products on the opportunity, and vice
versa.

When you're ready to send a quote to your customer, you can generate a PDF complete with your company's logo, and send
it by email.

You can also use Advanced Currency Management (ACM) with quotes. You can view converted currency amounts on quotes,
quote line items, and quote reports. Converted amounts don't appear on quote PDFs.

Implementation Tips

• The New Opportunity Save Behavior update must be activated before you enable Quotes. Salesforce.com will automatically
activate the new opportunity save behavior for all organizations on January 4, 2010.

• If you use quotes, you can't also use divisions. If you already have divisions enabled, you won't be able to use quotes at this
time.

• Field-level security is disabled by default for the Discount field on the Opportunity Product detail page. Enable field-level
security if you want to add the field to the page layout.

• If you already use a different quoting solution, phase out that product in stages so it's easier to migrate users to Salesforce.com
quotes and transfer your data.

• You can't use an Apex trigger to change an opportunity's SyncedQuote field. The field is currently read only.

Best Practices

• Users can sync a quote and an opportunity before the quote has line items or the opportunity has products. When they
add items to one record, the sync process updates the other.

• If users need approval before sending out quotes, set up a workflow to automate the process.
• If you use a logo for your quote PDFs, keep its size under 200K to maximize performance.

SALES CLOUD

15



About Quotes

Quotes Overview

Available in: Enterprise, Unlimited, and Developer Editions

A quote is a record showing proposed prices for products and services. You create a quote from an opportunity and its products.
You can create a set of quotes to show different combinations of products, discounts, and quantities so customers can compare
prices. Once you're satisfied with a quote, you can send it as a PDF.

Each opportunity can have multiple associated quotes, and any one of them can be synced with the opportunity. When a quote
and an opportunity are synced, any change to line items in the quote will sync with products on the opportunity, and vice
versa.

Enabling Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable or disable Quotes:

To enable Quotes for your organization:

1. Click Setup ➤ Customize ➤ Quotes ➤ Settings.
2. Select Enable Quotes.
3. Click Save.
4. Select Opportunity Layout to display the Quotes related list on the standard opportunity page layout.
5. Optionally, select Append to users' personal related list customization to add the Quotes related list

to all opportunity page layouts users have customized.
6. Click Save to finish.

Disabling Quotes

Select Disable Quotes to disable the feature for your organization.

Important: You can't disable quotes if your records have any references to quotes, quote line items, or quote PDFs
from any application customizations, including formula fields, triggers, workflow rules, and approval processes. You
must remove these references before you can disable quotes. You can't disable quotes if you have any quotes synced
with an opportunity. You must first stop syncing all quotes before you can disable the feature.
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Customizations
You can customize quotes and quote line items by clicking Setup ➤ Customize ➤ Quotes.

• Quotes—Customize the standard picklists, create custom fields and custom links, and control the layout of fields, related
lists, and custom links.

• Quote Line Items—(Located under Quotes) Customize the standard fields, create custom fields, and control the layout
of fields on quote line item pages.

These fields are currently unavailable in workflow formulas, validation rules, and formula fields.

• Quote Fields

- Account

- Grand Total

• Quote Line Item Fields

- Has Schedule

- List Price

- Subtotal

- Total Price

Note that the ListPrice field is not accessible in any Apex before trigger for the QuoteLineItem object.

Sample Workflow and Validation Rules
The following examples show how you can use workflow rules and validation formulas to manage the kind of quote data your
users can enter. The first uses a validation formula to ensure that users aren't allowed to create quote line items with discounts
larger than 40%. The second uses a workflow rule to alert the user's manager of the discount. For detailed instructions, see
“Defining Validation Rules” in the Salesforce.com online help and “Creating Workflow Rules” in the Salesforce.com online
help.

Display Error if Quote Line Item Discount Exceeds 40%

ValueField

Shows an error if a quote line item's discount exceeds 40%.Description:

Discount > .40Formula:

The discount on this quote line item cannot exceed 40%.Error Message:

Discount on quoteError Location:

Send Alert if Quote Line Item Discount Exceeds 40%

Object
Quote Line Item
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Description
Ensure that an email alert is sent if a sales rep applies a quote line item discount that exceeds 40%.

Evaluation Criteria
When a record is created, or when a record is edited and did not previously meet the rule criteria.

Rule Criteria (Filter)
Run this rule if the following criteria are met:

Quote Line Item: Discount is greater than 40

Immediate Actions
Email Alert: Notify the manager role that the quote line item discount exceeds 40%.

Creating Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotes.To view quotes:

“Create” on quotesTo create quotes:

To create a quote:

1. Click New Quote on the Quotes related list on an opportunity. The Subtotal, Discount, Total Price, and Grand
Total fields show values from the opportunity.

Note: The price book, products, and list prices must be active in the opportunity.

2. Enter a quote name.
3. In the Expiration Date field, enter the date when the quote will no longer be valid.
4. Enter taxes and shipping amounts as needed. The currency for these values comes from the opportunity.

For multicurrency organizations, the line item's currency is the same as the currency of the associated opportunity, which
is inherited from the product record. If the product currency is different from the user currency, currency-related fields
display both currencies: the product's currency is converted to the user's currency, and the converted amount appears in
parentheses.

5. Enter a contact name or click the lookup icon ( ) to select a contact. The quote shipping and billing addresses come from
the associated account.

6. Click Save when you're done. When you save a quote:

• A unique quote number is added.
• Any products on the opportunity are copied to the quote as line items.
• The grand total is recalculated based on any taxes or shipping information you entered.
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Enterprise, Unlimited, and Developer Edition organizations can activate record types and ask you to choose a Record Type
when creating a record. Record types determine the picklist values and business processes available when you create or edit a
record.

Displaying and Editing Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read” on Quotes

To change quotes:

Displaying Quotes

From the Quotes related list on an opportunity, click the quote number to display the quote. All quotes associated with
the opportunity appear in this list.

Tip: If your organization has enabled hover details, hover over any lookup field on the detail page to view key
information about a record before clicking into that record's detail page.

Editing Quotes

To update a quote, click Edit in any of these areas.

• On the quote detail page.
• Next to the quote in the Quotes related list of an opportunity.
• In the hover details for the quote in the Recent Items list.

Make changes as needed. Note that you can't change which opportunity is associated with the quote. Click Save when
you're done.

Note: If your organization enabled inline editing, you can edit fields directly on the detail page.

Related Lists

The related lists on a quote show key information related to the quote, including quote line items and the quote PDFs
that have been created and emailed. The related lists you see are determined by your personal customization, and by any
customization your administrator has made to page layouts or your permissions to view related data. You can click on
individual items to display additional detail. Click more at the bottom of the page or View More below a related list to
display more items. Clicking the New button lets you directly add new items. For example, clicking New Task lets you
directly add a new task.
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Note: If enabled by your administrator, related list hover links display at the top of each detail page. If Salesforce
Chatter is enabled, related list hover links display below feeds. Hover your mouse pointer over a related list hover
link to display the corresponding related list and its number of records. An interactive overlay allows you to
quickly view and manage the related list items. You can also click a related list hover link to jump to the content
of the related list without having to scroll down the page.

Printing Quotes

To open a printable display of all information for a record, click Printable View on the detail page.

Navigating Quotes

If your organization has enabled collapsible page sections, use the arrow icons next to the section headings to expand or
collapse each section on the detail page. See “Navigating” in the Salesforce.com online help for more information.

Quotes Fields

Available in: Enterprise, Unlimited, and Developer Editions

This table lists the fields (in alphabetical order) that make up a quote. Some of these fields may not be visible or editable
depending on your page layout, field-level security settings, and Salesforce.com edition.

Note:  If an opportunity product's currency is different from the user's currency in a multicurrency organization,
currency fields for quotes and quote line items appear in both currencies. the product's currency is converted to the
user's currency, and the converted amount appears in parentheses. Fields in quote custom reports appear in the report's
currency. Currency fields include Subtotal, Tax, and Grand Total.

DescriptionField

Name of account the quote's opportunity is linked to. (Read only)Account Name

Additional address field for use if needed. Not displayed on the page layout
by default.

Additional To

Name of the person or company associated with the additional address.Additional To Name

Billing address for the account associated with the quote.Bill To

Name of the person or company the quote is billed to.Bill To Name

Name of the contact associated with the quote. By default, this is the primary
contact on the opportunity.

Contact Name

User who created the quote and creation date and time. (Read only)Created By

Description of the quote or notes to help you differentiate between quote
versions.

Description

Weighted average of all line item discounts on the quote. Can be any positive
number up to 100.  (Read only)

Discount
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DescriptionField

Email address of the contact associated with the quote. If available,
automatically filled in when you add a contact.

Email

Date this quote is no longer valid.Expiration Date

Fax number for the contact associated with the quote. If available,
automatically filled in when you add a contact.

Fax

Total price of the quote plus shipping and taxes. (Read only)Grand Total

User who most recently changed the quote and modified date and time. (Read
only)

Last Modified By

Number of line items on the quote.Line Items

Name of the opportunity associated with the quote. (Read only)Opportunity Name

Phone number of the contact associated with the quote. If available,
automatically filled in when you add a contact.

Phone

Name of the quote.Quote Name

Automatically-generated number identifying the quote. (Read only)Quote Number

Address to send the quote to for approval, such as the address of a third-party
agency representing a buyer. Not displayed on the page layout by default.

Quote To

Name of the entity (such as a person or business) the quote is sent to for
approval.

Quote To Name

Name of the field that determines what picklist values are available for the
record. The record type may be associated with a sales process. Available in
Enterprise, Unlimited, and Developer Editions.

Record Type

Total shipping and handling costs for the quote.Shipping and Handling

Shipping address for the account associated with the quote.Ship To

Name of the entity (such as a person or company) the quote line items are
shipped to.

Ship To Name

Current status of the quote. The standard options are:Status

• —None—
• Draft
• Needs Review
• In Review
• Approved
• Rejected
• Presented
• Accepted
• Denied
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DescriptionField

Your administrator determines which status is the default for new quotes and
which statuses allow you to email a quote PDF.

Total of the quote line items before discounts, taxes, and shipping are applied.
(Read only)

Subtotal

Indicates whether the quote syncs with its associated opportunity. (Read
only.)

Syncing

Total taxes for the quote.Tax

Total of the quote line items after discounts and before taxes and shipping.
(Read only)

Total Price

Quote Line Item Fields

DescriptionField

User who created the line item and creation date and time. (Read only)Created By

Service, effective, or other date for the product.Date

Discount you apply to the line item. You can enter a number with or without
the percent symbol and you can use up to two decimal places.

Discount

User who most recently changed the line item and modify date and time.
(Read only)

Last Modified By

Description of the product in the line item.Line Description

Automatically system-generated number that identifies the line item. (Read
only)

Line Item Number

Price of the product within the price book including currency. (Read only)List Price

Name of the line item product as listed in the price book. (Read only)Product

Number of units of this line item's product included in the quote. Value must
be one or greater. If a quote is synced with an opportunity, this field is updated

Quantity

from the quote line item to the opportunity product. This field also appears
in the Products list on the Opportunity Forecast Edit page, if you use
forecasting for your opportunities.

Name of the quote the line item is for.Quote Name

Price you currently want to use for the product. Initially, the sale price for a
product added to an opportunity or quote is the product’s list price from the

Sales Price

price book, but you can change it here. If a quote is synced with an
opportunity, this field is updated from the quote line item to the opportunity
product. If a quote is synced with an opportunity, this field is updated from
the quote line item to the opportunity product. This field also appears in the
Products list on the Opportunity Forecast Edit page, if you use forecasting
for your opportunities.This field also appears in the Products list on the
Opportunity Forecast Edit page, if you use forecasting for your opportunities.
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DescriptionField

Indicates whether the line item uses schedules in the opportunity. Note that
default schedules are not carried over from the opportunity when opportunity
products are copied to a quote.

Schedule

Line item's sales price multiplied by the quantity.Subtotal

Line item's sales price multiplied by the quantity minus the discount.Total Price

Adding Line Items to Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read" on products and price books

To add quote line items:

To add line items to a quote:

1. Click Add Line Item in the Quote Line Items related list.
2. If no price book was selected on the opportunity, select a price book for the quote. Otherwise, the quote uses the opportunity's

price book.
3. Enter search criteria in the lookup to locate a line item.
4. Select the products you want to add and click Select.
5. Enter the correct values in the fields. The sales price defaults to the product's list price as recorded in the price book. The

sales price may be editable depending on your user profile. For multicurrency organizations, the line item's currency is the
same as the currency of the associated opportunity, which is inherited from the product record. If the product currency is
different from the user currency, currency-related fields display both currencies: the product's currency is converted to the
user's currency, and the converted amount appears in parentheses.

6. Click Save to save and exit, or Save & More to add more line items. The line items are added to the Quote Line Items
related list.The grand total in the detail section is the sum of the related line items, and the discount is the average discount
for the line items.

If the product has default schedules, the schedules are not created when you add the line item. If the line item is copied from
the opportunity, you can view the schedule from the opportunity. To change a schedule, edit the product record directly.

Note:

If this quote is synced with an opportunity, the new line item is copied to the opportunity as a product in the Products
related list.
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Editing Quote Line Items

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read" on products and price books

To edit or delete quote line items:

To edit a quote line item:

1. Click Edit next to the line item in the Quote Line Items related list. You can also click Edit All to edit all line items at
once.

2. Enter the correct values in the fields. The sales price defaults to the product's list price as recorded in the price book. The
sales price may be editable depending on your user profile.

For multicurrency organizations, the line item's currency is the same as the currency of the associated opportunity, which
is inherited from the product record. If the product currency is different from the user currency, currency-related fields
display both currencies: the product's currency is converted to the user's currency, and the converted amount appears in
parentheses.

If you have a quote line item that has a discount, you can't edit the Discount field if the product has either a default
schedule established on the product record or an individual schedule established on the opportunity product record.

3. Click Save. If the quote is synced with an opportunity, the opportunity product that corresponds to the quote line item is
updated with your changes.

Note: If an opportunity is syncing with a quote, and the quote record is locked by an approval process, you can't edit
the opportunity products.

Deleting Quote Line Items

If the quote is synced with an opportunity, deleting the quote line item also deletes the corresponding product from the
opportunity's Products related list.

To delete a line item:

• Click Del next to the line item in the quote's Quote Line Items related list.
• Click Delete on the quote line item's detail page.
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Quotes Syncing Overview

Available in: Enterprise, Unlimited, and Developer Editions

Quotes syncing is a process that lets you link a quote to the opportunity it was created from and synchronize all updates between
the two records. An opportunity can have multiple quotes, but it can only sync with one quote at a time.

While a quote and an opportunity are synced, any change to the products in one record syncs with the products in the other
one. So adding a line item to a quote updates the synced opportunity's Products related list, and adding a product to the
opportunity updates the synced quote's Quote Line Items related list. The quote and opportunity continue to sync each way
until you stop syncing or delete one of the records.

You can even sync quotes and opportunities that don't have any products. When you add a product to either record, it's
automatically added to the record it's synced to.

If you stop the sync between a quote and an opportunity, the link is broken and the records are no longer automatically updated
with each other's changes.

If an opportunity and a quote are synced, the opportunity identifies the synced quote in two places:

• The Synced Quote field on the Opportunity detail page.
• The Syncing checkbox in the Quotes related list.

Syncing Quotes and Opportunities

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on quotesTo sync quotes:

To sync a quote with an opportunity:

1. Open the quote you want to sync and click Start Sync.
2. In the dialog boxes, click Continue, Sync, then Done.

The quote and the opportunity are now linked for syncing, which takes place any time you add or update a quote line item or
opportunity product.The opportunity's Synced Quote field and Quotes related list identify the quote that's currently synced.

To stop sync between a quote and an opportunity, open the synced quote and click Stop Sync. Updates are no longer synced
between the records.

To sync a different quote with an opportunity, follow the steps for syncing a quote. The previously synced quote stops syncing
and the new quote starts.
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Creating Quote PDFs

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotesTo create quote PDFs:

To create a quote PDF:

1. Click Create PDF on the quote detail page. A preview of your PDF appears, listing all quote line items.
2. On the preview, click Save to Quote to save the PDF to the Quote PDFs related list or Save and Email Quote to save

the PDF to the quote and email it to the customer. The PDF name is the quote name plus a version number, such as
AcmeQuote_V1.

3. Click Email next to that version in the Quotes PDF related list to email the PDF to the customer, View to open the PDF
preview, or Del to permanently delete it. You can also print or save the PDF to your desktop using the toolbar in the PDF
preview.

Important:  In multicurrency organizations, converted currency amounts that appear in “quotes” in the Salesforce.com
online help and “quote line items” in the Salesforce.com online help don't appear in quote PDFs. Only the quote's
currency appears.

Adding a Logo to Quote PDFs

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on documentsTo upload new logos:

“Edit” on documentsTo replace logos:

To add your organization's logo to quote PDFs, upload the logo to the Shared Documents folder on the Documents tab. This
ensures that all users can access it. If you don't add a logo, quote PDFs display your organization's name.

Logo requirements:

• The unique name must begin with QUOTE_PDF_LOGO. The PDF will use the most recently modified logo that begins
with this unique name.

• The maximum logo height is 150 pixels. The logo will automatically scale to this height in the PDF.
• The maximum logo size is 5 MB. To reduce load time and limit PDF size, we recommend 200 KB or smaller.
• The logo must be in GIF, JPEG, or PNG format.
• For the best display on-screen, we recommend you use an image with a transparent background.
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• If you need to replace the logo image for quote PDFs, select the image on the Documents tab's Recent Documents related
list. On the Document Detail page, click Replace Document and upload the new file.

Emailing Quote PDFs

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotesTo email quote PDFs:

After you create a quote PDF, you can email it to the customer for approval. Note that the quote must have a status that allows
emailing.

To email a quote:

• Click Email Quote on the quote detail page.
• Click Save and Email Quote on the PDF preview.
• Click Email next to the PDF in the Quote PDFs related list.

The email opens with the latest PDF attached. You can change the attachments as needed. To email a previous version, you'll
need to click Email next to that version in the Quotes PDF related list. Enter body text and any other email addresses, and
then click Send.

Searching for Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotesTo view quotes

You can search for quotes by either name or number. To find specific quotes:

1. Enter the quote name or number in the Search box located in the sidebar.
2. Click Go!.

The search returns a list of quotes that match your search terms. The results you see are determined by the search layout
defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited, and Developer
Editions only).

3. From the list of search results, select a record to jump directly to that record or click Edit to edit it.
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Deleting Quotes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotesTo view quote lists:

“Delete” on quotesTo delete quotes:

You can delete a quote if you're an administrator, the quote owner, or a user above the quote owner in the organization role
hierarchy and you have the appropriate permissions.

You can delete a quote from:

• An opportunity—Open an opportunity, and in the Quotes related list, click Del next to the quote.
• The quote detail page—Open the quote and click Delete.

When you delete a quote, all related PDFs, notes, and attachments are deleted. If the quote is synced with an opportunity,
the record is removed from the opportunity's Quotes related list.The deleted quote is moved to the Recycle Bin. If you undelete
a previously synced quote, it will no longer be synced with the opportunity.

Products, Opportunity Products, Price Books, and
Schedules Included in Professional Edition

Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Spring '10, products, opportunity products, price books, and schedules are included in all Professional Edition organizations
at no additional cost. These objects are automatically available for organizations that subscribe during Spring '10 or later.
Existing organizations will be upgraded with Spring '10.

To learn more about products, opportunity products, price books, and schedules, see “Products, Price Books, and Schedules
Overview” in the Salesforce.com online help.

Salesforce Mobile Enhancements
Spring '10 includes many new features that improve the capabilities of Salesforce Mobile, including:

• Mobile Lite Enhancements
• Mobile Chatter—Limited Release
• Rich Text Area Fields—Beta
• Salesforce Mobile for BlackBerry Enhancements
• Salesforce Mobile for iPhone Enhancements
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To enjoy the Salesforce Mobile improvements, existing users must upgrade to the latest version of the mobile application.
New users must install the application. Refer to the user guides for installation and upgrade instructions:

• Salesforce Mobile User Guide for BlackBerry
• Salesforce Mobile User Guide for iPhone

About Salesforce Mobile Enhancements

Mobile Lite Enhancements

Available in: All Editions

With Spring ‘10, every Salesforce.com customer can enjoy free basic access to Salesforce.com from a mobile device regardless
of license type. Mobile Lite is now available in all Salesforce.com editions.

Additionally, you can create, edit, and delete supported standard object records in Mobile Lite. Previously, the Mobile Lite
client application was read-only.

If it has been enabled in your organization, Mobile Lite users also have access to their Salesforce Chatter feeds in the mobile
application.

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

For more information about Mobile Lite, see “Mobile Lite Overview” and “About the Default Mobile Configuration” in the
Salesforce.com online help.

Mobile Chatter—Limited Release

Available in: All Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Spring '10 introduces Salesforce Chatter, a social network inside Salesforce.com that lets people talk, collaborate, and share
information in real time.

If you're away from your desk, use Salesforce Chatter in the mobile application on your BlackBerry or iPhone to stay connected
with coworkers. An administrator must enable Salesforce Chatter for Salesforce Mobile users; Salesforce Chatter doesn't
require setup for Mobile Lite users.

Salesforce Chatter in the mobile application consists of the Chatter and People tabs. The feed that displays on the online
application's Home tab appears on the mobile application's Chatter tab.The Profile tab is not available in the mobile application,
although you can edit profile information from your mobile device using the People tab.
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Not all of the functionality in Salesforce Chatter is available from your mobile device. In the mobile application, you can:

• View and refresh feeds
• View coworkers' profiles
• Update your status
• View and edit your profile
• Post updates

In the mobile application, you can't:

• Follow or unfollow a person or record
• Upload profile photos
• View Following or Followers lists
• Attach files to posts
• View files attached to posts
• Attach links to posts (although you can type a URL in the body of a post)
• View feeds while working offline

Setting Up Salesforce Chatter for Mobile

Available in: All Editions

User Permissions Needed

“View Setup and Configuration”To view mobile configurations:

“Manage Mobile Configurations”To create, change, or delete mobile configurations:

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

You can set up the mobile application so that your users can talk, collaborate, and share information in real time with Salesforce
Chatter. Mobilizing feeds in your organization's mobile configurations enablesSalesforce Chatter in the mobile application.

To enable Salesforce Chatter for the mobile application:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and then click the name of a mobile configuration.
2. In the Data Sets related list, click Edit.
3. Click Add....
4. In the popup window, select Chatter, then click OK.
5. Enter the maximum number of updates across all feeds that this configuration can transfer to mobile devices:

a. The value defaults to 100, but you can enter any number up to 100.
b. Use the Order By drop-down list to specify which records are synchronized. You can order by the Last Feed

Activity Date or Created Date fields. Updates are sorted chronologically in descending order; you can't change
the sort order.
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If the limit is reached, Salesforce.com synchronizes the updates in accordance with the Order By and Sort settings. For
example, if the settings are Created Date and Descending, Salesforce.com transfers the most recently created updates
to mobile devices and removes the same number of updates that were least recently created.

6. Click Done when you're finished.
7. Optionally modify other mobile configurations and mobilize feeds.

Using Salesforce Chatter in the Mobile Application

Refer to the user guides to find out how to use Salesforce Chatter on your BlackBerry or iPhone:

• Salesforce Mobile User Guide for BlackBerry
• Salesforce Mobile User Guide for iPhone

Rich Text Area Fields—Beta
Spring '10 contains a beta version of the rich text area custom field type. The mobile application treats the new field type like
a long text area field, which doesn't support formatted HTML content and images. The mobile application truncates the field
at 1,000 characters, and the 1,000 character limit includes HTML markup.

Administrators should consider removing rich text area fields from mobile page layouts. If a mobile user edits a rich text area
field containing an existing text entry over 1,000 characters, the mobile application will truncate the text in the field. For
information about customizing mobile page layouts, see “Editing Mobile Object Properties” in the Salesforce.com online help.

Salesforce Mobile for BlackBerry Enhancements
Support for BlackBerry Operating System Version 5.0

Spring '10 offers support for version 5.0 of the BlackBerry operating system. Salesforce.com recommends installing the
latest version of the BlackBerry operating system offered by your cellular carrier prior to downloading the mobile
application.

To upgrade your device to the latest version of the operating system:

1. Visit the official list of cellular carriers on the BlackBerry website.
2. Click the link for your carrier under the appropriate region.
3. Follow the instructions to download and install the latest version of the BlackBerry Desktop Software.

You must upgrade the desktop software before upgrading the device software.The version of the BlackBerry Desktop
Software must match the operating system version you want to install on your device. For example, to upgrade your
device to version 4.5 of the BlackBerry operating system, install version 4.5 of the BlackBerry Desktop Software.

4. Connect your device to your computer.
5. Launch the BlackBerry Desktop Software.
6. Back up your device's data.
7. Upgrade the operating system. For specific instructions, refer to the product documentation for the BlackBerry

Desktop Software.
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New Minimum BlackBerry Operating System Requirement

In Spring '10, the new minimum operating system requirement for the mobile application is 4.3. Mobile users running
versions 4.0–4.3 of the operating system can still download and install the mobile application; however, the mobile server
will detect the older operating system and send version 11.6 of the mobile application, which was the last release that
supported operating system versions 4.0–4.3. Users on version 11.6 of the mobile application can't use any of the new
features included in the current release (version 11.7) or future releases.

WiFi Support

Spring '10 lets you take advantage of high-speed mobile connectivity. With the new WiFi support, you're no longer
tethered to a cellular data connection. You can download, activate, and use the mobile application with nothing more
than a WiFi connection.

Email Links to Records

Spring '10 tightens the integration between Salesforce Mobile and the BlackBerry email application. If you receive a
message in the BlackBerry email application that contains a link to a Salesforce.com record, you can use the link to open
the record in Salesforce Mobile. Click the link, then select Open in Salesforce from the menu.

If the record isn't available on your device, the mobile application prompts you to search for the record. If the object
isn't mobilized, you can launch the BlackBerry browser to view the record in Salesforce.com. Keep in mind that record
detail pages are not formatted for mobile devices, and they may not display correctly, particularly on devices running
older BlackBerry operating systems.

Note: You can't open content records or Salesforce Chatter updates from links in your email messages.

Activation Improvements

Spring '10 provides a more streamlined installation experience for BlackBerry users. A new activation screen presents
more information about what’s happening during the activation process. In cases where the signal strength is too low
for activation to occur, the mobile application listens to the radio signal and resumes the activation process when the
signal strength is sufficient for the activation to proceed.

Salesforce Mobile for iPhone Enhancements
Improved Search Capabilities

With Spring '10, every tab and every list view includes a new Filter and Search bar, making it easy to find a specific
record. For example, now you can quickly search for an account directly from the Accounts tab. As you type in the Filter
and Search bar box, the list of records is filtered to those that match. If you don't see the record you want, tap Continue
search on server....

If you need to search for a record across all objects on the device, use the Search tab.

Search for Related Items

Spring '10 provides an easy way to retrieve all the related records for a particular item. This feature is ideally suited for
Mobile Lite users who might not have all related contacts or opportunities on their device.

If you open a related list in the mobile application, the related item you want to view doesn't appear in the list, tap Search
server for more... to search online for additional related items. In the Search Results view, tap a record to open it. After
opening the record, it's automatically downloaded to your device.
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Encrypted Data Store

End-to-end data security has been enhanced in Spring '10. To protect data from attacks, the iPhone application
incorporates an encrypted data store (AES 128–bit encryption) that goes beyond the standard on-device security offered
by iPhones and iPods. The encrypted data store does not get synced to iTunes, which ensures data can't be compromised
from your computer. When combined with the encrypted data transport (AES 256–bit encryption) and the ability to
remotely erase data from a stolen device, your sensitive data remains secure.

Additional Sales Cloud Enhancements
Calendar & Activities Enhancements

Available in: All Editions

Group events not available in: Personal Edition

Branded Event Invitations

You asked for it! This enhancement is an idea from the IdeaExchange.

You can now show a custom logo in meeting request emails and on meeting response pages that invitees see when you
invite them to a group event.

When using a custom logo:

• The image must be in GIF, JPEG, or PNG format and be less than 20 KB.
• For best results, use an image that is no more than 130 pixels wide by 100 pixels high at 72 pixels per inch. Images

that are larger than these dimensions may not display correctly in some email clients due to automatic resizing.
• You must first upload your logo to the Documents tab and make it externally available. Documents marked Internal

Use Only can't be used as a logo.

Note:  If your custom logo is in the Shared Documents folder on the Documents tab, other users can replace
it and indirectly change the logo that appears in meeting invitations. We recommend uploading the logo to
your personal folder on the Documents tab so only you can replace it.

• You can't delete a custom logo from the Documents tab when it's being used in meeting requests. You must first
either select another document to use as your logo or uncheck the option to display a custom logo in meeting requests.

To enable this feature:

1. Go to Setup ➤ Customize ➤ Activities ➤ Activity Settings.
2. Select Show Custom Logo in Meeting Requests.
3. Click Save.

Enhanced Design for Event Invitations
When you enable branded event invitations, Salesforce.com now uses updated, more visually appealing invitations that
present a professional image to your customers when you invite them to a group event. The following example shows
the new design, which has been branded with the Universal Telco custom logo.
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Email Enhancements

Email Services—Converting Text Attachments to Binary Attachments

Available in: Enterprise, Unlimited and Developer Editions

Use of email services in installed AppExchange packages also available in: Group and Professional Editions

You can convert text attachments to binary attachments. See “Defining Email Services” in the Salesforce.com online
help.

Email Templates—Preview and Test Emails

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: All Editions

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

You can now send test emails and preview all email templates using information from records you chose. Previously, test
emails and previews were available for Visualforce email templates only. Additionally, all email templates now share the
enhanced look and feel of Visualforce email templates. See “Viewing Email Templates” in the Salesforce.com online
help.
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Sending Email—Default Task Type

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: All Editions

Mass email not available in: Personal, Contact Manager, and Group Editions

You can now specify the default Task Type assigned when sending emails and mass emails from the application and
the API:

1. Click Setup ➤ Customize ➤ Activities ➤ Task Fields.
2. Click the Type field.
3. Click Edit next to the appropriate picklist value, and select Send Email Default.
4. Click Save.

Global Visualforce Email Templates

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Spring '10 introduces Visualforce email templates translation based on, for example, the recipient user's language or the
language specified for an account.

To translate Visualforce email templates based on recipients' or related objects' languages, use the
<messaging:emailTemplate> tag's language attribute (valid values: Salesforce.com supported language keys, for
example, “en-US”). The language attribute accepts merge fields from the email template's recipientType and
relatedToType attributes. You create custom language fields for use in the merge fields. The translation workbench
is required to translate email templates.

This example uses a merge field to obtain a language attribute for the contact receiving the email:

<messagingmessaging:emailTemplate subject="Welcome to Dreamforce!" recipientType="Contact"
relatedToType="Account" language="{!recipient.language__c}">
<messaging:plainTextEmailBody>
{!$Label.greeting}
</messaging:plainTextEmailBody>
</messaging:emailTemplate>
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Campaign Enhancements

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Campaign Member Responses Mass Update When Campaign Advanced Setup Status is Edited
As before, campaign managers can configure whether a campaign member status value such as “Attended” or “RSVP”
counts as responded. Now, campaign members with that status automatically change when the status is edited by clicking
Advanced Setup on the campaign detail page and then clicking Edit. The Total Responses campaign statistic also
automatically updates.

Note: The following fields on campaign members change when you select or deselect the Responded checkbox
for a particular status value: Responded, Last Responded Date, and Last Modified. Use caution if you
rely heavily on these dates.

Notes & Attachments Enhancements

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Adding a Description to Attachments
You can now include a description when editing attachments on the Attachments related list of a case, solution, or
campaign, or on the Notes & Attachments related list of an account, contact, lead, opportunity, or custom object. The
description provides at-a-glance information for users who view the attachment's detail page.

Action Link Order Change
The order of the Action links on the Notes & Attachments related list is now Edit | View | Del.

Opportunities, Opportunity Products, and Quotes Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

New Opportunity Save Behavior for All Organizations
With the Spring '10 release, a new save behavior for opportunities has been rolled out to all Salesforce.com organizations.
Previously, you could make and save changes to child opportunities, opportunity products, or opportunity schedules
without activating rules or triggers for their associated parent records. Now, when you update one of these records,
Salesforce.com evaluates the triggers, validation rules, and workflow rules on the parent object as well as the child object.
This behavior is consistent for updates made through both the user interface and the API.

Syncing with Quotes

Each opportunity can have multiple associated quotes, and any one of them can be synced with the opportunity. When
a quote and an opportunity are synced, any change to line items in the quote will sync with products on the opportunity,
and vice versa.

Quotes Information on Custom Reports
You can now add quote and quote line item information to Opportunities custom reports.
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Field-Level Security on Discount Field
Field-level security is disabled by default for the Discount field on the Opportunity Product detail page. Enable
field-level security if you want to add the field to the page layout.

Subtotals on Opportunity Products
Opportunity products now include a Subtotal field. This field shows the difference between standard and discounted
pricing. Converted currency amounts when the opportunity's currency is different from the user's currency.

Inline Editing for Opportunity Fields
You can now edit the Stage,Forecast Category,Probability (%), and Private fields directly on detail pages.
See “Editing Data Using Inline Editing” in the Salesforce.com online help.

Partner Portal Enhancements

Available in: Enterprise and Unlimited Editions

Partner Portal Welcome Component for Home Page Layouts
Include the Partner Portal Welcome component on home page layouts assigned to partner portal users. When users log
in to your portal they receive a welcome message with their name, their channel manager's name, and links to both their
company and personal profiles. They can click the linked channel manager name to send an email to that person. When
portal users change information about themselves their user record is automatically updated but their contact record is
not.

To add the component to your partner portal home page:

1. Click Setup ➤ Customize ➤ Home ➤ Home Page Layouts.
2. Click Edit next to the page layout assigned to your partner portal users.
3. Select the Partner Portal Welcome component and click Next.
4. Arrange the selected components in the desired columns. Select the component and use the arrow keys to move it.
5. Optionally, click Preview to display the home page layout.
6. Click Save.

Note: The Partner Portal Welcome component is also available for the Customer Portal home page, however,
it only provides a welcome message with the user's name.

Partner Portal Users No Longer API Enabled
New partner portal users no longer have automatic access to the API. Administrators must enable access to the API for
each new user as needed.

To enable API access, edit the profile assigned to partner portal users and select the API Enabled checkbox.

Salesforce CRM Content Enhancements

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Apex Triggers for ContentVersion
To create triggers for the ContentVersion object, click Setup➤ Customize➤ Salesforce CRM Content➤ Triggers.
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Salesforce CRM Content Included in New Organizations
For new organizations that signed up during Spring 2010 or later, the Salesforce CRM Content feature license is included
at no additional cost.

Note: When Salesforce CRM Content is enabled, it is available in the app menu. Administrators enable access
to Salesforce CRM Content by selecting the Salesforce CRM Content User checkbox from Setup ➤
Manage Users ➤ Users and clicking Edit next to the user's name.

To set up Salesforce CRM Content for your organization, see “Setting Up Salesforce CRM Content” in the Salesforce.com
online help.

Salesforce to Salesforce Enhancements

Available in: All Editions

Removal of Required Field Mappings for Opportunities
In previous releases, the Close Date, Name, and Stage fields were required when publishing or subscribing to the
opportunity object. Additionally, subscribing connections could not unsubscribe from the fields or change their mappings.
In Spring '10, subscribing connections can unsubscribe from or change mappings for these opportunity fields. These
fields will still be required when publishing the opportunity object.
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Entitlement Management
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Salesforce.com takes customer service and support to a new level with Spring '10. Now, you can set up entitlement management
so that your support reps can verify if your customers are eligible for support. Additionally, users can create service contracts
for your customers and specify service levels, such as first response and resolution times. You can enforce service levels by
setting up time-dependent, automated processes that instruct reps on all the steps they must complete to resolve customer
issues. Plus, you can run reports to see how your support team is performing against its service level commitments.

Implementation Tips

• Before you set up entitlements, determine where you want support reps to validate support eligibility and how much detail
you want to include in your process. See “Getting Started with Entitlement Management” in the Salesforce.com online
help.

• Set field history tracking on entitlements, service contracts, and contract line items so that you can see when field values
changed. See “Tracking Field History” in the Salesforce.com online help.

• You can only use contract line items if your organization uses products. See “Products, Price Books, and Schedules Overview”
in the Salesforce.com online help.

• You can't create list views for contract line items. See “Creating Custom List Views” in the Salesforce.com online help.
• You can't share entitlements. If an entitlement has an account, its sharing is inherited from account sharing. See “Sharing

Accounts” in the Salesforce.com online help.
• You can't share contract line items. Sharing for contract line items is inherited from service contract sharing. For example,

users with the “Read” permission on service contracts inherit the “Read” permission on contract line items. See “Sharing
Service Contracts” in the Salesforce.com online help.

• If you want your customers or partners to access their entitlements or service contracts, add entitlements or service contracts
to your portals. See “Setting Up Your Customer Portal” in the Salesforce.com online help and “Setting Up Your Partner
Portal” in the Salesforce.com online help.

Don't add the following entitlement process fields to case page layouts for portal users because portal users shouldn't access
information related to your internal support processes:Entitlement Process Start Time,Entitlement Process
End Time, Stopped, and Stopped Since.

• If you use the Per Incident field to limit the number of cases entitlements support, we recommend setting field-level
security on the Cases Per Incident and Remaining Cases fields to read-only on the profiles of users who shouldn't
modify per incident support. See “Setting Field-Level Security” in the Salesforce.com online help.

• Customize entitlement, service contract, and contract line item fields to let users add additional information to them. See
“Customizing Fields” in the Salesforce.com online help.

• Entitlements don't automatically apply to cases created with Web-to-Case or Email-to-Case. If needed, you can add
entitlements to these features using Apex code. See “Capturing Web Cases” in the Salesforce.com online help, “Setting
Up Email-to-Case or On-Demand Email-to-Case” in the Salesforce.com online help, and “Force.com Apex Code
Overview” in the Salesforce.com online help.

• You can't add milestones to cases without using entitlement processes; entitlement processes apply milestones to cases.

SERVICE CLOUD
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• Merge fields for entitlements on cases aren't supported. For example, if you add the Entitlement Name
{!Case.Entitlement} merge field to an email template, the field is not populated on the template. See “Merge Fields
Overview” in the Salesforce.com online help.

Best Practices

• Set up lookup filters on cases to restrict the entitlements-related items returned. For example, when portal users create a
case and select the Entitlement Name field, they can choose only entitlements registered to their account or contact.
See “Setting Up Entitlements-Related Lookup Filters on Cases” in the Salesforce.com online help.

• Use Apex code to automatically mark milestones as Completed on cases that match unique criteria. For example, you can
create an Apex trigger on EmailMessage that marks a first response milestone as Completed on cases when support reps
send email from cases. See “Force.com Apex Code Overview” in the Salesforce.com online help and “Defining Apex
Triggers” in the Salesforce.com online help.

• Use the Mass Transfer Tool to transfer multiple service contracts from one user to another. See “Mass Transferring Records”
in the Salesforce.com online help.

• Customize the values for the Type field on entitlements to match the types of entitlements your team provides or sells.
For example, Web support or online training. See “Editing Fields” in the Salesforce.com online help.

• Add the Status Icon field to entitlements, service contracts, and contract line items page layouts so that users can easily
see one of these three statuses:

-  Active
-  Expired
-  Inactive

To add fields to page layouts, see “Customizing Page Layouts” in the Salesforce.com online help.
• Use sharing rules to give users access to service contracts they don't own; you can't extend the organization-wide default

sharing model for service contracts. See “Managing the Sharing Settings” in the Salesforce.com online help.
• If you use products, set up entitlement templates to predefine terms of support that users can add to products. See “Setting

Up Entitlement Templates” in the Salesforce.com online help.
• Set up entitlement processes to enforce all the steps that your support team must complete to resolve cases. See “Setting

Up Entitlement Processes” in the Salesforce.com online help.
• If you set up an entitlement process, you might want to activate it after you've added milestone actions to it. This is because

you can't update or delete milestone actions on a process after it's activated and applied to a case.

We recommend creating new entitlement processes to replace existing, active ones applied to cases.

• Contact salesforce.com for information on increasing the number of entitlement processes and milestones.
• Use custom report types to define report criteria from which users can run and create reports on entitlements and service

contracts. See “What is a Custom Report Type?” in the Salesforce.com online help and “Support Reports” in the
Salesforce.com online help.

• You can view cases with milestones by creating case list views that filter on milestone fields. See “Creating Custom List
Views” in the Salesforce.com online help.

• Use the entitlement process queue to view or cancel active entitlement process actions. See “Monitoring the Entitlement
Process Queue” in the Salesforce.com online help.
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About Entitlement Management

Entitlement Management Overview

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Entitlement management lets you and your support reps:

• Verify if your customers are eligible for support
• Create and maintain service contracts for your customers
• Specify unique service levels for each customer, such as first response and resolution times
• Enforce service levels with time-dependent, automated processes that instruct reps how to resolve cases

Entitlement Management Features

Entitlement management includes the following features to help you provide the correct service levels to your customers:

Verifying Entitlements
Support reps can verify that customers are eligible for support before creating cases for them. Here's an example of how
support reps use entitlements:

1. A customer calls support.
2. A support rep searches for the caller's account, contact, asset, or service contract.
3. The rep verifies there's an active entitlement on the Entitlements related list.
4. The rep creates a case from the entitlement.

Defining Service Levels
Users can create and maintain service contracts that represent different kinds of customer support, such as warranties,
subscriptions, or maintenance agreements. Each service contract can include the specific products covered under the
agreement.

Enforcing Service Levels
You can add time-dependent processes to entitlements that specify the actions your support team must take when service
levels on cases are near violation, violated, or successfully completed.

Providing Portal Access
You can add entitlement management to a Customer Portal or partner portal so that portal users can view their service
contracts and entitlements, and create cases with the correct entitlements.

Reporting on Entitlements and Service Levels
Administrators can use custom report types to define report criteria from which users can run and create reports on
entitlements and service contracts. See “What is a Custom Report Type?” in the Salesforce.com online help.

Important:  Only users in organizations with the Service Cloud can enable, create, and update entitlement management
items.
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Entitlement Management Terminology

The following terms are used when describing entitlement management functionality.

Entitlements
Entitlements help you determine if your customers are eligible for customer support so you can create cases for them. A
customer may be eligible for support based on a particular asset, account, or service contract. Depending on how
entitlements are set up, you can view and create them on the Entitlements tab or from the Entitlements related list on
accounts, contacts, assets, or service contracts. You can click Create Case on the Entitlements related list to create cases
that automatically include the correct entitlement, account, contact, and asset.

If set up, the Entitlements or Entitlement Template related lists let you add existing entitlements to contacts and products.

Entitlements don't automatically apply to cases created with Web-to-Case or Email-to-Case. If needed, you can add
entitlements to these features using Apex code. See “Force.com Apex Code Overview” in the Salesforce.com online help.

Entitlement Contact
Entitlement contacts are contacts specified to receive customer support. For example, a named caller. They're listed on
an entitlement's Contacts related list or the contact's Entitlements related list.

Entitlement contacts don't have page layouts, search layouts, buttons, links, or record types.

Entitlement Template
Entitlement templates are predefined terms of customer support that you can quickly add to products. For example, you
can create entitlement templates for Web or phone support so that users can easily add entitlements to products offered
to customers.

Service Contract
Service contracts are agreements between you and your customers for a type of customer support. Service contracts can
represent different kinds of customer support, such as warranties, subscriptions, or service level agreements (SLAs).

Depending on how service contracts are set up, you can view and create them on the Service Contracts tab or from the
Service Contracts related list on accounts and contacts.

Contract Line Item
Contract line items are specific products covered by a service contract. They only display to users on the Contract Line
Items related list on service contracts, not contracts. You can only use contract line items if your organization uses
products. See “Products, Price Books, and Schedules Overview” in the Salesforce.com online help. Schedules aren't
available for contract line items. Customer Portal users can't access contract line items.

Milestone
Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of
your customers. Examples of milestones include first response and resolution times on cases. Milestones can display one
of the following statuses on cases:

ExampleDescriptionMilestone Status

The first response on a case is complete
or not in violation.

Milestones on the case are complete or
not in violation.

New cases display as compliant because
they're not in violation.

 Compliant

The first response on a case is
incomplete.

Milestones on the case are violated;
steps in a support process are
incomplete.

 Open Violation
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ExampleDescriptionMilestone Status

The first response on a case was
incomplete, but completed nonetheless.

Milestones on the case were violated,
but the steps in the support process
were completed.

 Closed Violation

You can create a custom report to view a list of cases with milestones by choosing the Cases with Milestones report type
in the report wizard. You can also view cases with milestones by creating case list views that filter on milestone fields.
See “Creating Custom List Views” in the Salesforce.com online help.

Entitlement Process
Entitlement processes are timelines that include all of the steps (milestones) that your support team must complete to
resolve cases. Each process includes the logic necessary to determine how to enforce the correct service level for your
customers.

Not all entitlements require entitlement processes. For example, an entitlement might just state that a customer is eligible
for phone support and business hours define phone support to be 24/7. If you needed to add more to that definition,
you would use an entitlement process. For example, if certain people needed to be emailed after a customer's case went
unresolved after two hours.

Cases move through an entitlement process as follows:

1. A support rep adds an entitlement with an entitlement process to a case.
2. The case enters the process based on its creation date or a custom date/time field. A custom date/time field lets users

edit a date on the case to trigger when it enters the process.
3. Salesforce.com assigns milestones with matching criteria to the case. For example, if a milestone's criteria is Priority

equals High, and a case has a Priority of High, Salesforce.com assigns it to the Priority equals High milestone.

A case associates with one milestone at a time; it can associate with many milestones as it moves through the process.

4. Milestone actions determine when and if warning, violation, or success workflow actions fire for the case.
5. A support rep updates the case to complete a milestone action.
6. After a case is updated, it cycles through the entitlement process and initiates any milestones that match its criteria.
7. The case exits the process based on custom criteria or when it's closed.

Building an entitlement process includes:

1. Choosing an entitlement model.
2. Setting up milestones.
3. Setting up an entitlement process.
4. Adding milestones to the entitlement process.
5. Adding milestone actions to the entitlement process.
6. Adding the entitlement process to entitlements.

Entitlement processes only apply to cases with assigned entitlements.

You can view cases with assigned entitlements by creating case list views that filter on entitlement process fields. See
“Creating Custom List Views” in the Salesforce.com online help.

To view or cancel active entitlement processes, see “Monitoring the Entitlement Process Queue” in the Salesforce.com
online help.
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Milestone Actions
Milestone actions are time-dependent, workflow actions that occur at every step (milestone) in an entitlement process.
Examples of milestone actions include sending email alerts to specified users an hour before a first response is near
violation or automatically updating certain fields on a case one minute after a first response successfully completes.

You can add three types of actions to milestones:

DescriptionAction Type

The actions to take when a milestone successfully
completes.

 Success Actions

The actions to take when a milestone is near violation.Warning Actions

The actions to take when a milestone is violated.Violation Actions

You can automate the following actions for each action type:

ExampleDescriptionAutomation Type

Create a task for a support rep to call
a customer when a first response is
violated.

Assigns a task to a specific user. You
can specify the task's Subject,
Status, Priority, and Due Date.

Task

Notify case owners when their cases
are near violation of a first response.

Emails a specific template to a
designated recipient.

Email Alert

Update the case Priority field to
High when a first response is near
violation.

Changes the value of a selected field.
You can specify a value or create a
formula for the new value.

Field Update

Send data about parts or services to an
external system after a first response is
successful.

Sends a message to a designated
endpoint. You can also specify a
username and the data you want to
include in the message.

Outbound Message
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Getting Started with Entitlement Management

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up entitlements:

Before you set up entitlements, determine where you want support reps to validate eligibility and how much detail you want
to include in your process.

Where do you want support reps to verify that a contact or service contract is eligible for support?

You can set up entitlements so that users can view and create them from the Entitlements tab or from the Entitlements
related lists of these objects:

WhenAdd Entitlements to the Page Layouts of this Object

At least one contact in the account is eligible for support.Accounts

Specific contacts are eligible for support.Contacts

Specific assets (purchased products) are eligible for support.Assets

Support reps can verify that a specific service contract
includes support.

Service Contracts

The Entitlements related list has a Create Case link so users can create a new case that automatically includes the correct
entitlement. The case automatically includes any account, contact, or asset information from the entitlement.

How much detail do you want your entitlement management process to include?

Where you want support reps to verify entitlements helps determine the level of detail for your entitlement management
process. There are three models for managing entitlements, each with different levels of detail:

To Set UpUse IfYour GoalEntitlement Model

See “Setting Up Entitlements”
in the Salesforce.com online
help.

Support reps verify that
contacts are eligible for
customer support before they
create cases

Entitlements Only • There's no need to manage
your customers'
entitlements as part of a
service contract

• Your entitlements don't
have a renewal process

• Entitlements aren't
purchased by your
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To Set UpUse IfYour GoalEntitlement Model

customers; they're bundled
with products (warranties)

• Your customers'
entitlements are short term
and managed
independently of each
other

See “Setting Up Service
Contracts with Entitlements”

Support reps verify that a
contact is eligible for support
based on a service contract

Service Contracts with
Entitlements

• Entitlements are
purchased and managed
separately from the
products they cover and

in the Salesforce.com online
help.

are part of a service
contract

• Your customers'
entitlements are renewed
at a contract level

• Salesforce.com is used for
customer support but may
not be used for service
contract management

See “Setting Up Service
Contracts with Contract Line

Support reps verify that a
contact is eligible for support

Service Contract with
Contract Line Items and
Entitlements

• Salesforce.com is used for
customer support and to
manage your customers'
service contracts

based on line items in a service
contract

Items and Entitlements” in
the Salesforce.com online
help.• Your support team

manages service contract
transactions, such as
transfers, mergers, and
renewals

• Warranties, subscriptions,
or other support products
appear as line items on
your sales orders and map
to one or more
entitlements

• Entitlements are created
and updated through an
integration with your order
management system
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Setting Up Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up entitlements:

Before you set up entitlements, see “Getting Started with Entitlement Management” in the Salesforce.com online help to
determine which entitlement model is best for your support team.

To set up entitlements:

1. Enable entitlements:

a. Click Setup ➤ Customize ➤ Entitlement Management ➤ Settings.
b. Select Enable Entitlements and Save.

2. Customize entitlements fields.

This lets users add additional information to entitlements.

3. Customize entitlement page layouts.

This lets you specify which entitlement fields display to users. To limit the number of cases entitlements support, add these
fields to entitlement page layouts:

DescriptionField

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.Cases Per Entitlement

The number of cases the entitlement can support.This field
decreases in value by one each time a case is created with
the entitlement.

Remaining Cases

4. Customize case page layouts to add the Entitlement Name lookup field.

This lets users add entitlements to cases.

5. Customize account, contact, and asset page layouts to add the Entitlements related list.

This lets users verify entitlements and create cases that are automatically associated with the correct entitlement, account,
contact, and asset.

6. Set field-level security on entitlement fields.

This lets you choose which entitlement fields users can access.
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7. Add the Entitlements tab to an app.

This lets users view the Entitlements tab in a specific app.

8. Optionally:

• Customize related lists on entitlements to add Cases and Contacts.

This lets users:

- View cases and contacts associated with entitlements
- Create cases automatically associated with the correct entitlements
- Add contacts to entitlements

• Set up lookup filters on cases to restrict the entitlements-related items returned on cases.
• Set up entitlement templates to predefine terms of customer support that users can add to products.
• Set up milestones to define the required steps in your support process (such as first response and resolution times on

cases).
• Set up entitlement processes to enforce all of the steps (milestones) that your support team must complete to resolve

cases.

9. Create entitlements.

Setting Up Service Contracts with Entitlements

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up entitlements and service contracts:

Before you set up service contracts with entitlements, see “Getting Started with Entitlement Management” in the Salesforce.com
online help to determine which entitlement model is best for your support team.

To set up service contracts with entitlements:

1. Enable entitlements:

a. Click Setup ➤ Customize ➤ Entitlement Management ➤ Settings.
b. Select Enable Entitlements and Save.

2. Set up service contracts (click Setup ➤ Customize ➤ Entitlement Management ➤ Service Contracts):

a. Customize service contract fields.

This lets users add additional information to service contracts.

b. Customize service contract page layouts.

This lets you specify which service contract fields display to users.

c. Set field-level security on service contract fields.
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This lets you choose which service contract fields users can access.

d. Add the Service Contracts tab to an app.

This lets users view the Service Contracts tab in a specific app.

e. Customize account and contact page layouts to add the Service Contacts related list.

This lets users create, update, and verify service contracts from accounts and contacts.

f. Create service contracts.

3. Set up entitlements (click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlements):

a. Customize entitlements fields.

This lets users add additional information to entitlements.

b. Customize entitlement page layouts.

This lets you specify which entitlement fields display to users. To limit the number of cases entitlements support, add
these fields to entitlement page layouts:

DescriptionField

Lets you limit the number of cases the entitlement
supports.

Per Incident

The total number of cases the entitlement supports.Cases Per Entitlement

The number of cases the entitlement can support. This
field decreases in value by one each time a case is created
with the entitlement.

Remaining Cases

c. Customize case page layouts to add the Entitlement Name lookup field.

This lets users add entitlements to cases.

d. Customize account, contact, asset, and service contract page layouts to add the Entitlements related list.

This lets users verify entitlements and create cases that are automatically associated with the correct entitlement, account,
contact, and asset.

e. Set field-level security on entitlement fields.

This lets you choose which entitlement fields users can access.

f. Add the Entitlements tab to an app.

This lets users view the Entitlements tab in a specific app.

g. Optionally:

• Customize related lists on entitlements to add Cases and Contacts.

This lets users:

- View cases and contacts associated with entitlements
- Create cases automatically associated with the correct entitlements
- Add contacts to entitlements
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• Set up lookup filters on cases to restrict the entitlements-related items returned on cases.
• Set up entitlement templates to predefine terms of customer support that users can add to products.
• Set up milestones to define the required steps in your support process (such as first response and resolution times

on cases).
• Set up entitlement processes to enforce all of the steps (milestones) that your support team must complete to resolve

cases.

h. Create entitlements.

Setting Up Service Contracts with Contract Line Items and Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up service contracts and contract line items with
entitlements:

Before you set up service contracts with contract line items and entitlements:

1. Determine which entitlement model is best for your support team. See “Getting Started with Entitlement Management”
in the Salesforce.com online help.

2. Make sure your organization uses products. You can't use contract line items unless you're using products. See “Products
Home” in the Salesforce.com online help and “Products, Price Books, and Schedules Overview” in the Salesforce.com
online help.

To set up service contracts with contract line items and entitlements:

1. Enable entitlements:

a. Click Setup ➤ Customize ➤ Entitlement Management ➤ Settings.
b. Select Enable Entitlements and Save.

2. Set up service contracts (click Setup ➤ Customize ➤ Entitlement Management ➤ Service Contracts):

a. Customize service contract fields.

This lets users add additional information to service contracts.

b. Customize service contract page layouts.

This lets you specify which service contract fields display to users.

c. Set field-level security on service contract fields.

This lets you choose which service contract fields users can access.

d. Add the Service Contracts tab to an app.

50

Service Cloud Entitlement Management



This lets users view the Service Contracts tab in a specific app.

e. Customize account and contact page layouts to add the Service Contacts related list.

This lets users create, update, and verify service contracts from accounts and contacts.

f. Create service contracts.

3. Set up contract line items (click Setup ➤ Customize ➤ Entitlement Management ➤ Service Contracts ➤ Contract
Line Items):

a. Customize contract line item fields.

This lets users add additional information to contract line items.

b. Customize contract line item page layouts.

This lets you specify which contract line item fields display to users.

c. Customize service contract page layouts to add the Contract Line Items related list.

This lets users create, edit, and delete contract line items from service contracts.

Contract line items only display to users on the Contract Line Items related list on service contracts.

d. Set field-level security on contract line items.

This lets you choose which contract line item fields users can access.

e. Add contract line items to service contracts.

4. Set up entitlements (click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlements):

a. Customize entitlements fields.

This lets users add additional information to entitlements.

b. Customize entitlement page layouts.

This lets you specify which entitlement fields display to users. To limit the number of cases entitlements support, add
these fields to entitlement page layouts:

DescriptionField

Lets you limit the number of cases the entitlement
supports.

Per Incident

The total number of cases the entitlement supports.Cases Per Entitlement

The number of cases the entitlement can support. This
field decreases in value by one each time a case is created
with the entitlement.

Remaining Cases

c. Customize case page layouts to add the Entitlement Name lookup field.

This lets users add entitlements to cases.

d. Customize account, contact, asset, and service contract page layouts to add the Entitlements related list.

This lets users verify entitlements and create cases that are automatically associated with the correct entitlement, account,
contact, and asset.
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e. Set field-level security on entitlement fields.

This lets you choose which entitlement fields users can access.

f. Add the Entitlements tab to an app.

This lets users view the Entitlements tab in a specific app.

g. Optionally:

• Customize related lists on entitlements to add Cases and Contacts.

This lets users:

- View cases and contacts associated with entitlements
- Create cases automatically associated with the correct entitlements
- Add contacts to entitlements

• Set up lookup filters on cases to restrict the entitlements-related items returned on cases.
• Set up entitlement templates to predefine terms of customer support that users can add to products.
• Set up milestones to define the required steps in your support process (such as first response and resolution times

on cases).
• Set up entitlement processes to enforce all of the steps (milestones) that your support team must complete to resolve

cases.

h. Create entitlements.

Setting Up Milestones

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up milestones:

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include first response and resolution times on cases. See “Entitlement Management
Overview” in the Salesforce.com online help to learn how milestones work with entitlement processes to help your team resolve
cases.

Before setting up milestones, you must choose an entitlement model.

To set up milestones:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Milestones.
2. Click New Milestone.
3. Enter a name and description.

We recommend naming milestones after common support tasks such as First Response Time or Resolution
Time. This helps users understand milestones when they view them on cases or entitlement processes.

4. Click Save.
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5. Customize case page layouts to:

• Add these milestone fields:

DescriptionField

Shows a milestone's status on a case.Milestone Status

Shows a milestone's status on the case by displaying one
of the following icons:

Milestone Status Icon

-  Compliant
-  Open Violation
-  Closed Violation

See “Milestone” in the Salesforce.com online help.

• Add the Case Milestones related list. This lets users view milestones on cases.

You can customize the Case Milestone related list to add these fields:

DescriptionField

Shows the time required to complete a milestone.
Automatically calculated to include any business hours on
the case.

Elapsed Time

Shows the time that remains before a milestone violation.
Automatically calculated to include any business hours on
the case.

Time Remaining

Shows the time to complete the milestone. Automatically
calculated to include any business hours on the case.

Target Response

6. Optionally, create an entitlement process that includes the milestone.

Note: You can add time-dependent, workflow actions to milestones after they're added to entitlement processes. See
“Adding Milestone Actions to Entitlement Processes” in the Salesforce.com online help.
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Setting Up Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up entitlement processes:

Entitlement processes are timelines that include all of the steps (milestones) that your support team must complete to resolve
cases. Each process includes the logic necessary to determine how to enforce the correct service level for your customers. For
an example of how a case moves through an entitlement process, see the “definition of an entitlement process” in the
Salesforce.com online help.

You can set up entitlement processes after you:

1. Choose an entitlement model.
2. Set up milestones.

You can create up to 20 entitlement processes and include up to ten milestones in each entitlement process. Contact
salesforce.com for information on increasing the number of entitlement processes and milestones.

To set up an entitlement process:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlement Processes.
2. Click New Entitlement Process.
3. Enter a name and description.
4. Select Active to enable the process.

Tip: You may want to activate an entitlement process after you've added milestone actions to it. This is because
you can't update or delete milestone actions on a process after it's activated and applied to a case.

5. Choose the criteria for cases to enter and exit the entitlement process:

Additional Actions to Take?DescriptionField

No.Based on case created date

Select if cases should enter the
process when they're created.

Case enters the process

Yes, a drop-down list displays for
selecting the custom date/time. You can

Based on a custom date/time field
on the case

Select if you want the value of a
custom date/time field on the case

only choose a custom date/time, not a
custom date.

to determine when the case enters
the process.
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Additional Actions to Take?DescriptionField

No.Based on when case is closed

Select if cases should exit the
process when they're closed.

Case exits the process

Yes, select one of the following:Based on custom criteria

Select if cases should exit the
process based on criteria you
define.

• Choose criteria are met and
select the filter criteria that a case
must meet for it to exit the process.
For example, set a case filter to
Priority equals Low if you
want cases with the Priority field
marked Low to exit the process.

If your organization uses multiple
languages, enter filter values in your
organization's default language. You
can click the Advanced Options...
link to add up to 25 filter criteria,
up to 255 characters.

• Choose formula evaluates to
true and enter a formula that
returns a value of “True” or “False.”
Cases exit the process if the formula
returns “True.” For example, the
formula (Case: Priority
equals Low) AND(Case: Case
Origin equals Email, Web)
moves cases out of the process if
their Priority field is Low and
the Case Origin field is marked
Email or Web. For information on
using formulas, see “Building
Formulas” in the Salesforce.com
online help.

6. Click Save.
7. Optionally:

• Add milestones to the entitlement process.
• Customize case page layouts to add these fields:

DescriptionField

How far along a case is to reaching an entitlement process's
milestones. You can click or hover your mouse pointer over

Timeline
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DescriptionField

each milestone to view its details. Milestones are
represented by these icons:
-

 Completed milestone
-

Violated milestone

You can drag the Handle icon ( ) along the Timeline
Zoom tool to view past and future milestones.

When adding the Timeline field to case page layouts,
click the wrench icon ( ) next to it and select Show
label so the field name displays on cases.

The time the case entered an entitlement process. You can
update or reset the time if you have the “Edit” permission
on cases. When you reset the time:

Entitlement Process Start Time

- Closed or completed milestone's aren't affected
- Incomplete milestones are recalculated based on the

new start time

The time the case exited an entitlement process.Entitlement Process End Time

Lets you stop an entitlement process on a case. This may
be necessary if you're waiting for a customer's response.

Stopped

Shows the date and time an entitlement process was
stopped on a case.

Stopped Since

Note: Entitlement processes only apply to cases with assigned entitlements.
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Adding Milestones to Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To add milestones to entitlement processes:

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include first response and resolution times on cases. Use milestones in entitlement processes
to enforce the steps in your support process.

You can add milestones to entitlement processes after you:

1. Choose an entitlement model.
2. Set up milestones.
3. Set up entitlement processes.

You can create up to 20 entitlement processes and include up to ten milestones in each entitlement process.

To add milestones to entitlement processes:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlement Processes.
2. Click the name of an entitlement process.
3. Click New on the Milestones related list.
4. Choose the milestone.
5. In Time Trigger (Minutes) enter the number of minutes users need to complete the milestone before it triggers an

action.
6. Enter the order to process the milestone if a case matches the criteria of more than one milestone in an entitlement process.

For example, 1, 2, 3. Use this if you have similar milestones, such as first response and first response with a case Priority
of high.

Cases can only match one milestone at a time in an entitlement process.

7. Enter the criteria a case must match for the milestone to apply to it:

• Choose criteria are met and select the filter criteria that a case must meet for a milestone to apply to it. For
example, set a case filter to Priority equals High if you want the milestone to apply to cases with the Priority
field marked High.

If your organization uses multiple languages, enter filter values in your organization's default language. You can click
the Advanced Options... link to add up to 25 filter criteria, up to 255 characters.

• Choose formula evaluates to true and enter a formula that returns a value of “True” or “False.” The milestone
applies to cases if the formula returns “True.” For example, the formula (Case: Priority equals High) AND
(Case: Case Origin equals Email, Web) applies the milestone to cases where the Priority field is High
and the Case Origin field is marked Email or Web. For information on using formulas, see “Building Formulas” in
the Salesforce.com online help.

8. Click Save.
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9. Optionally:

• Customize entitlements page layouts to add the Milestones related list.This lets users view milestones on entitlements.
• Add actions to milestones in the entitlement process.

Note: The Timeline field shows you any milestones added to the entitlement process:

•

The Milestone icon ( ) represents milestones.
• Click or hover your mouse pointer over each milestone to view it's details.
•

Drag the Handle icon ( ) along the Timeline Zoom tool to view past and future milestones.

Adding Milestone Actions to Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To add milestone actions to entitlement processes:

Milestone actions are time-dependent, workflow actions that occur at every step (milestone) in an entitlement process. Examples
of milestone actions include sending email alerts to specified users an hour before a first response is near violation or automatically
updating certain fields on a case one minute after a first response successfully completes. See “Milestone Actions” in the
Salesforce.com online help for the types of actions and automated processes you can add to milestones.

Before you can add milestone actions to entitlement processes, you must:

1. Choose an entitlement model.
2. Set up milestones.
3. Set up entitlement processes.
4. Add milestones to entitlement processes.

To add milestone actions to entitlement processes:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlement Processes.
2. Click the name of an entitlement process.
3. Click the name of a milestone on the Milestone related list.
4. Add actions to the milestone:
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ExampleToClick Add Workflow Action and
Select

Create a task for a support rep to call a
customer when a first response is
violated.

Create a taskNew Task

Notify case owners when their cases are
near violation of a first response.

Create an email alertNew Email

Update the case Priority field to
High when a first response is near
violation.

Define a field updateNew Field Update

Send data about parts or services to an
external system after a first response is
successful.

Define an outbound messageNew Outbound Message

Use an existing email alert to notify a
case owner when their case is near
violation of a first response.

Select an existing actionSelect Existing Action

Note: To make warning and violation actions time-dependent, add a time trigger first.The time trigger for success
actions is the time trigger on the milestone.

The Add Workflow Action button initially displays on the Success Actions section. It displays in the Warning Actions
and Violation Actions sections after you add time triggers to them.

• Click Add Time Trigger to add a time trigger to the milestone.

Time-triggered actions only occur during your organization's business hours.

• Click Add Workflow Action under a time trigger to add time-dependent actions.

You can add up to ten actions and ten time triggers to each type of milestone action.

Optionally:

• Click Edit next to any action or time trigger to modify it.
• Click Remove next to any action to remove it from the entitlement process. This removes the milestone action from

the entitlement process but does not delete the milestone action.
• Click Delete next to any time trigger to remove it from the milestone. This deletes the time trigger and removes its

actions from the entitlement process but does not delete the milestone actions. The actions are still available when you
click Add Workflow Action and choose Select Existing Action.
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Monitoring the Entitlement Process Queue

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To manage the entitlement process queue:

When Salesforce.com triggers an entitlement process that has time-dependent milestone actions, use the entitlement process
queue to view pending actions and cancel them, if necessary.

To view pending actions:

1. Click Setup ➤ Monitoring ➤ Entitlement Processes.
2. Click Search to view all pending actions for any active workflow rules, or set the filter criteria and click Search to view

only the pending actions that match the criteria. The filter options are:

Entitlement Process Name

The entitlement process.

Case Number

The case's automatically-generated identifying number.

Milestone Name

The milestone that triggered the action.

Evaluation Date

The date the evaluated actions are scheduled to occur.

Created Date

The creation date of the case that triggered the entitlement process.

Username

The user who updated the case to trigger an entitlement process.

The filter is not case-sensitive. See “Entering Filter Criteria” in the Salesforce.com online help.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel. Optionally, check the box in the column header to select all
currently displayed items.

2. Click Delete.
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Using the Case Milestones Related List

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on casesTo view case milestones:

“Edit” on casesTo edit case milestones:

The Case Milestones related list on a case detail page displays a list of milestones that automatically apply to the case due to
an entitlement process. Milestones are required steps in your support process. They're metrics that represent service levels to
provide to each of your customers. Examples of milestones include first response and resolution times on cases.

The Case Milestones related list displays the following:

No records to display

Message that displays if no milestones apply to the case.

Action

Lists the actions you can perform on the milestone. For example, if you have the “Edit” permission on cases, you can
click Edit to select the milestone completion date.

Note: Customer Portal users can't edit case milestones.

Milestone

The name of a set of steps in an entitlement process that applies to the case. Users with the “Manage Entitlements”
permission can click a milestone's name to view the entitlement process, case criteria, time triggers, and actions associated
with it.

The following table lists the types of actions associated with milestones:

DescriptionAction Type

The actions to take when a milestone successfully
completes.

 Success Actions

The actions to take when a milestone is near violation.Warning Actions

The actions to take when a milestone is violated.Violation Actions

Administrators can set up milestones to automate the following for each action type:
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ExampleDescriptionAutomation Type

Create a task for a support rep to call
a customer when a first response is
violated.

Assigns a task to a specific user. You
can specify the task's Subject,
Status, Priority, and Due Date.

Task

Notify case owners when their cases
are near violation of a first response.

Emails a specific template to a
designated recipient.

Email Alert

Update the case Priority field to
High when a first response is near
violation.

Changes the value of a selected field.
You can specify a value or create a
formula for the new value.

Field Update

Send data about parts or services to an
external system after a first response is
successful.

Sends a message to a designated
endpoint. You can also specify a
username and the data you want to
include in the message.

Outbound Message

Target Date

The date and time to complete the milestone.

Completion Date

The date and time the milestone was completed.

Target Response

Shows the time to complete the milestone. Automatically calculated to include any business hours on the case. Displays
if set up by your administrator.

Time Remaining

Shows the time that remains before a milestone violation. Automatically calculated to include any business hours on the
case. Displays if set up by your administrator.

Elapsed Time

Shows the time required to complete a milestone. Automatically calculated to include any business hours on the
case.Displays if set up by your administrator.

Violation

Icon ( ) that indicates a milestone violation.

Completed

Icon ( ) that indicates a milestone completion.

Completed milestones remain on a case even if they no longer apply. This is because they're part of the case's history.
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Setting Up Entitlement Templates

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up entitlement templates:

Entitlement templates are predefined terms of customer support that you can quickly add to products. For example, you can
create entitlement templates for Web or phone support so that users can easily add entitlements to products offered to customers.

Choose an entitlement model before you set up entitlement templates. You can use entitlement templates without setting up
the service contracts with contract line items and entitlements model.

To set up entitlement templates:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Entitlements ➤ Templates.
2. Click New Template.
3. Enter the details:

DescriptionField

The name of the entitlement template.

We recommend using a descriptive name, such as Phone
Support. This helps users better understand entitlement
templates when they see them on related lists for products.

Entitlement Template Name

The number of days the entitlement is in effect.Term (Days)

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the
steps (milestones) that your support team must complete to

Entitlement Process

resolve cases. Each process includes the logic necessary to
determine how to enforce the correct service level for your
customers.

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The entitlement's supported business hours.Business Hours

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type

4. Click Save.
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5. Customize product page layouts to add the Entitlement Templates related list.

Optionally, you can customize the Entitlement Templates related list to add the Type and Business Hours fields. This
lets users view the type of entitlement, such as Web or phone support, and any business hours that apply to the entitlement.

6. Click Save.

Setting Up Entitlements-Related Lookup Filters on Cases

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up entitlement-related lookups on cases:

You can set up lookup filters on cases to restrict the entitlements-related items returned. For example, when portal users create
a case and select the Entitlement Name field, they can choose only entitlements registered to their account or contact. See
“About Lookup Filters” in the Salesforce.com online help.

To set up entitlement-related lookup filters on cases:

1. Click Setup ➤ Customize ➤ Entitlement Management ➤ Settings.
2. Choose the item(s) you'd like returned in the lookup fields.

To ReturnClickLookup Field on Cases

Assets registered to the account on the
case.

Same account on the caseAsset

Assets registered to the contact on the
case.

Same contact on the case

Assets associated with entitlements that
belong to the case's account.

Entitlements on the cases'
account

Assets associated with entitlements
related to the case's contact.

Entitlements on the case's
contact

Entitlements with an Active Status.Active statusEntitlement

Entitlements associated with the
account on the case.

Same account on the case

Entitlements associated with the asset
on the case.

Same asset on the case

Entitlements associated with the contact
on the case.

Same contact on the case
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Choosing multiple items acts as an AND function. For example, choosing Same account on the case and Same
contact on the case restricts items returned in the Asset field to assets registered to the account and contact on
the case.

Tip:  Choose items that match how your support reps verify support eligibility. For example, choose the
account-related items if your support reps verify support based on accounts.

3. Click Save.

Creating Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Create” on entitlementsTo create or clone entitlements:

Entitlements specify if a contact or account is eligible to receive customer support.

To create entitlements:

1. Click New on the Entitlements tab or New Entitlement from the Entitlements related list on accounts, assets, or service
contracts.

Your administrator determines where you can create entitlements.

Note:

• To add existing entitlements to contacts, click Add Entitlements on the Entitlements related list.
• To add entitlement templates to products, click Add Entitlement Template on the Entitlement Templates

related list.

You can't create new entitlements on contacts or products.

2. Enter the following details:

DescriptionField

The name of the account associated with the entitlement.

To quickly find an asset in the lookup dialog box, select
criteria from the Filter by fields. Administrators can set
lookup filters to restrict filter values and results.

Account Name

The name of the asset associated with the entitlement.

Assets represent specific products purchased by customers.
See “Assets Overview” in the Salesforce.com online help.

Asset Name
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DescriptionField

The entitlement's supported business hours.

Business hours on a case take precedence over business hours
on entitlements. Business hours on entitlements only add

Business Hours

business hours to cases created from entitlements. For
example, if you add an entitlement with business hours to a
case that already has business hours, the entitlement's
business hours are ignored.

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The name of the contract line item (product) associated with
the entitlement.

Contract Line Item

The last day the entitlement is in effect.End Date

The entitlement's name.

We recommend using a descriptive name , such as Phone
Support. This helps users better understand entitlements

Entitlement Name

when they see them on related lists for accounts, contacts,
and assets.

The name of the service contract associated with the
entitlement.

To quickly find a service contract in the lookup dialog box,
select criteria from the Filter by fields. Administrators
can set lookup filters to restrict filter values and results.

Service Contract

The first day the entitlement is in effect.Start Date

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the
steps (milestones) that your support team must complete to

Entitlement Process

resolve cases. Each process includes the logic necessary to
determine how to enforce the correct service level for your
customers.

The number of cases the entitlement can support.This field
decreases in value by one each time a case is created with
the entitlement.

This field is only available if Per Incident is selected.

Remaining Cases

The entitlement's status.Status
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DescriptionField

Represents the entitlement's status by displaying one of the
following icons:

Status Icon

•  Active
•  Expired
•  Inactive

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type

3. Click Save.

Tip:  Click Clone on an entitlement to quickly create a new entitlement from an existing one. This helps you create
multiple entitlements for a customer.

Verifying Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

You may have to verify that contacts are eligible to receive customer support, or that a service contract includes an entitlement,
before you create or update cases. Depending on how entitlements are set up, you can verify them from these locations:

Steps To VerifyTo Confirm ThatVerify Entitlements From

A specific entitlement is available.Entitlements tab
1. Click the Entitlements tab.
2. Click an entitlement name.

At least one contact in the account is
eligible for support.

Accounts
1. View an account.
2. Confirm that an entitlement is on the

Entitlements related list.

Specific contacts are eligible for support.Contacts
1. View a contact.
2. Confirm that an entitlement is on the

Entitlements related list.
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Steps To VerifyTo Confirm ThatVerify Entitlements From

Specific assets (purchased products) are
eligible for support.

Assets
1. Locate an asset from a related list or

an assets list view on the Products
tab.

2. Click the asset name.
3. Confirm that an entitlement is on the

Entitlements related list.

A specific service contract includes
customer support.

Service contracts
1. Click the Service Contracts tab.
2. Click a service contract name.
3. Confirm that an entitlement is on the

Entitlements related list.

Note:  After you verify an entitlement, you can click Create Case to create a new case associated with the entitlement.
The case automatically includes any account, contact, or asset information from the entitlement.

Displaying and Editing Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

“Edit” on entitlementsTo change entitlements:

Displaying Entitlements

To view an entitlement's details, use the Entitlements tab, list pages, or the Entitlements related list on:

• Accounts
• Contacts
• Assets
• Service contracts

The Entitlements related list shows all the entitlements associated with that item.

To view an entitlement template's details, use the Entitlement Templates related list on products.

Your administrator determines where you can view entitlements and entitlement templates.

Editing Entitlements

To update an entitlement, click Edit, change the fields, and click Save.
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If your organization enabled inline editing, you can edit fields directly on the detail page.

Entitlements Related Lists

The lower portion of an entitlement displays information related to it, including cases, contacts, milestones, history,
activities, notes, and attachments.

You can click:

• Items to display their details
• Show [number] more to increase the number of items in the list
• Go to list to display a page with the entire list.

Sharing

You can't share entitlements. If an entitlement has an account, its sharing is inherited from account sharing.

Printing Entitlements

To open a printable display of all information for a record, click Printable View on the detail page.

Deleting Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on entitlementsTo delete entitlements:

To delete an entitlement, click Del next to the entitlement on the entitlement list page, or click Delete on the entitlement
detail page.

Deleting an entitlement moves it to the Recycle Bin. Any notes, attachments, or activities associated with the entitlement are
also deleted. If you undelete the entitlement, any associated items are undeleted.

Note:

• The Del link and Delete button only display for users with the “Delete” permission on entitlements.
• You can't delete an entitlement with an active or closed case.
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Using the Entitlements Related List

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on accounts, contacts, assets, or service contractsTo view entitlements on accounts, contacts, assets, or service
contracts:

“Edit” on accounts, contacts, assets, or service contractsTo edit entitlements on accounts, contacts, assets, or service
contracts:

“Create” on casesTo create cases:

“Edit” on entitlementsTo change entitlements:

The Entitlement related list displays a list of entitlements that apply to accounts, contacts, assets, or service contracts.
Entitlements help you determine if your customers are eligible for customer support. You can use entitlements to verify if you
can create cases for a customer.

Administrators determine an Entitlements related list's availability and contents. The following options and information
display by default:

New Entitlement

Click this button to add a new entitlement to an account, contact, asset, or service contract.

Action

The actions you can perform on the entitlement:

• Click Create Case to create a new case that automatically includes the correct entitlement, account, contact, or asset.
• Click Edit to change the entitlement.
• Click Del to remove the entitlement.

Entitlement

The entitlement's name. Click to view the entitlement's details.

Start Date

The first day the entitlement is in effect.

End Date

The last day the entitlement is in effect.

Status

The entitlement's status.
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Entitlement Fields

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here are an entitlement's fields. Some of these fields may not be visible or editable depending on your page layout and field-level
security settings. (Field-level security is available in Enterprise, Unlimited, and Developer Editions.)

DescriptionField

The name of the account associated with the entitlement.

To quickly find an asset in the lookup dialog box, select criteria
from the Filter by fields. Administrators can set lookup
filters to restrict filter values and results.

Account Name

The name of the asset associated with the entitlement.

Assets represent specific products purchased by customers.
See “Assets Overview” in the Salesforce.com online help.

Asset Name

The entitlement's supported business hours.

Business hours on a case take precedence over business hours
on entitlements. Business hours on entitlements only add

Business Hours

business hours to cases created from entitlements. For example,
if you add an entitlement with business hours to a case that
already has business hours, the entitlement's business hours
are ignored.

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The name of the contract line item (product) associated with
the entitlement.

Contract Line Item

The last day the entitlement is in effect.End Date

The entitlement's name.

We recommend using a descriptive name , such as Phone
Support. This helps users better understand entitlements

Entitlement Name

when they see them on related lists for accounts, contacts, and
assets.
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DescriptionField

The name of the service contract associated with the
entitlement.

To quickly find a service contract in the lookup dialog box,
select criteria from the Filter by fields. Administrators can
set lookup filters to restrict filter values and results.

Service Contract

The first day the entitlement is in effect.Start Date

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the steps
(milestones) that your support team must complete to resolve

Entitlement Process

cases. Each process includes the logic necessary to determine
how to enforce the correct service level for your customers.

The number of cases the entitlement can support. This field
decreases in value by one each time a case is created with the
entitlement.

This field is only available if Per Incident is selected.

Remaining Cases

The entitlement's status.Status

Represents the entitlement's status by displaying one of the
following icons:

Status Icon

•  Active
•  Expired
•  Inactive

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type

Creating Service Contracts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Create” on service contractsTo create or clone service contracts:

Service contracts are agreements between you and your customers for a type of customer support.

To create service contracts:
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1. Click New on the Service Contracts tab or New Service Contract from the Service Contracts related list on accounts or
contacts.

Your administrator determines where you can create service contracts.

2. Enter the following details:

DescriptionField

The name of the account that purchased or owns the service
contract.

Account Name

The initial day the service contract went into effect (whereas
Start Date may include a renewal date).

Activation Date

An approval process status field. See “Approval Processes
Overview” in the Salesforce.com online help.

Approval Status

City portion of billing address. Up to 40 characters are
allowed in this field.

Billing City

Country portion of billing address. Up to 40 characters are
allowed in this field.

Billing Country

State or province portion of billing address. Up to 20
characters are allowed in this field.

Billing State

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip

Name of the contact associated with the service contract.
Select from the drop-down list.

Contact Name

Name of the service contract.Contract Name

Automatically-generated number identifying the service
contract. (Read only)

Contract Number

User who created the service contract. (Read only)Created By

The date the service contract was created (whereas
Activation Date is the initial day the service contract

Created Date

went into effect and Start Date may include a renewal
date).

The currency for all amount fields in the service contract.
Available only for organizations that use multiple currencies.

You can't change the currency on a service contract that has
contract line items.

Currency

Description of the service contract. Up to 32 KB of data are
allowed in this field.

Description

Weighted average of all contract line item discounts on the
service contract. Can be any positive number up to 100.
(Read only)

Discount
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DescriptionField

The last day the service contract is in effect.End Date

Total price of the service contract plus shipping and taxes.
(Read only)

Grand Total

User who most recently changed the service contract. (Read
only)

Last Modified By

Number of contract line items (products) on the service
contract.

Line Items

Assigned owner of the service contact.Service Contract Owner

Total shipping and handling costs for the service contract.Shipping and Handling

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City

Country portion of primary mailing or shipping address. Up
to 40 characters are allowed in this field.

Shipping Country

State or province portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping State

Primary mailing or shipping street address of account. Up
to 255 characters are allowed in this field.

Shipping Street

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip

Any terms that you have specifically agreed to and want to
track in the service contract.

Special Terms

The first day the service contract is in effect.Start Date

The status of the service contract.Status

Represents the service contract's status by displaying one of
the following icons:

Status Icon

•  Active
•  Expired
•  Inactive

Total of the service contract line items (products) before
discounts, taxes, and shipping are applied. (Read only)

Subtotal

Total taxes for the service contract.Tax

Number of months that the service contract is in effect.Term (months)

Total of the contract line items (products) after discounts
and before taxes and shipping. (Read only)

Total Price

3. Click Save.
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Tip:  Click Clone to quickly create a new service contract from the existing one. This helps you create multiple service
contracts for a customer.

Displaying and Editing Service Contracts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

“Edit” on service contractsTo change service contracts:

Displaying Service Contracts

To view a service contract's details, click a service contract on the Service Contracts tab, list pages, or the Service Contracts
related list on:

• Accounts
• Contacts

The Service Contracts related list shows all the service contacts associated with that item.

Your administrator determines where you can view service contracts.

Editing Service Contracts

To update a service contract, click Edit, change the fields, and click Save.

If your organization enabled inline editing, you can edit fields directly on the detail page.

Service Contracts Related Lists

The lower portion of a service contract displays information related to it, including entitlements, contract line items,
history, activities, notes, and attachments.

You can click:

• Items to display their details
• Show [number] more to increase the number of items in the list
• Go to list to display a page with the entire list.

Sharing

Click Sharing to share a service contract with other users, groups, or roles. See “Sharing Service Contracts” in the
Salesforce.com online help.

Printing Service Contracts

To open a printable display of all information for a record, click Printable View on the detail page.
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Deleting Service Contracts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on service contractsTo delete service contracts:

To delete a service contract, click Del next to the service contract on the service contract list page, or click Delete on the
service contract detail page.

Deleting a service contract moves it to the Recycle Bin. Any notes, attachments, activities, or contract line items associated
with the service contract are also deleted. If you undelete the service contract, any associated items are undeleted.

Note:

• The Del link and Delete button only display for users with the “Delete” permission on service contracts.
• You can't delete service contracts with active or expired entitlements.

Using the Service Contracts Related List on Accounts or Contacts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on accountsTo view service contracts on accounts:

“Read” on contactsTo view service contracts on contacts:

“Create” on service contractsTo create service contracts:

“Edit” on service contractsTo change service contracts:

The Service Contracts related list displays a list of service contracts that apply to accounts or contacts. Service contracts are
agreements between you and your customers for a type of customer support.

Administrators determine the Service Contracts related list's availability and content. The following options and information
display by default:

New Service Contract

Click this button to create a new service contract for an account or contact.

Action

The actions you can perform on the service contract:

• Click Edit to update a service contract.
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• Click Del to delete a service contact.

Contract Number

Automatically-generated number identifying the service contract.

Start Date

The first day the service contract is in effect.

End Date

The last day the service contract is in effect.

Status

The status of the service contract.

Sharing Service Contracts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

Your administrator sets the default sharing model for your organization. You can extend sharing to more users than the default
set by your administrator. However, you can't make the sharing model more restrictive than the default.

To view and manage sharing details, click Sharing on a service contract's detail page. The Sharing Detail page lists the users,
groups, roles, and territories that have sharing access to the service contract. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom view. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

Note:  Users must have the “Read” permission on service contracts for you to share service contracts with them.

• Click Expand List to view all users that have access to the record.
• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

Service Contract Fields

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here's a service contract's fields. Some of these fields may not be visible or editable depending on your page layout and field-level
security settings. (Field-level security is available in Enterprise, Unlimited, and Developer Editions.)
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DescriptionField

The name of the account that purchased or owns the service
contract.

Account Name

The initial day the service contract went into effect (whereas
Start Date may include a renewal date).

Activation Date

An approval process status field. See “Approval Processes
Overview” in the Salesforce.com online help.

Approval Status

City portion of billing address. Up to 40 characters are allowed
in this field.

Billing City

Country portion of billing address. Up to 40 characters are
allowed in this field.

Billing Country

State or province portion of billing address. Up to 20 characters
are allowed in this field.

Billing State

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip

Name of the contact associated with the service contract. Select
from the drop-down list.

Contact Name

Name of the service contract.Contract Name

Automatically-generated number identifying the service
contract. (Read only)

Contract Number

User who created the service contract. (Read only)Created By

The date the service contract was created (whereas
Activation Date is the initial day the service contract went
into effect and Start Date may include a renewal date).

Created Date

The currency for all amount fields in the service contract.
Available only for organizations that use multiple currencies.

You can't change the currency on a service contract that has
contract line items.

Currency

Description of the service contract. Up to 32 KB of data are
allowed in this field.

Description

Weighted average of all contract line item discounts on the
service contract. Can be any positive number up to 100. (Read
only)

Discount

The last day the service contract is in effect.End Date

Total price of the service contract plus shipping and taxes.
(Read only)

Grand Total

User who most recently changed the service contract. (Read
only)

Last Modified By
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DescriptionField

Number of contract line items (products) on the service
contract.

Line Items

Assigned owner of the service contact.Service Contract Owner

Total shipping and handling costs for the service contract.Shipping and Handling

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City

Country portion of primary mailing or shipping address. Up
to 40 characters are allowed in this field.

Shipping Country

State or province portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping State

Primary mailing or shipping street address of account. Up to
255 characters are allowed in this field.

Shipping Street

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip

Any terms that you have specifically agreed to and want to
track in the service contract.

Special Terms

The first day the service contract is in effect.Start Date

The status of the service contract.Status

Represents the service contract's status by displaying one of
the following icons:

Status Icon

•  Active
•  Expired
•  Inactive

Total of the service contract line items (products) before
discounts, taxes, and shipping are applied. (Read only)

Subtotal

Total taxes for the service contract.Tax

Number of months that the service contract is in effect.Term (months)

Total of the contract line items (products) after discounts and
before taxes and shipping. (Read only)

Total Price
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Adding Contract Line Items

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Edit” on service contracts

AND

“Create” on contract line items and “Read” on products and
price books

To add contract line items to service contracts:

Contract line items are specific products covered by a service contract.

To add contract line items to service contracts:

1. Click Add Line Item from the Contract Line Items related list on service contracts. See “Displaying and Editing Service
Contracts.” in the Salesforce.com online help

2. Select a price book.
3. Select one or more products.
4. Enter the attributes for each product.

Your administrator may have customized this page to include fields specific to your business.

5. Enter the Sales Price for the product.

The Sales Price is automatically filled in with the List Price specified in the price book. Depending on your user profile,
you may be able to override this value.

6. Optionally, enter the number of products at this price in the Quantity field.
7. Click Save.
8. Optionally, edit the contract line item to update the following fields:

DescriptionField

Name of the asset associated with the contract line item.

Products represent the items your company sells whereas
assets represent the specific products your customers have
purchased.

Asset Name

User who created the contract line item. (Read only)Created By

The date the contract line item was created.Created Date

Description of the contract line item. Up to 32 KB of data
are allowed in this field. Only the first 255 characters display
in reports.

Description
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DescriptionField

Discount you apply to the contact line item. You can enter
a number with or without the percent symbol and you can
use up to two decimal places.

Discount

The last day the contract line item is in effect.End Date

User who most recently changed the contract line item.
(Read only)

Last Modified By

Automatically-generated number that identifies the contract
line item. (Read only)

Line Item Number

Price of the contract line item (product) within the price
book including currency. (Read only)

List Price

The name of the contract line item (product) as listed in the
price book.

Product

Number of units of the contract line item (product) included
in the service contract.

Value must be one or greater.

Quantity

Price to use for the contract line item.

Initially, the sale price for a contract line item (product)
added to an opportunity or quote is the contract line item’s
list price from the price book, but you can change it here.

Sales Price

Name of the service contract associated with the contract
line item.

Service Contract

Start date of the contract line item.Start Date

The status of the contract line item.Status

Represents the contract line item's status by displaying one
of the following icons:

Status Icon

•  Active
•  Expired
•  Inactive

Contract line item's sales price multiplied by the quantity.Subtotal

Contract line item's sales price multiplied by the quantity
minus the discount.

Total Price
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Displaying and Editing Contract Line Items

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on contract line itemsTo view contract line items:

“Edit” on contract line itemsTo change contract line items:

Displaying Contract Line Items

To view a contract line item's details, click a service contract on the Service Contracts tab, list pages, or the Service
Contracts related list on:

• Accounts
• Contacts

The Contract Line Items related list shows all the contract line items associated with a service contract.

Your administrator determines if contract line items display on service contracts.

Editing Contract Line Items

To update a contract line item, click Edit, change the fields, and click Save.

Contract Line Items Related Lists

The lower portion of a contract line item displays information related to it, including entitlements, history, activities,
notes, and attachments.

You can click:

• Items to display their details
• Show [number] more to increase the number of items in the list
• Go to list to display a page with the entire list.

Sharing

You can't share contract line items. Sharing for contract line items is inherited from service contract sharing. For example,
users with the “Read” permission on service contracts inherit the “Read” permission on contract line items.

Printing Contract Line Items

To open a printable display of all information for a record, click Printable View on the detail page.
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Deleting Contract Line Items

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on contract line itemsTo delete contract line items:

To delete a contract line item, click Del next to the contract line item on the service contract list page, or click Delete on the
contract line item detail page.

Deleting a contract line item moves it to the Recycle Bin. Any notes, attachments, or activities associated with the contract
line item are also deleted. If you undelete the contract line item, any associated items are undeleted.

Note: The Del link and Delete button only display for users with the “Delete” permission on service contracts.

Using the Contract Line Items Related List

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contracts

AND

“Read” on contract line items

To view contract line items:

“Edit” on service contracts

AND

“Create” on contract line items and “Read” on products and
price books

To add contract line items:

“Edit” on contract line itemsTo change contract line items:

The Contract Line Items related list displays a list of products covered by a service contract. Service contracts are agreements
between you and your customers for a type of customer support.

Administrators determine the Contract Line Item related list's availability and contents.The following options and information
display by default:

Add Line Item

Click this button to add a contract line item (product) to the service contract.
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Action

The actions you can perform on the contract line item:

• Click Edit to change the contract line item.
• Click Del to remove the contract line item.

Line Item Number

Automatically-generated number that identifies the contract line item.

Product Name

The product's name. Click to view the product's details.

Start Date

The first day the service contract is in effect.

End Date

The last day the service contract is in effect.

Status

The status of the service contract.

Asset Name

Name of the asset associated with the contract line item.

Products represent the items your company sells whereas assets represent the specific products your customers have
purchased.

Quantity

Number of units of the contract line item (product) included in the service contract.

Sales Price

Price to use for the contract line item (product).

Contract Line Item Fields

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here's a contract line item's fields. Some of these fields may not be visible or editable depending on your page layout and
field-level security settings. (Field-level security is available in Enterprise, Unlimited, and Developer Editions.)

DescriptionField

Name of the asset associated with the contract line item.

Products represent the items your company sells whereas assets
represent the specific products your customers have purchased.

Asset Name

User who created the contract line item. (Read only)Created By
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DescriptionField

The date the contract line item was created.Created Date

Description of the contract line item. Up to 32 KB of data are
allowed in this field. Only the first 255 characters display in
reports.

Description

Discount you apply to the contact line item. You can enter a
number with or without the percent symbol and you can use
up to two decimal places.

Discount

The last day the contract line item is in effect.End Date

User who most recently changed the contract line item. (Read
only)

Last Modified By

Automatically-generated number that identifies the contract
line item. (Read only)

Line Item Number

Price of the contract line item (product) within the price book
including currency. (Read only)

List Price

The name of the contract line item (product) as listed in the
price book.

Product

Number of units of the contract line item (product) included
in the service contract.

Value must be one or greater.

Quantity

Price to use for the contract line item.

Initially, the sale price for a contract line item (product) added
to an opportunity or quote is the contract line item’s list price
from the price book, but you can change it here.

Sales Price

Name of the service contract associated with the contract line
item.

Service Contract

Start date of the contract line item.Start Date

The status of the contract line item.Status

Represents the contract line item's status by displaying one of
the following icons:

Status Icon

•  Active
•  Expired
•  Inactive

Contract line item's sales price multiplied by the quantity.Subtotal

Contract line item's sales price multiplied by the quantity
minus the discount.

Total Price
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Computer-Telephony Integration (CTI) 2.0: Custom Screen
Pops

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Salesforce CRM Call Center seamlessly integrates Salesforce.com with third-party computer-telephony systems. With Spring
'10, developers and partners can use a new CTI Developer's Toolkit to build more robust CTI adapters for call center users.

Implementation Tips

• Users' browsers handle CTI 2.0 settings differently if you update SoftPhone layouts so that screen pops open in a new
browser windows or tabs:

- Internet Explorer 6.0 always displays screen pops in new windows.
- Internet Explorer 7.0 displays screen pops based on what users select in its tabs settings.
- Firefox 3.5 displays screen pops based on what users select in its tabs settings.

Best Practices

• Use CTI 2.0 to pass information from inbound calls to specific Visualforce pages. Adapters using CTI 2.0 can send
Visualforce pages the ANI (or caller ID) of the caller, the DNIS (the number that the caller dialed), and any additional data
attached to the call's URL. For example, if your call center prompts customers to enter their ZIP codes, you can configure
your telephony system so that the ZIP codes attach to calls and automatically populate Visualforce pages when they arrive
at your support reps' phones. See “Visualforce Overview” in the Salesforce.com online help.

About Computer-Telephony Integration (CTI) 2.0

Salesforce.com CTI Toolkit Overview

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Developers use a CTI (computer-telephony integration) toolkit provided by salesforce.com to build CTI adapters that integrate
Salesforce.com with third-party CTI systems. The CTI Toolkit helps developers build CTI adapters that Salesforce CRM
Call Center users install on their machines so they can use the features of a CTI system through the Salesforce.com SoftPhone.

There are two versions of the CTI Toolkit. Each version provides users with different Salesforce CRM Call Center functionality.
However, salesforce.com only distributes CTI Toolkit version 2.0 or higher.The following table lists the functionality available
in CTI adapters built with each CTI Toolkit:

Version 2.0 or HigherVersion 1.0 or HigherFunctionality

Change the fields and order of fields that
display in a SoftPhone
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Version 2.0 or HigherVersion 1.0 or HigherFunctionality

Change the objects and order of links to
objects that display in a SoftPhone

Specify the fields that display in the
SoftPhone if a single record for a
particular object is found

Specify screen pop settings for inbound
calls with single, multiple, or no record
matches

Specify screen pops for inbound calls to
display in browser windows that are
already open, or in new browser windows
or tabs

Specify screen pops to Visualforce pages
for inbound calls

Specify screen pops to search pages for
inbound calls with multiple record
matches

View a call center's version in a Version
field (click Setup➤Customize➤Call
Center➤Call Centers and choose a call
center.)

For information on customizing and building CTI adapters, see the CTI Toolkit Developer's Guide.

Partners and developers can download the CTI Toolkit by visiting developer.force.com. The CTI Toolkit provides you with
all of the source code, libraries, and files you need to develop your own custom CTI adapter.

Checking the Version of Your CTI Adapter

Available in: Professional, Enterprise, Unlimited, and Developer Editions

To check which version of the CTI adapter you've installed on your machine:

1. Run the CTI adapter from where it's installed. For example, from the Start menu, select All Programs➤ salesforce.com
➤ CTI Adapter 2.0 ➤ Salesforce.com Adapter 2.0.

2. Right-click the  icon in the system tray of your computer. The system tray is located next to the clock in the lower-right
corner of your screen.

3. Click About...

The version of your CTI adapter displays under CTI Connector.
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Designing a Custom SoftPhone Layout

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view, create, edit, or delete a SoftPhone layout:

In a SoftPhone layout you can control the call-related fields that are displayed and the Salesforce.com objects that are searched
for an incoming call. To design a custom SoftPhone layout:

1. Click Setup ➤ Customize ➤ Call Center ➤ SoftPhone Layouts.
2. Click New to create a new SoftPhone layout definition, or click Edit next to the name of an existing layout definition to

view or modify it.
3. In the Name field, enter a label that uniquely identifies your SoftPhone layout definition.
4. In the Select Call Type picklist, choose the type of call for which the currently displayed SoftPhone layout should

be used. Every SoftPhone layout definition allows you to specify different layouts for inbound, outbound, and internal
calls. These three layouts are grouped together in a single SoftPhone layout definition.

5. In the Display these call-related fields section, click Edit to add, remove, or change the order of fields in
the currently-displayed SoftPhone layout:

• To add a field to the SoftPhone layout, select it in the Available list and click Add.
• To remove a field from the SoftPhone layout, select it in the Selections list and click Remove.
• To change the order of a field in the SoftPhone layout, select it in the Selections list and click Up or Down.

Any changes that you make are automatically updated in the SoftPhone layout preview image on the right side of the page.
To hide the Available and Selections lists, click Collapse.

Phone-related fields only appear in a user's SoftPhone if a valid value for that field is available. For example, if you add a
Caller ID field to the layout of an outbound call, Caller ID will not appear.

6. In the Display these Salesforce.com Objects section, click Add/Remove Objects to add, remove, or change
the order of links to call-related objects.

7. Below the list of selected objects, click Edit next to each If single <Object> found, display row to specify the
fields that should be displayed in the SoftPhone layout if a single record for that object is the only record found. You can
add, remove, or change the order of fields.

8. In the Screen Pop Settings section (for inbound call types), click Edit next to each type of record-matching row to
specify which screens should display when the details of an inbound call match or don't match existing record(s) in
Salesforce.com. The following table describes each record-matching row and its screen pop options:

Screen Pop OptionsDescriptionRecord-Matching Row

Existing browser window

Select to display in open browser
windows.

Use to set where screen pops display.Screen pops open within
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Screen Pop OptionsDescriptionRecord-Matching Row

New browser window or tab

Select to display in new browser
windows or tabs.

Users' browsers may handle these
settings differently:

• Internet Explorer 6.0 always displays
screen pops in new windows.

• Internet Explorer 7.0 displays screen
pops based on what users select in
its tabs settings.

• Firefox 3.5 displays screen pops
based on what users select in its tabs
settings.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
don't match any existing Salesforce.com
records.

No matching records

Pop to new

Select to display a new record page
you specify from the drop-down
list.

Pop to Visualforce page

Select to display a specific
Visualforce page.

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed).The
URL can pass additional data to
the Visualforce page if necessary.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
match one existing Salesforce.com
record.

Single-matching record

Pop detail page

Select to display the matching
record's detail page.

Pop to Visualforce page

Select to display a specific
Visualforce page.
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Screen Pop OptionsDescriptionRecord-Matching Row

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed).The
URL can pass additional data to
the Visualforce page if necessary.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
match more than one existing
Salesforce.com record.

Multiple-matching records

Pop to search page

Select to display a search page.

Pop to Visualforce page

Select to display a specific
Visualforce page.

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed).The
URL can pass additional data to
the Visualforce page if necessary.

To hide expanded record-matching rows, click Collapse.

This section only displays if your CTI adapter was built using the CTI Developer's Toolkit 2.0 or higher.

9. Configure SoftPhone layouts for any remaining call types in the Select Call Type picklist.
10. Click Save.

Note:  Some Salesforce CRM Call Center features that are described in this help system may not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.
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Answers

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: Enterprise, Unlimited, and Developer Editions

Answers is the newest feature of the Community application that lets community members ask questions, post replies, and
vote whether they like or dislike a reply.

About Answers

What is Answers?

Available in: Enterprise, Unlimited, and Developer Editions

Answers provides the following features:

Asking Questions to the Answers Community

Users can ask questions and monitor the replies to see if another community member provides relevant information that
resolves their question.

Replying to Questions

Community members can reply to questions and add to the general knowledge within the community. Other community
members can vote whether they like or dislike the reply, and the user who asked the question can choose the reply as the
best answer.

Categorizing Questions

Answers supports Data Categories for organizing and controlling access to questions. For more information, see “Data
Categories” in Terminology on page 92.

Choosing the Best Answer to a Question

After a user asks a question, they can monitor the replies posted by other community members and eventually choose
one of the replies as the best answer to their question. The best answer is highlighted directly below the question so it's
easy to find, which helps community members quickly identify the most useful resolution to the question.

Voting for Replies

Users can contribute to the answers community by identifying the replies they like and dislike. When other community
members look for an answer to a question, they can quickly look at the number of “likes” and “dislikes” a reply has received
and make a more informed decision about which reply to read.
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Viewing a List of All Your Questions and Replies

Once a user becomes an active community member, they can view a list of all the questions they asked and replies they
posted by clicking My Questions & Replies at the top of any page in the Answers tab.

Finding Answers to Questions

To make it easy for community members to find answers to their questions, they can select a category and view all
associated questions, filter questions to show only open or resolved questions, sort questions by newest, oldest and recent
activity, or use the search for questions.

Implementation Tips

• Only one community can be displayed in the Answers tab at a time.
• Only one category group can be assigned to answers.
• Workflow rules and custom fields are not supported.
• You can't use Force.com Sites to publicly expose the Answers tab.
• You can't create a question validation rule based on a category because the category field isn't available for the question

object in the validation rule editor.
• Microsoft® Internet Explorer 6.0 is not supported.

Best Practices

• When creating a category group for answers, we recommend naming the category group the same as the answers community
so other administrators understand where the category group is being used.

Terminology

Answers
Answers is a feature of the Community application that enables users to ask questions and have community members
reply with answers. Community members can then vote on the helpfulness of each reply, and the person who asked the
question can mark one reply as the best answer.

Best Answer
When a member of an answers community asks a question and other community members post a reply, the asker can
mark one of the replies as the best answer. The best answer then appears directly under the question (above the other
replies). Identifying the best answer helps other community members with the same question quickly find the most
relevant, useful information.

Community
Communities help organize ideas and questions into logical groups with each community having its own focus and
unique ideas and questions. Professional Edition organizations can have only one internal ideas community. All other
editions can have up to 50 communities shared between ideas and answers.

Community Application
The Community application includes the ideas and answers features. The Community app is available in the Force.com
app menu.

Data Category for Answers
On the Answers tab, data categories allow users to classify questions in an answers community. For example, if you have
an answers community for hardware products, your data categories may include laptops, desktops, and printers. Community
members can quickly browse within a specific category to find answers to their questions. Administrators can use data
categories to control access to questions.
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Idea
Ideas are suggestions posted by the members of an ideas community. For example, if the focus of a particular community
is “Ideas for car features,” an appropriate idea for that community might have the title “Insulated cup holders that keep
your beverage hot or cold.” Or, if the focus of a particular community is “Ideas for our company's employee benefits,”
an appropriate idea for that community might have the title “On-site day care.”

Question
An issue posted to an answers community. When a community member asks a question, other community members
post replies to help resolve the question.

Reply
The response to a question in an answers community. When community members reply to a question, the person who
asked the question can mark one of the replies as the best answer to resolve and close the question.

Vote, Reply
In an answers community, a vote means you either like or dislike a reply to a question.

Setting Up Answers

Available in: Enterprise, Unlimited, and Developer Editions

To set up answers:

1. Enable answers and set the default community.
2. Create a category group for answers, and add the data categories you want displayed in your answers community to the

category group.

See “Creating and Modifying Category Groups” in the Salesforce.com online help and “Adding Data Categories” in the
Salesforce.com online help.

Note: Even though you can create up to five hierarchy levels of categories in a category group, only the first level
of categories is supported in your answers community. Child categories below the first level are not displayed in
the community, and community members can't assign these child categories to questions.

3. Assign the data category to your answers community.

After you assign the data categories to answers, users can see all categories in the answers community. However, if you set
up category group visibility settings in the next step, users without a role can only see uncategorized questions.

4. If you want to control which categories (and all associated questions) users can access:

a. Assign roles to the users that you want to participate in the answers community. Users without a role can only view
uncategorized questions, whereas users with a role can view all questions associated with the categories their role has
access to.  See “Assigning Users to Roles” in the Salesforce.com online help.

b. Set up category group visibility settings to control which categories (and associated questions) users can see in the
answers community. See “Editing Category Group Visibility Settings” in the Salesforce.com online help.

5. (Optional) Create a validation rule for questions and replies to prevent offensive language from being posted to the answers
community.
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To create validation rules, click Setup➤Customize➤Answers➤Question Validation Rules and Setup➤Customize
➤ Answers ➤ Reply Validation Rules. Refer to “Community Validation Rules” in the Salesforce.com online help for
sample rules.

6. (Optional) Create reports for your answers community. For more information, see “Setting Up Reports for Answers” in
the online help.

7. (Optional) Enable answers in your Customer Portal or partner portal.

For more information, see “Enabling Answers in the Customer Portal” or “Enabling Answers in the Partner Portal” in the
online help.

Enabling Answers and Setting the Default Community

To enable the answers feature:

1. Click Setup ➤ Customize ➤ Answers ➤ Settings.
2. Click Edit.
3. Use the Enable Answers checkbox to enable answers.

Enabling answers displays the Answers tab in the Community application and creates a community named Internal
Community.

4. Select the default community to display on the Answers tab. You can only display one answers community at a time. You
can either use Internal Community as the default or create a new community and use it as the default.

5. Click Save.

Assigning a Category Group to Answers

After you have created a category group for answers and added data categories to the group, you need to assign the group to
answers:

1. Go to Setup ➤ Customize ➤ Answers ➤ Category Group Assignments. The category group assignments page only
displays after you have enabled answers.

2. Click Edit.
3. Select the category group you want to assign to your answers community.
4. Click Save.

The following example shows how the categories within a category group appear on the Answers tab.
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Figure 1: Answers tab displaying categories

1. The community assigned to answers.
2. When you assign a category group to answers, the data categories within the group appear beneath the community name

on the Answers tab. Community members can assign these categories to their questions and browse within categories to
see related questions. The name of the category group isn't displayed within the answers community.

Using Answers

Using Answers

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Answers is a feature of the Community application that enables users to ask questions and have community members reply
with answers. Community members can then vote on the helpfulness of each reply, and the person who asked the question
can mark one reply as the best answer.

To get started:

• Ask a question
• Find an answer to a question
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• Reply to a question
• Vote for a reply

Once you become an active community member, you can view all of your questions and replies, and also resolve any question
you asked by choosing a reply as the best answer.

To help organize questions within a community, each question is associated with one category. From the answer home page,
click a category under the community to view all the questions associated with that category. Or click the community name
to view all questions for that community.

The right side of the answers home page provides a snapshot of recent activity by showing the most recently asked and the
most recently replied questions, as well as questions that have been open for more than a week.

Only administrators have full read, create, edit, and delete permissions for answers. Standard and portal users only have read
and create permissions by default.

Asking a Question

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

To ask a question:

1. From the Answers tab, enter your question and click Ask.

Salesforce.com searches the titles and descriptions of the other questions in the community and lists ones that are similar
to yours. If your question has already been asked, click the question title to view the replies that other community members
have posted to that question.

Alternatively, click Start Over to clear the similar questions results and ask another question.

2. If your question has not already been asked, click Continue.
3. Enter a description of your question. Use the HTML editor to format your text or upload an image.
4. Select a category for your question. If you do not assign a category, community members may have difficulty finding your

question, as they must use search or view all questions in the community.
5. Click Post Question.

After asking your question, wait for community members to post replies. Then you can choose a reply as the best answer to
resolve your question.
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Finding and Viewing Questions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

There are a couple ways to find a question:

• Browse all questions within a community or category.
• Search for a question using the search field on the Answers tab. This field searches the title and description fields for both

questions and replies and displays matching results.

Once you've found your question, click the question title to view the question detail page, which lists all the replies for the
question. The question detail page lists the number of community members who liked and disliked each reply, and also shows
the best answer to the question (if one has been chosen).

From the question detail page, you can:

• Reply to the question.
• Vote for a reply.
• Choose a reply as the best answer. You can only choose a best answer if you asked the question or are a Salesforce.com

administrator.

If a question has already been resolved, you can click Mark as Not Answered above the question to re-open it.

• Sort replies by

- Newest—Shows the most recently posted replies at the top of the list.
- Oldest—Shows the oldest replies at the top of the list.
- Most Votes—Shows the replies with the greatest number of “likes” and “dislikes” (added together) at the top of the

list.
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Replying to a Question

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

To reply to a question:

• If you're viewing a list of questions within a community or category, click Reply next to question you want to respond to.
Enter your reply in the space provided and click Reply.

• If you're viewing the details of a question, enter your reply in the space provided at the bottom of the page, and click Reply.

When entering your reply, use the HTML editor to format your text or insert an image.

After you reply to a question:

• Community members can vote on whether they like dislike your reply.
• The person who asked the question can choose your reply as the best answer.

Voting for a Reply

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

When you vote on a reply, you contribute to the answers community by identifying the replies that contains the most helpful
(and unhelpful) information. When other community members look for an answer to a question, they can quickly look at the
number of “likes” and “dislikes” a reply has received and make a more informed decision about which reply to read.

In addition, the more votes a reply receives the easier it is for the person who asked the question to choose a reply as the best
answer.

When viewing a question, review the replies and click Like to voice your approval of a reply or Dislike if a reply contains
incorrect or unhelpful information. Your vote (either a +1 or –1) is included in the Like or Dislike total for that reply. You
can't vote for your own reply and you can only vote once for each reply.
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Browsing Questions within a Community or Category

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

To view all questions within a community or category, go to the Answers tab and click the community name or category that
appears below the Get an Answer heading.

Browsing Questions within a Community

After clicking the community name to view all questions within that community, you can:

• Ask a question.
• Filter questions so you only see the open or resolved questions. A question is considered resolved when the person who

asked the question selects one of the replies as the best answer. Community members can continue to post replies and vote
for replies even when the question has been resolved.

• Sort questions by:

- Recent Activity—Shows the questions that have the most recent replies at the top of the list
- Newest—Shows the questions that have been most recently asked at the top of the list
- Oldest—Shows the oldest questions at the top of the list

• Click Reply below a question to post a reply.
• Click a category to view all the questions associated with that category.

All the categories within your community appear under the community name at the top of the page.

The question icons identify whether the question has been resolved or is still open.

Browsing Questions within a Category

When community members ask a question, they associate a single category with their question to make it easier to find within
the community. To browse all questions associated with a category, click the category name to display the category detail page.

You can click on a category from the following locations:

• When viewing a question, the categories associated with that question appear below the question description.
• When browsing questions within a community, all the categories in the community appear below the community name.
• On the answers home page, all the categories in the community appear below the community name.

From the category detail page, you can:

• Ask a question that is automatically associated with the category you are viewing.
• View all questions associated with that category, or filter the questions so you only see the open or resolved questions. A

question is considered resolved when the person who asked the question selects one of the replies as the best answer.
Community members can continue to post replies and vote for replies even when the question has been resolved.
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• Sort questions by:

- Recent Activity—Shows the questions that have the most recent replies at the top of the list
- Newest—Shows the questions that have been most recently asked at the top of the list
- Oldest—Shows the oldest questions at the top of the list

• Click Reply below a question to post a reply.

The question icons identify whether the question has been resolved or is still open.

Choosing the Best Answer to a Question

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

After you ask a question, you should monitor the replies posted by other community members and eventually choose one of
the replies as the best answer. The best answer is highlighted directly below the question so it's easy to find, which helps
community members quickly identify the most useful resolution to the question.

Only Salesforce.com administrators and the person who asked the question can mark a reply as the best answer.

To choose the best answer:

1. From the Answers tab, find your question and click its title.
2. Decide which reply is the best answer, and click Choose as Best Answer.

To identify the best answer, look at the votes (“likes” and “dislikes”) for each reply. The reply with the most “likes” probably
contains the most useful information. If a question has many replies, try sorting the replies by Most Votes so the replies
with the most likes and dislikes appear at the top of the list.

After you choose a best answer:

• The question is marked as “resolved”. Community members can continue to post and vote on replies for resolved questions.
• If another reply that you like better is posted in the future, simply choose that reply as the best answer to replace the old

best answer.
• To clear a question so it is no longer resolved, click Mark as Not Answered above the question.
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Viewing Your Questions and Replies

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Once you become an active community member, you can view a list of all the questions you asked and replies you posted by
clicking My Questions & Replies at the top of any page in the Answers tab.

When viewing a list of your questions, you can quickly identify which questions you resolved and which questions are still
open. (Resolved questions have a best answer.) You can sort your questions by:

• Newest—Shows your most recently asked questions at the top of the list
• Recent Activity—Shows your most recently asked questions and your questions that have the most recent replies at the

top of the list
• Oldest—Shows your oldest questions at the top of the list

When viewing a list of your replies, the question title appears as a link followed by your reply. You can sort your replies by:

• Newest—Shows your most recently posted replies at the top of the list.
• Oldest—Shows your oldest replies at the top of the list.
• Most Votes—Shows your replies that have received the greatest number of “likes” and “dislikes” (added together) at the

top of the list.

The following table describes the icons displayed on the page:

DescriptionIcon

A question that has been resolved.To resolve a question, the person who asked the question chooses
a reply as the best answer.

A question that community members have replied to. For example, this icon represents a question
with four replies. If a question has no replies, a “0” appears in this icon.

A reply to a question.

A reply that has been marked as the best answer to a question.
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High Volume Customer Portal Users
Available in: Enterprise, Unlimited, and Developer Editions

In Winter '10, the High Volume Customer Portal User and Authenticated Website User user licenses were available through
a pilot program. In Spring '10, the Authenticated Website User user license is generally available, while the High Volume
Customer Portal User user license is available through a pilot program.

High-volume Customer Portal users include both the High Volume Customer Portal User and Authenticated Website User
license types. You can use these user licenses to add significantly more users to a Customer Portal. After you purchase these
high-volume user licenses, you can assign them to portal-enabled contacts so that large numbers of users can log in to a
Customer Portal without affecting its performance.

Implementation Tips

• You must purchase High Volume Customer Portal User or Authenticated Website User user licenses before you can assign
them to portal users.

• To view the user licenses in your organization, click Setup ➤ Company Profile ➤ Company Information.
• Contact salesforce.com for information about how many High Volume Customer Portal users you can activate for a

Customer Portal.
• You can only enable contacts as High Volume Customer Portal users via the API. See the Force.com Web Services API

Developer's Guide.
• Review the details of Customer Portal user licenses before assigning them to users. The following table shows the Customer

Portal user licenses with their associated profiles and positions in the Customer Portal role hierarchy:

Roles and SharingProfilesUser License

High-volume Customer Portal users
don't have roles. See “Granting High

High Volume Customer Portal User or
Authenticated Website User profile, or

High Volume Customer Portal User

and Volume Customer Portal Users Accessa profile cloned and customized from
one of theseAuthenticated Website User to Objects” in the Salesforce.com online

help.

Can't share but can transfer records they
own or have access to; can't access
articles.

- Can access custom objects
depending on profile settings.

(both user licenses are High-volume
Customer Portal users)

- Can't assign to person accounts.

Can't transfer cases from non-High
Volume Customer Portal users to them.

Can't include in:

- Personal groups or public groups
- Sharing rules
- Account teams, sales teams, or case

teams
- Salesforce CRM Content

workspaces
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Roles and SharingProfilesUser License

Can only assign to either the Executive,
Manager, or User role.

Can view and edit data they directly
own or data owned by or shared with

Customer Portal User profile or a
profile cloned and customized from the
Customer Portal User profile

Customer Portal Manager Standard

- Can access custom objects
depending on profile settings. users below them in the Customer

Portal role hierarchy; and they can view- Can receive the “Portal Super User”
permission. and edit cases where they are listed in

the Contact Name field.- Can access Salesforce CRM
Content depending on feature
license and profile settings. See
“Enabling Salesforce CRM Content
in the Customer Portal” in the
Salesforce.com online help.

Can assign to either the Executive,
Manager, or User role.

Can view and edit data they directly
own or data owned by or shared with

Customer Portal Manager profile or a
profile cloned and customized from the
Customer Portal Manager profile

Customer Portal Manager Custom

- Can access custom objects
depending on profile settings. users below them in the Customer

Portal role hierarchy; and they can view- Can access reports depending on
profile settings. and edit cases where they are listed in

the Contact Name field.- Can access Salesforce CRM
Content depending on feature

Can have data shared to them just like
other Salesforce.com users.

license and profile settings. See
“Enabling Salesforce CRM Content
in the Customer Portal” in the
Salesforce.com online help.

- Can receive the “Portal Super User”
and “Delegated Portal User
Administrator” permissions.

- The settings on the Customer Portal
Manager and Customer Portal User
profiles are similar. However, users
associated with the Customer Portal
Manager profile can be assigned
greater access to data via the
Customer Portal role hierarchy and
sharing rules.

Best Practices

• Add Salesforce.com users to the High Volume Customer Portal Users share group to grant them access to records owned
by High Volume Customer Portal users. See “Sharing Records Owned by High Volume Customer Portal Users to
Salesforce.com Users” in the Salesforce.com online help.

• Don't assign the High Volume Customer Portal User user license to Customer Portal users who you want in:

- Personal groups or public groups
- Sharing rules
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- Account teams, sales teams, or case teams
- Salesforce CRM Content workspaces

• Avoid granting ownership of accounts to High Volume Customer Portal users because they can't own accounts.

About High Volume Customer Portal Users

Granting High Volume Customer Portal Users Access to Objects

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To grant High Volume Customer Portal users access to
objects:

Note:

• High-volume Customer Portal users include both the High Volume Customer Portal User and Authenticated
Website User license types.

• The High Volume Customer Portal User user license is currently available through a pilot program, while the
Authenticated Website User user license is generally available. For information on enabling High Volume Customer
Portal users, contact salesforce.com.

High-volume Customer Portal users are limited-access portal users intended for organizations with many thousands to millions
of portal users. Unlike other portal users, High Volume Customer Portal users don't have roles, which eliminates performance
issues associated with role hierarchy calculations.

Specifically, High Volume Customer Portal users:

• Are contacts enabled to access a Customer Portal
• Are assigned to the High Volume Customer Portal User or Authenticated Website User user license
• Can access records if all of the following conditions are met:

- The records are associated with the high-volume Customer Portal user's account or contact
- The high-volume Customer Portal user has read only or read/write access to an object's records

• Only share the records they own with Salesforce.com users in the High Volume Customer Portal Users share group. See
“Sharing Records Owned by High Volume Customer Portal Users to Salesforce.com Users” in the Salesforce.com online
help.

Limitations of High Volume Customer Portal users include:

• High-volume Customer Portal users can't manually share records they own or have access to, but they can transfer such
records.

• They can't access articles.
• You can't transfer cases from non High Volume Customer Portal users to High Volume Customer Portal users.
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• High-volume Customer Portal users can't own accounts.
• You can't add case teams to cases owned by High Volume Customer Portal users. Also, if you transfer cases to High

Volume Customer Portal users, any case teams on those case are deleted.
• You can't include High Volume Customer Portal users in:

- Personal groups or public groups
- Sharing rules
- Account teams, sales teams, or case teams
- Salesforce CRM Content workspaces

• You can only enable contacts as High Volume Customer Portal users via the API. See the Force.com Web Services API
Developer's Guide.

To grant High Volume Customer Portal users access to objects:

1. Click Setup ➤ Customize ➤ Customer Portal ➤ Settings.
2. In the Sharing Settings for High Volume Customer Portal Users section, click Set Up or Edit next to an object.

Note:

• Objects with Set Up in the Action column have not been customized for high-volume Customer Portal user
access. Until you configure them, their access is determined by organization-wide sharing defaults.

• Custom objects only display if the Available for Customer Portal field is selected. See “Managing
Custom Objects” in the Salesforce.com online help.

3. Grant access based on an account or contact lookup:

• To grant access to all High Volume Customer Portal users on an account, select All High Volume Customer
Portal users whose account matches and then select a field. For example, choose this option if you want all
High Volume Customer Portal users in an account to access all of the cases for their account.

• To grant access to an individual contact as a high-volume Customer Portal user, select Only the high-volume
Customer Portal user who matches and then select a field. For example, choose this option if you want
individual High Volume Customer Portal users to only access cases associated with their contact.

• To prohibit access to all High Volume Customer Portal users, select Don't grant access to High Volume
Customer Portal users.

4. Choose an access level of Read Only or Read/Write.
5. Click Save.

Your settings apply to all of your organization's Customer Portals.
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Sharing Records Owned by High Volume Customer Portal Users to
Salesforce.com Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To share records owned by High Volume Customer Portal
users to Salesforce.com users:

Note:

• High-volume Customer Portal users include both the High Volume Customer Portal User and Authenticated
Website User license types.

• The High Volume Customer Portal User user license is currently available through a pilot program, while the
Authenticated Website User user license is generally available. For information on enabling High Volume Customer
Portal users, contact salesforce.com.

High-volume Customer Portal users are limited-access portal users intended for organizations with many thousands to millions
of portal users. Unlike other portal users, High Volume Customer Portal users don't have roles, which eliminates performance
issues associated with role hierarchy calculations. Because High Volume Customer Portal users are not in the role hierarchy
while Salesforce.com users are, a share group allows you to specify the Salesforce.com users who can access records owned by
High Volume Customer Portal users. Each Customer Portal has its own share group.

To specify the Salesforce.com users who can access records owned by High Volume Customer Portal users:

1. Click Setup ➤ Customize ➤ Customer Portal ➤ Settings.
2. Click the name of a Customer Portal.
3. Click the Share Group Settings subtab.
4. Click Activate to turn on the share group.

Activating the share group can take a while. An email is sent to you when the process finishes.

Note:  Deactivating a share group removes all Salesforce.com users' access to records owned by High Volume
Customer Portal users. An email isn't sent to you when the deactivation process finishes.

5. Click Edit to add Salesforce.com users to the share group:

a. From the Search drop-down list, select the type of member to add.
b. If you don't see the member you want to add, enter keywords in the search box and click Find.
c. Select members from the Available Members box, and click Add to add them to the group.
d. Click Save.
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Salesforce Knowledge Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Salesforce Knowledge enhancements in Spring '10 include:

New API Object for Articles

With KnowledgeArticleVersion, you can now retrieve Salesforce Knowledge articles using the API. For more
information, see the Force.com Web Services API Developer's Guide.

Describe Calls for Data Categories

Data Category Groups and their data category structure can now be retrieved using the describeDataCategoryGroups
and the describeDataCategoryGroupStructures calls. For more information, see the Force.com Web Services API
Developer's Guide.

Metadata API Component for Data Category Groups

You can now deploy data category groups in Salesforce Knowledge using the DataCategoryGroup component. See
the Force.com Metadata API Developer's Guide for details.

SOQL and SOSL Clauses to Filter Articles Based on their Categorization

SOQL and SOSL now provide the optional WITH DATA CATEGORY clause to filter articles based on their classification
in one or more data category groups. For more information, see the Force.com Web Services API Developer's Guide.

Salesforce Knowledge in the Partner Portal

You can now provide access to articles for your partner portal users.

Field-Level Security for Articles

You can now restrict users’ access to view and edit specific fields on articles. For example, if certain articles are published
in the internal app and the Customer Portal, you may want to ensure that a custom field, such as Internal Comments,
is not visible to portal users.

Custom Report Types for Article Data

Custom report types are now available to help you analyze Salesforce Knowledge data.

Printable View for Articles

A Printable View hyperlink now renders a printable view of your articles.

File Field Support in the Article Importer

The Article Importer now supports the File field. You can use this field to import Articles containing PDF files or any
other file type.
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About Salesforce Knowledge

Salesforce Knowledge in the Partner Portal

Available in: Enterprise and Unlimited Editions

User Permissions Needed

"Customize Application"To set up and update the partner portal:

"Manage Users"To create and edit profiles or manage portal users:

"View Articles”To view Salesforce Knowledge articles:

After you have set up Salesforce Knowledge in your organization and enabled your partner portal, complete the following
steps to make articles visible in your portal.

Note:  For prerequisite details, see “Setting Up Salesforce Knowledge” in the Salesforce.com online help and “Enabling
the Partner Portal” in the Salesforce.com online help.

1. Update your cloned partner portal profiles:

a. Include the “View Articles” user permission.
b. Verify that the tab visibility for the Articles tab is Default On.

Note:  For instructions on cloning profiles, see “Creating and Editing Profiles” in the Salesforce.com online help.

2. At the bottom of the partner portal detail page, click Edit Profiles and activate the new profile.
3. Add the Articles tab to each partner portal
4. Assign the cloned profiles to your partner portal users:

a. To create a new partner portal user, click Work with Portal and choose Enable Partner Portal Login on the contact
detail page. To update an existing user, click Work with Portal and choose View Partner User on the contact detail
page.

b. For a new user, select the cloned profile from the Profile drop-down menu. For an existing user, click Edit  and then
select the profile.

c. Click Save.

5. Notify users who create articles that they must select Partner Portal as a channel option when creating or modifying an
article. If the Partner Portal channel is not selected, the article will not appear in the portal.

6. To allow users to search for articles from the Home tab, add the Article Search component to the home page layout. Ensure
that you assign the layout to the partner user profiles.
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Setting an Article's Field-Level Security

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To set field-level security:

Field-level security lets administrators restrict users’ access to specific fields on detail and edit pages. For example, you can
make a “Comment” field in an article visible for agent profiles, but not customer.

If using both article-type layout and field-level security to define field visibility, the most restrictive field access settings of the
two always apply. For example, if a field is hidden in the article-type layout, but visible in the field-level security settings, the
layout overrides security settings, and the field won't be visible. Some user permissions on profiles override both page layouts
and field-level security settings. For example, users with the “Edit Read Only Fields” permission can always edit read-only
fields regardless of any other settings.

Tip: Even though article-type layouts also determine which fields users can view and edit, use them primarily to
organize fields and sections on detail and edit pages. Use article field-level security to restrict users' access to view and
edit specific fields on detail and edit pages.

Important: Field-level security does not prevent searching on the values in a field. If you do not want users to be
able to search and retrieve records that match a value in a field hidden by field-level security, contact salesforce.com
Customer Support for assistance with setting up your organization to prevent unwanted access to those field values.

To define field-level security:

1. Choose where to define security, either via a profile or a field:

• For profiles:

a. Select Setup ➤ Manage Users ➤ Profiles.
b. Select a profile to change the field access for users with that profile.
c. In the Field-Level Security section, click View next to the tab you want to modify, and then click Edit.

• For fields:

a. Select Setup ➤ Customize ➤ Knowledge ➤ Article Types.
b. Select the article type that contains the field to modify.
c. Select the field and click Set Field-Level Security.

2. Specify whether the fields should be visible, hidden, read-only, or editable (visible without read-only).

Note that these field access settings override any less-restrictive field access settings on the article-type layouts.

3. Click Save.
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After setting field-level security, you can create article-type layouts to organize the fields on detail and edit pages. For more
information on article-type layouts, see “Modifying Article-Type Layouts” in the Salesforce.com online help.

Custom Report Types for Article Data

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

In Spring '10, four custom report types are available to help you analyze your Salesforce Knowledge data:

Knowledge Articles

Use this custom report type to compare information about individual articles, such as their creation dates, published
channels, and number of associated cases.

Knowledge Article Searches

Use this custom report type to analyze the number of searches per day, month, or year for each channel and role.

Knowledge Article Views

Use this custom report type to analyze the number of views per day, month, or year for each channel and role.

Knowledge Article Votes

Use this custom report type to analyze the number of votes per day, month, or year for each channel and role.

To create a custom report type, click Setup ➤ Create ➤ Report Types.

Printable View for Articles

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Articles”To view articles:

A Printable View hyperlink now displays at the top right of your article in:

• the article detail page and preview in the Article Management tab
• the article preview in the Articles tab, Customer Portal, partner portal and the public knowledge base.
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If you are using an older package of the public knowledge base, you must add the Printable View CSS style to make it
visible on the article detail page. Add the following style in your CSS file:

.pkbFullWidthInner .configLinks {
color: #666666;

}

Additional Service Cloud Enhancements
Work with Portal Button on Accounts and Contacts

Available for the partner portal in: Enterprise and Unlimited Editions

Available for the Customer Portal in: Enterprise, Unlimited, and Developer Editions

Now, organizations with a Customer Portal or partner portal have fewer buttons on account and contact detail pages. This is
because Salesforce.com has added all the buttons related to these portals to the Work with Portal drop-down button. For
example, before Spring '10, users saw the View Partner User, Disable Partner User, Login as Partner User buttons on a
contact; now they just see the Work with Portal button, which they can click to choose the same options. The following table
shows the portal buttons that displayed on account and contact detail pages before and after Spring '10:

Spring '10Before Spring '10Portal Buttons on

Click Work with Portal and choose:Account detail pages • Enable as Partner
• Enable as Partner• Disable Partner Account
• Disable Partner Account• Disable Customer Portal Account
• Disable Customer Portal Account

Click Work with Portal and choose:Person account detail pages • View Customer Portal User
• View Customer Portal User• Disable Customer Portal Account
• Disable Customer Portal Account• Login As Portal User
• Login As Portal User

Click Work with Portal and choose:Contact detail pages • View Partner User
• View Partner User• Disable Partner User
• Disable Partner User• Login as Partner User
•

OR
Login as Partner User

OR• View Customer Portal User
• View Customer Portal User• Disable Customer Portal User
• Disable Customer Portal User• Login as Partner User
• Login as Partner User

Note:

• You can't enable accounts for a Customer Portal.
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• You can enable person accounts for a Customer Portal, but not the partner
portal.

• You can enable a contact for a Customer Portal or partner portal, but not both.

Category Group Visibility Settings for Customer Portal and Partner Portal Roles

Available in: Enterprise, Unlimited, and Developer Editions

Note: Category group visibility settings are only available with Salesforce Knowledge (articles) and answers communities
(questions).

By default, a Customer Portal or partner portal user inherits the role and category group visibility settings assigned to the
account owner. Previously, category group visibility settings could not be modified on a portal-user level. As of Spring '10,
you can modify the category group visibility settings for each portal role:

1. Click Setup ➤ Manage Users ➤ Users.
2. Select the role you want to modify.
3. In the Category Group Visibility Settings related list, click Edit next to the category group you want to modify. Alternatively,

click the name of a category group and then click Edit.
4. Select a visibility setting:

DescriptionVisibility Setting

Users can see all categories in the category group. This option is only available for the topmost role
in the role hierarchy. When you create a new category group, its visibility is defaulted to All for
the topmost role in the role hierarchy, and all subordinate roles inherit that setting.

All

The role inherits its parent role's visibility settings. If the parent role's settings change, the child
role stays in sync. Click the name of the parent role to see its category group visibility settings.

Inherited
from...

Users cannot see any categories in the category group.None

Users see your custom selection of categories. You can choose from the categories that are visible
to the parent role. If the parent role's visibility changes to be less than its child's visibility, the child
role's category visibility is reset to its parent's category visibility.

To select categories, double-click the category in the Available Categories box. Alternatively,
select a category and then click Add. Selecting a category implicitly includes its child and parent

Custom

categories as well. Categories that are grayed out in the All Categories box are not available for
selection because their parent has already been selected.

Note:  If you are customizing a role that was previously set to All Categories, you must first
remove All from the Selected Categories box before you can select specific categories.

5. Click Save.
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Salesforce Chatter—Limited Release
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Spring '10 introduces Salesforce Chatter, a collaboration application that helps you connect with your coworkers and share
business information securely and in real time. Salesforce Chatter includes the following new features:

Profiles

Each user in your organization now has a profile that can be customized with a photo, contact information, and professional
experience. View your profile on the new Profile tab or by clicking your name at the top of any page, on the header bar
of your Home tab, or in a feed. View profiles for other users in your organization on the new People tab or by clicking
a person's name in a feed or on a record detail page.

Profile Tab

The Profile tab allows people to view and update their own profiles.

People Tab

The People tab provides a list of users in your organization. From the People tab, you can search for users, view profiles,
and follow and unfollow people.

Salesforce Chatter App

The Salesforce Chatter app is available in the app menu in the top right corner of any page. The Salesforce Chatter app
includes the People and Profile tabs.

Feeds

Feeds show you recent activities performed by people in your organization and changes to records you follow. Feeds
display on your Home tab, your profile, and on record detail pages.

Feed Tracking

In Setup ➤ Customize ➤ Chatter ➤ Feed Tracking, administrators can configure which objects can be followed in
Salesforce Chatter and which fields will create feed updates when changed.

Attachments

Share files and links with other people by attaching them to a post on a feed. Attachments can include all file types, from
traditional business documents such as Microsoft® PowerPoint presentations to audio files, video files, Web pages,
Google® docs, and Web links.

Follow and Unfollow Links

Click Follow on a profile or record detail page to see feed updates for changes made by that person or on that record.
Click Unfollow to stop feed updates from a person or record and remove their previous updates from your feed.

COLLABORATION CLOUD
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Stop Automatically Following Records Checkbox

You automatically follow records you own so that you can see updates to those records in your news feed. Select the
Stop Automatically Following Records checkbox in Setup ➤ My Personal Information ➤ Personal
Information to stop automatically following records you own.

Email Notifications

If an administrator enables email notifications in Setup ➤ Customize ➤ Chatter ➤ Settings, users can edit personal
email notifications. To edit email notifications, click Setup ➤ My Chatter Settings ➤ My Chatter Emails. You can
receive email notifications when updates occur in Salesforce Chatter, including when people: follow you, post on your
profile, comment on your status or a change you make, comment on a post on your profile, or comment after you comment
in a feed.

Salesforce Chatter for the Mobile Application

You can access a subset of Salesforce Chatter features on your BlackBerry or iPhone. See Mobile Chatter—Limited
Release on page 29 for more information.

Weekly Export

Salesforce Chatter feed data is available for export in Setup ➤ Data Management ➤ Data Export.

Salesforce Chatter API

Salesforce Chatter introduces several new API objects that enable you to build collaborative apps for the Force.com
platform. For more information, see New Objects on page 134.

Implementation Tips

• Salesforce Chatter features are not supported using Microsoft® Internet Explorer version 6.0.
• Quickly access the Salesforce Chatter People and Profile tabs using the Salesforce Chatter app, available in the app menu

in the top right corner of any page.
• If you want to try Salesforce Chatter before you enable it in your production environment, enable it in a sandbox organization

first.

About Salesforce Chatter

Salesforce Chatter Overview

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Watch a Demo (2 minutes)
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Salesforce Chatter is a collaboration application that helps you connect with your coworkers and share business information
securely and in real time. Salesforce Chatter works in accordance with all of the security and permission settings in your
Salesforce.com organization. Use Salesforce Chatter to share information about yourself and learn about your colleagues with
profiles, connect with people using comments and posts, and use feeds to keep up with the latest activities and record updates
in your organization. You can easily find the Salesforce Chatter People and Profile tabs in the Salesforce Chatter app, available
in the app menu in the top right corner of any page. If your administrator has added the People and Profile tabs to other apps,
you'll see the tabs in those apps unless you previously customized your display. In that case, you'll need to add the tabs to those
apps.

Note: Salesforce Chatter features are not supported using Microsoft® Internet Explorer version 6.0.

Salesforce Chatter includes limits on:

• The number of posts, comments, and tracked field changes stored on the Salesforce.com servers
• How long posts, comments, and tracked field changes are stored on the Salesforce.com servers
• The number of posts, comments, and tracked field changes an organization can make per day
• The number of email notifications that can be sent per organization per hour

These limits are subject to change at any time. Contact salesforce.com for more information.

Salesforce Chatter Terminology

The following terminology is used for Salesforce Chatter:

Comment, Salesforce Chatter
A reply to an update in a feed.

Feed
A list of recent activities in Salesforce.com. There are three types of feeds:

• News feed: displays on your Home tab and includes your updates, status updates of people you follow, and updates
to records you follow

• Profile feeds: display on Salesforce Chatter profiles and include the updates made by the person whose profile you're
viewing

• Record feeds: display on record detail pages and include updates to the record you're viewing

Feed Tracking
Administrator settings that determine which records can be followed and which fields can be tracked in feeds. Enabling
an object for feed tracking allows people to follow records of that object type. Enabling fields for feed tracking allows
users to see news feed updates when those fields are changed on records they follow.

Follow
A subscription to a user or record that lets you see related updates in your news feed. Follow a user to see status updates.
Follow a record to see posts, comments, and field changes.

People
Users in your Salesforce.com organization. A list of people is available on the People tab in Salesforce Chatter.

Post
A top-level comment in a feed.
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Profile, Salesforce Chatter
A personal page for each Salesforce.com user that includes contact information, following and followers lists, a profile
feed, and a photo.

Record Update
An update in a feed that is the result of a field change on a record that is being followed.

Status Update
An update made by posting to your news or profile feeds, usually to tell other people what you're working on. Your status
update displays on your Home tab, in your news and profile feeds, on your profile, and in the feeds of people following
you.

Unfollow
To stop following a user or record and stop seeing their updates in your news feed.

Update
A single activity that displays in a feed, such as a status update, post, or field change.

Enabling Chatter

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Modify All Data”To enable Salesforce Chatter:

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Enable Salesforce Chatter to turn on feeds and profiles so your users can talk to each other and share information in real time.

Note:  Enabling Salesforce Chatter also enables the new user interface theme, which updates the look and feel of
Salesforce.com. Salesforce Chatter requires the new user interface theme, and if you disable the new user interface
theme, Salesforce Chatter is also disabled.

1. Click Setup ➤ Customize ➤ Chatter ➤ Settings.
2. Click Edit.
3. Select Enable.
4. Optionally select Allow Emails so users can choose to receive email notifications when certain activities happen in

Salesforce Chatter.
5. Click Save.

Note:  After enabling Salesforce Chatter for your organization, you can also enable it for the mobile application so
users can access their feeds from an iPhone or BlackBerry device. Salesforce Chatter doesn't require setup for Mobile
Lite users; however, you must enable Salesforce Chatter for Salesforce Mobile users.
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Customizing Feed Tracking

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To customize fields tracked in feeds:

“View Setup and Configuration”To view the field tracking setup page:

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Enable objects for feed tracking so people can follow records of that object type. Enable field tracking for objects so people
can see feed updates about changes to those fields for records they follow. For example, if you enable feed tracking for the
Billing Address field on accounts, people can follow account records and see feed updates when Billing Address is
changed on those records. Sharing rules and field-level security determine visibility of record changes in feeds; you must be
able to see a record in order to see changes to that record in feeds.

You can configure feed tracking for users, custom objects, and the following standard objects: accounts, assets, campaigns,
cases, contacts, contracts, leads, opportunities, products, and solutions.

1. Click Setup ➤ Customize ➤ Chatter ➤ Feed Tracking.
2. Select an object.
3. Select Enable Feed Tracking.
4. Select up to 20 fields to track.
5. Click Save.

Consider the following feed tracking tips:

• To stop tracking an object, deselect Enable Feed Tracking. You can't disable feed tracking for users.
• Deselecting the owner field for an object disables automatic following for that object when a new owner is assigned. For

example, if the Account Owner field isn't tracked and someone creates an account and later changes the owner to a
different person, the new owner will not automatically follow the account.

• To restore the default feed tracking settings for an object, click Restore Defaults.
• If leads are tracked, but accounts, contacts, or opportunities are not, users won't be able to follow or see updates related to

the accounts, contacts, and opportunities created during lead conversion.
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Profile Overview

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Customize your profile with a photo and information about yourself so people in your organization can learn more about you.
View your profile on the Profile tab or by clicking your name at the top of any page, on the header bar of your Home tab, in
a feed, or on a record detail page.

View other people's profiles on the People tab or by clicking their name in the People tab, a feed, or on a record detail page.
If hover details are enabled, you can also see contact details by hovering over names in the recent items list and owner fields
on records.

The Profile and People tabs are available by default in the Salesforce Chatter app. Select this app from the app menu in the
top right corner of any page. If your administrator has added the People and Profile tabs to other apps, you'll see the tabs in
those apps unless you previously customized your display. In that case, you'll need to add the tabs to those apps.

From your profile, you can:

• Edit your contact information
• Add additional information about yourself in the About Me section
• Update your status in the What are you working on? field
• Upload or delete a profile photo
• See who's following you and who you're following
• See your recent updates your profile feed

When using profiles, consider these tips:

• Your status displays on your profile, Home tab, news and profile feeds, hover details, and in the news feed of people
following you. Click Clear to remove your status from these locations. Clearing your status does not remove it from feeds.
Click Delete under your status in a feed to remove it from feeds.

• You can optionally attach files and links to your status updates.
• Your contact information is also visible in your user detail and is subject to validation or other rules set by your administrator.

Click the User Detail link on your profile to view your user detail page.
• When you change your email address in your contact information, a confirmation is sent to the new address. You must

click the link provided in that email for the change to take effect.
• To search the contents of other people's About Me, click Advanced Search... in the sidebar of the Home tab or an object

tab, enter a search term, and select Users as the scope.
• Portal users don't have profiles.
• For organizations using Salesforce to Salesforce, the Connection User may display in feeds, but does not have a profile.
• Users with the "Manage Users" permission can edit profiles and photos for other users.
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Uploading Your Profile Photo

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Upload a profile photo so other people can see who you are.

1. View your profile by clicking your name at the top of any page or by clicking the Profile tab.
2. Click Update Photo.
3. Click Browse....
4. Select a file to upload and click Open.

Note:  Photos can be JPG, GIF, or PNG format up to 4 MB.

5. Drag the dotted lines in the photo to create a thumbnail image that will display next to your name in the application.
6. Click Save.

To delete your photo, click Delete, then click OK.

Using the Following and Followers Lists

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

The Following and Followers lists on your profile show you who and what you are following and who is following you,
respectively. You can also view Following and Followers lists on other people's profiles to see who and what they are following
and who is following them. Click Show All in either section to view the full list in alphabetical order.

You can filter Following lists by users or objects, for example, accounts or contacts. In your Following list, click Unfollow to
stop following a person or record. In another person's Following list, you can also click Follow to follow a person or record.

In any Followers list, click Follow to follow a person, or Unfollow to stop following them.

In both lists, use the Next and Previous links to see more of the list. Click Done to close the window.
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Feeds Overview

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Feeds show you recent activities performed by people and on records in your Salesforce.com organization. Salesforce Chatter
includes the following feeds:

• Profile feed: displays on a user's profile and shows updates by that user. View your own profile to view your profile feed
and update your status.

• Record feed: displays on record detail pages and shows updates to a record.
• News feed: displays on your Home tab and shows your updates, status updates of people you follow, and updates to records

you follow.

Depending on how your administrator has configured feed tracking, you can see feed updates for:

• Field changes
• Created and deleted records
• Converted leads
• Closed opportunities and cases
• Record owner changes
• Status updates
• Comments and posts
• Shared files and links

You must follow people and records to see their updates in your news feed. Sharing rules and field-level security determine
visibility of record changes in feeds; you must be able to see a record in order to see changes to that record in feeds.

Using Feeds

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

Use the following feeds to see recent activities in Salesforce.com:

• Profile feed: displays on a user's profile and shows updates by that user. View your own profile to view your profile feed
and update your status.

• Record feed: displays on record detail pages and shows updates to a record.
• News feed: displays on your Home tab and shows your updates, status updates of people you follow, and updates to records

you follow.
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Note:  Show or hide feeds using the Show Chatter and Hide Chatter links at the top of a feed. If enabled by your
administrator, related list hover links display below feeds.

To use feeds:

• Post to feeds by typing in the text box at the top of a feed. You can also attach files and links to posts. Anyone who can
see a record can see your post on the record's feed. Additionally, people following a record can see your post in their news
feed.

• Update your status by posting to your profile feed or news feed. Anyone can see your status update on your profile feed,
and people following you can see your status update in their news feed.

• Click Comment to comment on feed updates.
• Click Delete to delete posts and comments. You can delete posts and comments you've made and posts and comments

made by other people on your profile feed or on feeds of records you own. If you have delete permission for an object, but
not for a specific record of that object type, you may see a Delete link for posts to that record in your news feed, but you
can't delete these posts. Administrators and users with the “Modify All Data” permission can delete all comments and
posts.

• Click Unfollow in your news feed to stop following people or records.

Attaching a File or Link to a Feed

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

You can share files and links with people by attaching them to feed posts. Attachments can include all file types, from traditional
business documents such as Microsoft® PowerPoint presentations to audio files, video files, Web pages, Google® docs, and
Web links. To attach a file or link to a post:

1. Enter your post in the field at the top of the feed. If you don't enter any text, a generic update is posted with your attachment.
2. Click File or Link below your update.
3. Click Select a File to share a file, or enter the URL to share.
4. Enter the Name of the file or Link Name.
5. For files, enter a description in the Description field.
6. Click Share.

Note:

• The upload may take some time depending on your file size.
• The size limit for an attachment on a profile or news feed is 25 MB.
• The size limit for an attachment on a record feed is 5 MB.
• When you attach a file to a record feed, the file is also added to the record's Notes & Attachments or Attachments

related list. If you don't see the Notes & Attachments or Attachments related list on your page layout, contact your
administrator.

• When you attach a file to a record's Notes & Attachments or Attachments related list, the file is not added to the
record's feed.
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• Salesforce.com is not responsible for content posted by users.

To delete a file or link on a feed, you have to delete the post by clicking Delete on the post.

On a record feed, you can also delete a file by clicking Del next to the file on the Notes & Attachments or Attachments related
list, or clicking Delete on the feed attachment detail page, and then clicking OK.

Note:  Deleting a file on the Notes & Attachments or Attachments related list, or the attachment detail page also
deletes the file on the original post.

Editing a File on a Record Feed

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Read” on the recordTo view a record:

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

You can edit the properties of a file on a record feed through the Notes & Attachments or Attachments related list, or the
feed attachment detail page.

1. Click Edit next to the file on the Notes & Attachments or Attachments related list, or on the feed attachment detail page.
2. Change the File Name or Description field, or select or deselect the Private checkbox.

Note:  Files marked private are only accessible to you and your administrators.

3. Click Save.

Note:  Making the following changes on the Notes & Attachments or Attachments related list, or the feed attachment
detail page, will also change the file on the feed: changing the Description, marking the file as Private, or deleting
the file.

Downloading or Viewing a File on a Feed

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.

122

Collaboration Cloud Salesforce Chatter—Limited Release



To download a file from a feed, click Download next to the file and then save the file. On a record feed, you can also download
a file by clicking View next to the feed attachment on the Notes & Attachments or Attachments related list and then save the
file.

You can view some files in your browser without downloading them. To view a file on a profile feed, click the file icon or the
View button.

Note:

• Not all files can be viewed with the document viewer, such as Microsoft Office 2007 files. Files that can't be viewed
appear as generic file type icons in the feed.

• Files attached to a record feed can't be viewed with the document viewer.

The enhanced document viewer provides the following capabilities for viewing documents:

• In addition to using the next page ( ), previous page ( ), first page ( ), and last page ( ) icons on the document toolbar,
you can navigate page-by-page through a document by right-clicking and choosing Next Page and Previous Page.

• You can use the scroll bar to move continuously through a document without needing to click the Next Page and Previous
Page icons. Continuous scrolling is not available for PowerPoint files.

• You can jump directly to a page by entering the page number in the page field and pressing Enter.
• From the right-click menu you can choose Fit Width to expand the width of the document, or Fit Full Page to view the

whole page of the document. The fit width icon ( ) and fit full page icon ( ) are also available on the toolbar.
• From the right-click menu you can choose Full Screen to view the document in full screen mode, or Exit to exit full screen

mode. The full screen icon ( ) and exit icon ( ) are also available on the toolbar.
• From the right-click menu you can Zoom In or Zoom Out. The zoom-in icon ( ) and zoom-out icon ( ) are also

available on the toolbar.
• You can use the keyboard arrow keys to navigate page-by-page through a document. Click on the document viewer and

use the keys as follows:

- Right-arrow key: moves a PowerPoint document forward one slide and moves a PDF, Word, or Excel document
forward one page.

- Left-arrow key: moves a PowerPoint document backward one slide and moves a PDF, Word, or Excel document
backward one page.

- Up-arrow key: moves a PowerPoint document forward one slide and scrolls a PDF, Word, or Excel document up the
page.

- Down-arrow key: moves a PowerPoint document backward one slide and scrolls a PDF, Word, or Excel document
down the page.

Editing Salesforce Chatter Email Notifications

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Salesforce Chatter is currently available through a limited release program. For information on enabling
Salesforce Chatter in your organization, contact salesforce.com.
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If your administrator has enabled email notifications, you can choose to receive notifications when Salesforce Chatter activities
occur.

1. Click Setup ➤ My Chatter Settings ➤ My Chatter Emails.
2. Select Yes to receive email notifications.
3. Select the desired checkboxes to receive an email notification when people:

• Follow you
• Post on your profile
• Comment on your status or a change you make, such as a post on a profile
• Comment on posts on your profile
• Comment after you comment in a feed

4. Click Save.

Consider the following tips for email notifications:

• If you select Comments on a post on my profile, you won't receive a notification when someone comments on
changes to your profile by an administrator.

• If you select Comments after me, you will only receive email notifications for up to four comments after you.
• Salesforce Chatter includes limits the number of email notifications that can be sent per organization per hour. These

limits are subject to change at any time.
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New User Interface Theme
Available in: All Editions

Spring '10 introduces a restyled user interface with a new look and feel, including a new color scheme and a new style for many
attributes of Salesforce.com.

Implementation Tips

• Enabling Salesforce Chatter in your organization automatically enables the new look and feel for all users. Disabling the
new user interface theme automatically disables Salesforce Chatter.

• The new user interface theme is disabled in accessibility mode.
• Two new global variables, $User.UITheme and $User.UIThemeDisplayed, identify the Salesforce.com look and feel

a user sees on a given Web page.

The difference between the two variables is that $User.UITheme returns the expected look and feel, while
$User.UIThemeDisplayed returns the actual look and feel. For example, a user may have the ability to see the new
look and feel by having the permission set, but if they are using a browser that isn't supported,$User.UIThemeDisplayed
returns a different value.

The Styling Visualforce Pages section of the Visualforce Developer's Guide provides more information on how to use these
global variables.

• The <apex:pageBlock> mode attribute has a new possible value:maindetail.This value provides the same functionality
as detail, but provides more compatibility for the new look-and-feel. The Visualforce Component Reference provides
more information on its use.

About the New User Interface Theme

User Permissions Needed

“Customize Application”To modify user interface settings:

To enable the new theme:

1. Click Setup ➤ Customize ➤ User Interface.
2. Select the Enable New User Interface Theme checkbox.
3. Click Save.

CUSTOM CLOUD
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The new user interface theme updates the look and feel of Salesforce.com for all users in your organization. The new user
interface theme is not supported in Setup, Agent Console, Portals, or Help & Training. The new user interface theme is
enabled by default for organizations created after Spring '10.

Only users with supported browsers see the new user interface theme. Users with unsupported browsers receive an error message
recommending that they upgrade to one of the following supported versions:

• Microsoft® Internet Explorer version 7.0 and 8.0
• Mozilla Firefox 3.0.x
• Apple® Safari 3.2.x

Adobe Flash Builder for Force.com Developer Preview
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

Adobe® Flash® Builder™ for Force.com is an integrated development environment (IDE) for developing Force.com Stratus
apps—desktop applications that operate in the Adobe Integrated Runtime (AIR) environment and utilize Force.com logic
and data. Stratus applications run seamlessly online or offline while taking full advantage of the security, scalability, and
reliability of Force.com.

Adobe Flash Builder for Force.com is intended for developers with a working knowledge of MXML (Adobe's user interface
markup language), ActionScript, (Adobe's scripting language), and Adobe Flash Builder 4, formerly known as Adobe Flex
Builder.To obtain Adobe Flash Builder for Force.com, visit http://developer.force.com/flashbuilder.To provide
feedback and suggestions for Adobe Flash Builder for Force.com, visit the Adobe Flash Builder for Force.com IdeaExchange
post.

Important: Adobe Flash Builder for Force.com is currently only available as a developer preview and may change
significantly before it's generally available. The developer preview supports the development of desktop applications
only and not Web applications. During the developer preview, don't use Adobe Flash Builder for Force.com to create
applications for use in production environments.

Analytics Enhancements
Spring '10 includes new features that improve the capabilities of Salesforce.com analytics:

• The New Report Builder—Developer Preview
• Custom Dashboard Tables
• See a Dashboard's Running User
• Dashboard Finder Improvements
• New Visibility Option for Report and Dashboard Folders
• Updated Labels for Metric and Table Dashboard Components
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About Analytics Enhancements

The New Report Builder—Developer Preview

Available in: Developer Edition

User Permissions Needed

“Create and Customize Reports”To create custom reports:

With Spring '10, report builder is available as a Developer Preview! Report builder is a visual editor for reports. You can use
it as an alternative to the report wizard for creating and editing reports.

Note:  For Developer Preview, report builder only works with tabular reports, and functionality is limited.

The report builder interface consists of three resizable panes: Fields, Filters, and Preview:

Fields Pane

All accessible fields in the report type for your report are available, organized by the sections defined in the page layout.
Find the fields you want using the Quick Find search box and field type filters, then drag them into the Preview pane
to add them to the report.

Filters Pane

Set the view and time frame filters to limit the data shown in the report. If you use report builder to edit an existing
report with a Rows to Display limit, or custom filters, those settings are shown in the Filter pane, but are not editable.
Change those settings using the report wizard.

Note:  Reports with advanced filters can't be edited using report builder.

Preview Pane

The dynamic preview makes it easy for you to modify your report. Drag fields to and from the Fields pane to add and
remove columns, and drag columns within the preview to reorder them. Click column headers or use the column header
drop-down to sort your report.

To remove columns, drag them back to the Fields pane, or use the column header drop-down.

The preview shows only a limited number of records. Run the report to see all your results.
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Figure 2: The Report Builder Interface

To create a new report using report builder::

1. From the Reports tab, Click Create Report Using Report Builder.
2. Select the report type for the report, and click Next.
3. Choose the format of the report and click Next. For the Developer Preview, you can only select Tabular.
4. Modify your report, then save or run it.

To edit a report using report builder:

1. From the Reports tab, click the name of an existing tabular report.
2. Click Customize Using Report Builder.
3. Modify your report, then save or run it.

Tips for Using Report Builder

There are a lot of things you can do from the report builder page:

Change Report Properties
Click Report Properties to change a report's name, description, or folder.

Filtering Data
To limit the data shown in the report, set the View and Time Frame filters. Depending on your organization's setup,
you may see additional filters, such as hierarchy, territories, or others.

If you use report builder to edit an existing report with a Rows to Display limit, or custom filters, those settings are
shown in the Filter pane, but are not editable. Change those settings using the report wizard.

Note:  Reports with advanced filters can't be edited using report builder.
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Adding and Removing Fields
All accessible fields in the report type for your report are available, organized by the sections defined in the page layout.
To add a field to your report, double-click it or drag it into the Preview pane. To remove a column, grab the column
header and drag it back to the Fields pane. You can also hover over the column header and choose Remove Column
from the drop-down list.

Note: You can't use report builder to remove columns that are summarized. First remove the summary using
the report wizard, then remove the column.

Find a field by typing its name into the Quick Find search box. You can also filter the list of fields by type:

• Click  to see all field types.
• Click  to see just text fields.
• Click  to see just number fields.
• Click  to see just date fields.

The type for each field in the list is indicated by an icon.

Ordering and Sorting Columns
Reorder report columns by grabbing the column header and dragging it to a new location. To sort your report by a
column, click its column header. You can also hover over the column header and choose Sort Ascending or Sort
Descending from the drop-down list.

Resizing Panes
You can resize the Fields, Filters, and Preview panes by grabbing and dragging the divider to a new location.

Running and Saving the Report
Once you've modified your report, click Save, Save As, or Run Report. If you navigate away from report builder without
saving, you may lose your changes.

Custom Dashboard Tables

You asked for it! This enhancement is from ideas on the IdeaExchange about adding columns and choosing
summary fields for dashboard table components.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”

AND

“Manage Dashboards”

To create, edit, clone, and delete dashboards:

In previous releases, dashboard tables were limited to two columns selected by default. With Spring '10, you can create a
custom dashboard table with up to four columns.
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To add a table component to a dashboard:

1. Edit the dashboard, then add a new component or edit one that you want to change.
2. Select Table as the Component Type. A default two-column table is created for you using the first grouping and summary

field from the chart in the source report. If the report has no chart, default columns are based on the first grouping and
summary field in the report. To use a tabular report as the source report, Rows to Display must be set for that report.

3. To sort the default table, set the Sort By option to sort ascending or descending by row labels or values.
4. Set the Maximum Values Displayed to limit the number of rows in the table. For example, you can show the top five

salespeople from a report that groups amounts by owner.
5. Click the Customize Table link to create a custom table. The Maximum Values Displayed field is populated with

the value you entered, and the first two columns are pre-populated with the default columns.

Note: To customize a table, the source report must be summary or matrix and contain a chart.

6. Specify up to four columns to display in the table. Available columns can be any grouping or summary field in the chart,
or the second-level grouping in the source report.

7. Choose the sort order by selecting ascending or descending on a column. You can't sort on second-level groupings.
8. Optionally, define up to three value ranges to highlight on your component. Highlighting only applies to the first summary

field column in the table.

DescriptionSetting

Select a color to represents the low range, up to the first breakpoint.Low Range Color

The value that separates the low and middle range colors on the dashboard.Breakpoint #1 Value

Select a color to represent the middle range, between the first and second breakpoints.Middle Range Color

The value that separates the middle and high range colors on the dashboard.Breakpoint #2 Value

Select a color to represent the high range, beyond the second breakpoint.High Range Color

Note:  Customized tables allow null values in the results. Default two-column tables do not.
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See a Dashboard's Running User

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”

AND

Access to view dashboard folders

To view dashboards:

“Manage Dashboards”To edit dashboards:

Dashboards are run using the security settings of a single user, the running user. All users with access to the dashboard see the
same data, regardless of their personal security settings.

In previous releases, users had no way of knowing a dashboard's running user, and might be confused by the perspective of
the data shown. With Spring '10, the running user is shown in the new Displaying data as field when viewing or editing
a dashboard. This additional information helps users put the data into context.

Dashboard Finder Improvements

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify report and dashboard settings:

With dashboard finder, you can quickly find a dashboard by typing its name in the search filter. All accessible dashboards
matching that text are dynamically displayed in the drop-down list.

In previous releases, dashboard finder was turned off for any user with access to more than 1000 dashboards. With Spring '10,
the maximum limit has been increased to 30,000. The first 1000 results are shown in a single list; above 1000, results are
shown 500 per page. Users with access to more than 30,000 dashboards are automatically defaulted to the static drop-down
list.

Note: For Internet Explorer 6, dashboard finder is automatically disabled for users with access to more than 1000
dashboards.
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If dashboard finder isn't already enabled, click Setup ➤ Customize ➤ Reports & Dashboards ➤ User Interface Settings,
then select Use Auto-Complete When Choosing Dashboards.

New Visibility Option for Report and Dashboard Folders

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards”

AND

“View All Data”

To create, edit, and delete public dashboard folders:

With Spring '10, a new visibility option is available for report and dashboard folders. The This folder is accessible
by all users, except for portal users option gives folder access to all users in your organization, but denies
access to portal users.

Note: This option is only available for report and dashboard folders in organizations with a partner portal or Customer
Portal enabled. If you don't have a portal, you won't see it.

The name of the This folder is accessible by all users option has been changed to This folder is
accessible by all users, including portal users. Only the name is different.

To use the new visibility option for report and dashboard folders:

1. Create a new folder, or edit an existing one.
2. Select This folder is accessible by all users, except for portal users.
3. Click Save.

Note: You can also access this setting through the metadata API.
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Updated Labels for Metric and Table Dashboard Components

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”

AND

“Manage Dashboards”

To create, edit, clone, and delete dashboards:

For metric and table dashboard components, the heading label “Step 4: Indicator Colors (Optional)” has changed to “Step 4:
Conditional Highlighting” to be more consistent with terminology in other areas of the application.

Force.com Web Services API Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

The Force.com Web Services API version 18.0 contains new features and bug fixes that improve the capabilities of applications
that leverage the Force.com platform. Considerable effort has been made to ensure backwards capability for applications that
have been written against previous versions of the API, starting with API 2.5.

The new API provides a number of powerful enhancements that further improve any integration already in place between
Salesforce.com and your other systems.

After the Spring '10 release, the 17.0 version of the WSDL file is no longer available. Instead, all requests for a WSDL return
the 18.0 version. Please remember to save WSDL files with your project, as the enterprise WSDL is custom to your organization.
Salesforce.com maintains backwards compatibility with previous versions of our API in accordance with our stated support
policy. We recommend that developers migrate to the latest version of the API as often as is feasible in order to receive the
benefit of new enhancements from release to release. Developers with integrations on API versions prior to version 2.5 should
plan to migrate to the most recent API in preparation for the eventual end of support for the older API versions.

Generally Available Enhancements

The Force.com Web Services API has been improved for Spring '10 (API version 18.0):

New SOSL Clause for Filtering By Data Categories
An additional SOSL clause has been added in API version 18.0. The optional WITH DATA CATEGORY clause allows
you to filter all search results that are associated with one or more data categories and are visible to users. For more
information, see “WITH DATA CATEGORY DataCategorySpec” in the Force.com Web Services API Developer's
Guide.

New Support for API Version in Outbound Messages
In Spring '10, outbound messages include a new API Version field. Previously, all outbound messages used API
version 8.0. Now, the API Version field is automatically set to the current API version when the outbound message
was created.
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Id field in sObject Now Required
The Id field in sObject no longer has minOccurs="0" in its WSDL definition. This means that the field is required,
but it is still nillable as nillable="true". This change is necessary to accommodate the new AggregateResult object,
which supports aggregate functions in SOQL. AggregateResult uses xsd:any to represent the set of aggregate values
in your query. An optional Id field would result in a Unique Particle Attribution (UPA) violation in the XML schema.
This change to the Id field circumvents the UPA issue.

New Objects
The following new objects have been added in API version 18.0:

• The following new objects were added for Salesforce Chatter. To access these objects, Salesforce Chatter must be
enabled for your organization.

Note:  A feed is a list of recent activities in Salesforce.com, which can include status updates, changes to
record fields, and posts about records. Feeds are a useful way to stay up-to-date with what's going on in
Salesforce.com.

- The AccountFeed object represents a single feed item in an account record feed.
- The AssetFeed object represents a single feed item in an asset record feed.
- The CampaignFeed object represents a single feed item in a campaign record feed.
- The CaseFeed object represents a single feed item in a case record feed.
- The ContactFeed object represents a single feed item in a contact record feed.
- The ContractFeed object represents a single feed item in a contract record feed.
- The EntitySubscription object represents a subscription for a user following a record.
- The FeedComment object represents a comment added to a feed by a user.
- The FeedPost object represents the following types of changes in a NewsFeed, UserProfileFeed, or record feed,

such as AccountFeed: status updates, posts, link posts, and content posts.
- The FeedTrackedChange object represents an individual field change in a feed.
- The LeadFeed object represents a single feed item in a lead record feed.
- The NewsFeed object represents a single feed item in the news feed on a user's home page. A news feed shows

recent changes to records which the user is following.
- The OpportunityFeed object represents a single feed item in an opportunity record feed.
- The Product2Feed object represents a single feed item in a product record feed.
- The SolutionFeed object represents a single feed item in a solution record feed.
- The UserFeed object represents a single feed item in a user record feed.
- The UserProfileFeed represents a user profile feed, which tracks all actions by a user on records that can be tracked

in a feed. This feed is displayed on the user profile page.

• The following new objects were added for Entitlement Management.To access these objects, entitlement management
must be enabled for your organization.

- The CaseMilestone object represents a required step in an entitlement process on a case.
- The ContractLineItem object represents a product covered by a ServiceContract (customer support agreement).
- The ContractLineItemHistory object represents the history of changes to field values on a product covered by a

ServiceContract (customer support agreement).
- The Entitlement object represents the customer support an Account or Contact is eligible to receive. This differs

from a ServiceContract because some organizations don't require customer support agreements to provide service.
- The EntitlementContact object represents a Contact eligible to receive customer support via an Entitlement.
- The EntitlementHistory object represents the history of changes to field values on an Entitlement.
- The EntitlementTemplate object represents predefined terms of customer support for products (Product2 object).
- The MilestoneType object represents a milestone (required step in an entitlement process).
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- The ProductEntitlementTemplate object represents predefined terms of customer support that users can add to
products.

- The ServiceContract object represents a customer support agreement.
- The ServiceContractHistory object represents the changes to field values on a ServiceContract.
- The ServiceContractOwnerSharingRule object represents the rules for sharing a ServiceContract with users other

than the owner.
- The ServiceContractShare object represents a sharing entry on a ServiceContract.

• The following objects are now generally available for Sites. To access these objects, Force.com Sites must be enabled
for your organization.

- The read-only Site object represents a public website that is integrated with a Salesforce.com organization.
- The read-only SiteHistory object represents the history of changes to the values in the fields of a site.

• The following objects are now generally available for the Answers feature. To access these objects, answers must be
enabled for your organization.

- The Question object represents a topic that a user has posted to an answers community.
- The Reply object represents a reply that a user has posted in response to a question.

• The following objects are now generally available for the Quotes feature. To access these objects, quotes must be
enabled for your organization.

- The Quote object represents a quote, which is a record showing proposed prices for products and services. Quotes
can be created from and synced with opportunities, and emailed as PDFs to customers.

- The QuoteDocument object represents a quote in document format.

- The QuoteLineItem object represents a quote line item, which is a member of the list of Product2 products
associated with a Quote, along with other information about those line items on that quote.

• The KnowledgeArticleVersion object was added for Salesforce Knowledge. It represents an article. To access this
object, Salesforce Knowledge must be enabled for your organization.

New Calls
The following new calls have been added in API version 18.0 for Salesforce Knowledge and the Answers feature:

• describeDataCategoryGroups() call retrieves available category groups for objects specified in the request.
• describeDataCategoryGroupStructures() call retrieves available category groups along with their data

category structure for objects specified in the request.

Changed Objects
The following objects have been changed in API version 18.0:

• The Attachment object includes a Description field that displays the description of the attachment.
• The CallCenter object includes a Version field that displays the version number of call centers built with the CTI

Developer's Toolkit 2.0 or higher.
• The Case object includes an SlaStartDate field that displays the date a case entered an entitlement process. It

also includes an IsStopped field that indicates whether an entitlement process on a case is stopped or not, as well
as a StopStartDate field that displays the date an entitlement process was stopped on a case.

• The EmailServicesFunction includes an IsTextAttachmentsAsBinary field to support converting text attachments
to binary attachments.

• ApexClassId is now a required field for the EmailServicesFunction object.
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• The Group object includes a DoesIncludeBosses field that indicates whether the managers have access (true)
or do not have access (false) to records shared with members of the group. This field is only available for public
groups.

• The OpportunityLineItem object includes a Discount field to support discounts for opportunity products. It also
includes a Subtotal field, which shows the difference between standard and discounted pricing.

• The Organization object includes a MonthlyPageViewsEntitlement field that displays the number of page views
allowed for the current calendar month for the sites in your organization. The Organization object also includes a
MonthlyPageViewsUsed field that displays the number of page views used for the current calendar month for the
sites in your organization. To access these fields, Sites must be enabled for your organization.

• The User object includes a UserPreferencesDisableAutoSubForFeeds field for Salesforce Chatter.This field
turns off automatic subscriptions to feeds created by the user.

• The single email and mass email limits are now separate. SingleEmailMessage, used by the sendEmail() call,
returns SINGLE_EMAIL_LIMIT_EXCEEDED when the limit is reached (version 18.0 and higher). MassEmailMessage,
used by the sendEmail() call, continues to return MASS_MAIL_LIMIT_EXCEEDED.

• The Vote object can now be used to vote on the new Reply object.
• The UserLicense object now supports these field values:

ValueField

Authenticated Website: label is Authenticated WebsiteName

Platform_Portal_User: corresponds to the Authenticated
Website User user license

LicenseDefinitionKey

Changed Calls
The following calls have been changed in API version 18.0:

• The results of the describeSoftphoneLayout() call now include the new screenPopOptions setting for
SoftPhone layouts associated with CTI 2.0 adapters or higher.

• The read-only AggregateResult object contains the results returned by a query() call if the query contains an
aggregate function, such as MAX().

• The charset argument in SingleEmailMessage, used by the sendEmail() call, is unavailable if you are specifying
the templateId because the template specifies the character set.

New SOAP Header
The DisableFeedTrackingHeader header specifies whether the changes made in the current call are tracked in
feeds. Use this header if you want to process a large number of records without tracking the changes in various feeds
related to the records.This header is available if the Chatter feature is enabled for your organization. For more information
on Chatter, see “Salesforce Chatter Overview” in the Salesforce.com online help.

New Concurrent API Request Limit
Production and sandbox organizations now have a limit of 25 concurrent requests (calls) with a duration of 20 seconds
or longer.

API Migration Issues

The following technical notes are available to assist you in migrating from earlier versions:

• Release 4.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-10
• Release 5.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-13
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• Release 6.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-15
• Release 7.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-17
• Release 8.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-19
• Release 9.0:

http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Spring_%2707

• Release 10.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Summer_%2707

• Release 11.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Winter_%2708

• Release 12.0:
http://wiki.apexdevnet.com/index.php?title=What%27s_New_in_Force.com_Web_Services_API_Spring_%2708

• Release 13.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Summer_%2708

• Release 14.0: Force.com Web Services API Developer's Guide Version 14.0
• Release 15.0: Force.com Web Services API Developer's Guide Version 15.0
• Release 16.0: Force.com Web Services API Developer's Guide Version 16.0
• Release 17.0: Force.com Web Services API Developer's Guide Version 17.0

Documentation for these earlier versions is also available. See
wiki.developerforce.com/index.php/Earlier_Reference_Documentation on Developer Force for links to
online and PDF versions.

SOQL Enhancements
The Salesforce.com Object Query Language (SOQL) is similar to the SELECT command in SQL. SOQL allows you to
construct simple but powerful query strings when you are using the API, Apex, or Visualforce.

Generally Available Enhancements for SOQL

SOQL has been improved for Spring '10 (API version 18.0):

New GROUP BY Clause

You asked for it! This enhancement is an idea from the IdeaExchange.

Spring '10 introduces a new GROUP BY clause in SOQL that is similar to GROUP BY in SQL. You can use GROUP BY
with new aggregate functions, such as SUM() or MAX(), to summarize the data and roll up query results rather than
having to process the individual records in your code. For example, you can use GROUP BY to determine how many leads
are associated with each LeadSource value:

SELECT LeadSource, COUNT(Name)
FROM Lead
GROUP BY LeadSource

If you want a query to do the work of calculating subtotals so that you don't have to maintain that logic in your code,
use GROUP BY ROLLUP. If you want to calculate subtotals for every possible combination of grouped field (to generate
a cross-tabular report, for example), use GROUP BY CUBE instead.

For more information, see “GROUP BY” in the Force.com Web Services API Developer's Guide.
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New HAVING Clause
There is a new HAVING clause in SOQL that is similar to HAVING in SQL. You can use a HAVING clause with a GROUP
BY clause to filter the results returned by aggregate functions, such as SUM(). A HAVING clause is similar to a WHERE
clause. The difference is that you can include aggregate functions in a HAVING clause, but not in a WHERE clause. For
example, the following query returns accounts with duplicate names:

SELECT Name, Count(Id)
FROM Account
GROUP BY Name
HAVING Count(Id) > 1

For more information, see “HAVING” in the Force.com Web Services API Developer's Guide.

Aggregate Functions

You asked for it! This enhancement is an idea from the IdeaExchange.

Aggregate functions allow you to roll up and summarize your data for analysis. You can use these functions without
using a GROUP BY clause. For example, you could use the AVG() aggregate function to find the average Amount for all
your opportunities.

SELECT AVG(Amount) FROM Opportunity

However, these functions become a more powerful tool to generate reports when you use them with a GROUP BY clause.
For example, you could find the average Amount for all your opportunities by campaign.

SELECT CampaignId, AVG(Amount)
FROM Opportunity
GROUP BY CampaignId

This table lists all the aggregate functions supported by SOQL.

DescriptionAggregate Function

Returns the average value of a numeric field. For example:

SELECT CampaignId, AVG(Amount)
FROM Opportunity
GROUP BY CampaignId

AVG()

Returns the number of rows matching the query criteria. There are two versions of
count function: the existing COUNT() function and the new COUNT(fieldName)

COUNT()

aggregate function. You can't use a GROUP BY clause with COUNT(), but you can
with COUNT(fieldName). For example:

SELECT COUNT() FROM Account WHERE Name LIKE 'a%'

SELECT COUNT(Id) FROM Account WHERE Name LIKE 'a%'
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DescriptionAggregate Function

Note: COUNT(Id) in SOQL is equivalent to COUNT(*) in SQL.

Returns the number of distinct non-null field values matching the query criteria.
For example:

SELECT COUNT_DISTINCT(Company)
FROM Lead

COUNT_DISTINCT()

Note: COUNT_DISTINCT(fieldName) in SOQL is equivalent to
COUNT(DISTINCT fieldName) in SQL.

You can use a GROUP BY clause without an aggregated function to query all the
distinct values, including null, for an object.The following query returns the distinct
set of values stored in the LeadSource field.

SELECT LeadSource
FROM Lead
GROUP BY LeadSource

Returns the minimum value of a field. For example:

SELECT MIN(CreatedDate), FirstName, LastName
FROM Contact
GROUP BY FirstName, LastName

MIN()

If you use the MIN() or MAX() functions on a picklist field, the function uses the sort
order of the picklist values instead of alphabetical order.

Returns the maximum value of a field. For example:

SELECT Name, MAX(BudgetedCost)
FROM Campaign
GROUP BY Name

MAX()

Returns the total sum of a numeric field. For example:

SELECT SUM(Amount)
FROM Opportunity
WHERE IsClosed = false AND Probability > 60

SUM()

For more information, see “Aggregate Functions” in the Force.com Web Services API Developer's Guide.
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Date Functions
Date functions allow you to group or filter your data by various date periods. For example, you could use the
CALENDAR_YEAR() function to find the sum of the Amount values for all your opportunities for each calendar year.

SELECT CALENDAR_YEAR(CreatedDate), SUM(Amount)
FROM Opportunity
GROUP BY CALENDAR_YEAR(CreatedDate)

This table lists all the date functions supported by SOQL.

ExamplesDescriptionDate Function

Returns a number representing the calendar
month of a date field.

CALENDAR_MONTH() • 1 for January
• 12 for December

Returns a number representing the calendar
quarter of a date field.

CALENDAR_QUARTER() • 1 for January 1 through March 31
• 2 for April 1 through June 30
• 3 for July 1 through September 30
• 4 for October 1 through December 31

2009Returns a number representing the calendar year
of a date field.

CALENDAR_YEAR()

20 for February 20Returns a number representing the day in the
month of a date field.

DAY_IN_MONTH()

Returns a number representing the day of the
week for a date field.

DAY_IN_WEEK() • 1 for Sunday
• 7 for Saturday

32 for February 1Returns a number representing the day in the year
for a date field.

DAY_IN_YEAR()

2009-09-22 for September 22, 2009

You can only use DAY_ONLY() with dateTime
fields.

Returns a date representing the day portion of a
dateTime field.

DAY_ONLY()

If your fiscal year starts in March:Returns a number representing the fiscal month
of a date field. This differs from

FISCAL_MONTH()

• 1 for March
CALENDAR_MONTH() if your organization uses
a fiscal year that does not match the Gregorian
calendar.

• 12 for February

See “Setting the Fiscal Year” in the
Salesforce.com online help.

If your fiscal year starts in July:Returns a number representing the fiscal quarter
of a date field. This differs from

FISCAL_QUARTER()

• 1 for July 15
CALENDAR_QUARTER() if your organization uses
a fiscal year that does not match the Gregorian
calendar.

• 4 for June 6

2009Returns a number representing the fiscal year of
a date field. This differs from

FISCAL_YEAR()

CALENDAR_YEAR() if your organization uses a
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ExamplesDescriptionDate Function

fiscal year that does not match the Gregorian
calendar.

18 for a time of 18:23:10

You can only use HOUR_IN_DAY() with
dateTime fields.

Returns a number representing the hour in the
day for a dateTime field.

HOUR_IN_DAY()

2 for April 10

The first week is from the first through the
seventh day of the month.

Returns a number representing the week in the
month for a date field.

WEEK_IN_MONTH()

1 for January 3

The first week is from January 1 through January
7.

Returns a number representing the week in the
year for a date field.

WEEK_IN_YEAR()

Note: SOQL queries in a client application return dateTime field values as Coordinated Universal Time (UTC)
values. To convert dateTime field values to your default time zone, use convertTimezone(dateTimeField).
Note that you can only use convertTimezone() in a date function.

For more information, see “Date Functions” in the Force.com Web Services API Developer's Guide.

Semi-Join and Anti-Join Support For Reference Fields
A semi-join is a subquery on another object in an IN clause in a SOQL query. You can use semi-joins to create advanced
queries, such as getting all contacts for accounts that have an opportunity with a particular record type. An anti-join is
a subquery on another object in a NOT IN clause in a SOQL query. You can use anti-joins to create advanced queries,
such as getting all accounts that do not have any open opportunities.

Prior to API version 18.0, the subquery could only filter by an ID (primary key) field. For example, the following query
returns account IDs if an associated opportunity is lost:

SELECT Id, Name
FROM Account
WHERE Id IN
(SELECT AccountId FROM Opportunity WHERE StageName = 'Closed Lost')

Notice that the left operand,Id, of the IN clause is an ID field. Filtering by an ID field allows you to create parent-to-child
semi- or anti-joins, such as Account to Contact.

With API version 18.0, the subquery can now filter by ID (primary key) or reference (foreign key) fields.This also allows
you to create child-to-child semi- or anti-joins, such as Contact to Opportunity, or child-to-parent semi- or anti-joins,
such as Opportunity to Account.The following query returns task IDs for all contacts in Twin Falls:

SELECT Id
FROM Task
WHERE WhoId IN
(SELECT Id FROM Contact WHERE MailingCity = 'Twin Falls')

For more information, see “Comparison Operators” in the Force.com Web Services API Developer's Guide.
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Filtering By Data Categories

The WITH DATA CATEGORY clause is used in a SELECT statement to filter records based on their classification in one
or more data category groups. If WITH DATA CATEGORY is specified, the query() only returns matching records that
are associated with the specified data categories and are visible to the user. If unspecified, the query() only returns the
matching records that are visible to the user.

Note: The WITH DATA CATEGORY clause does not support bind variables.

The WITH DATA CATEGORY SOQL syntax is:

WITH DATA CATEGORY filteringExpression

The filteringExpression syntax is:

dataCategorySelection [AND dataCategorySelection2 ...]

The WITH DATA CATEGORY clause only filters objects of type:

• Question—to query questions.
• KnowledgeArticleVersion—to query articles.

The examples in this section are based on the following data category group:

Geography__c
ww__c

northAmerica__c
usa__c
canada__c
mexico__c

europe__c
france__c
uk__c

asia__c

The category filtering in the statements below is highlighted in bold. For more information on the syntax, see “WITH
DATA CATEGORY filteringExpression” in the Force.com Web Services API Developer's Guide.

• SELECT Title FROM KnowledgeArticleVersion WITH DATA CATEGORY Geography__c ABOVE usa__c

• SELECT Title FROM KnowledgeArticleVersion WHERE LastPublishedDate > 2009-01-01 WITH
DATA CATEGORY Geography__c AT (usa__c, uk__c)

• SELECT Language FROM KnowledgeArticleVersion WHERE FirstPublishedDate < 2009-01-01
WITH DATA CATEGORY Geography__c AT usa__c AND Product__c ABOVE_OR_BELOW
mobile_phones__c ORDER BY Title
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Force.com Bulk API Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

The REST-based Bulk API is optimized to process a large number of records asynchronously. It allows you to load large
batches of data that are processed in the background.

New Delete Operation

With Spring '10 (API version 18.0), the Bulk API now supports deleting records to enhance existing support for inserting,
updating, and upserting records.

For more information, see JobInfo.

Using Data Loader for Delete

You can now use the Bulk API to delete records in Data Loader by enabling the Use Bulk API setting. This setting replaces
the Use Bulk API for Insert, Update, and Upsert setting. To download Data Loader, click Setup ➤ Data
Management ➤ Data Loader.

Data Loader uses the SOAP-based Web services API by default. To use the Bulk API instead:

1. Open the Data Loader client.
2. Click Settings ➤ Settings.
3. Select the Use Bulk API checkbox.
4. Click OK.

For more information about the Data Loader, see “Data Loader Overview” in the Salesforce.com online help.

Force.com Apex Code Enhancements
Available in: Unlimited, Developer, and Enterprise Editions

Force.com Apex code includes the following enhancements in Spring '10. Refer to the Force.com Apex Code Developer's
Guide for complete information about Apex.

The following enhancements are generally available:

Apex Scheduler (Code Scheduler) Generally Available

The Apex scheduler (Code Scheduler) is now generally available.

Callouts Enhancements

You can click Generate from WSDL to generate an Apex class from a WSDL. This allows you to make callouts to an
external Web service from an Apex script. The following enhancements have been made:

• Increased Size Limit for HTTP Callouts—The maximum size of a request or response for an HTTP or Web
services callout is now 1 MB. This grants HTTP callouts parity in size limits with Web services callouts.
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• Output Message with Multiple Elements—Prior to Spring '10, you couldn't generate an Apex class from a WSDL
if it contained an output message with more than one element. With Spring '10, the generated Apex wraps the output
elements in an inner class. The Apex method that represents the WSDL operation returns the inner class instead of
the individual elements.

• New DOM Classes—New DOM (Document Object Model) classes help you to parse or generate XML content.
Use the Document class to process the content in the body of an XML document. Use the XmlNode class to work
with a node in an XML document.

You can use these classes to create the body of a request for HttpRequest or to parse a response accessed by
HttpResponse.

• New getBodyDocument Method for HttpResponse—The new method allows you to process an HTTP response
as a DOM Document object.

• New getBodyDocument and setBodyDocument Methods for HttpRequest—The new methods allows you to
get and set the body of an HTTP request as a DOM Document object.

• Enhanced Two-Way SSL Authentication—You can use two-way SSL authentication by sending a certificate with
your callout. This enhances security as the target of the callout receives the certificate and can use it to authenticate
the request against its keystore.

Prior to Spring '10, you could implement two-way authentication by using a certificate obtained from a third party
for your organization. Then, you encoded your client certificate key in base64 and referenced it in your Apex class.
This doesn't follow security best practices for protecting private keys.

With Spring '10, you can enhance security by sending a certificate generated in Salesforce.com or signed by a certificate
authority (CA) with your callout. You can generate a self-signed or CA-signed certificate at Setup ➤ Security
Controls ➤ Certificate and Key Management.

• New setClientCertificateName Method for HttpRequest—The new method allows you to set the certificate
name if the external service requires a client certificate for authentication. The setClientCertificate method
has been deprecated.

Line Numbers Now in Detail View

When you view the details of either an Apex class or trigger, line numbers now display, as they do when you edit Apex.

Change to getContent Method

As of API version 18, the PageReference.getContent method throws an ExecutionException error if the
Visualforce page you're trying to access has invalid markup.

Limit to Number of execute Methods

A maximum of 250,000 execute methods can be called in a 24 hour period for an organization.

Collection Limits Removed

Limits on the number of items in a collection has been removed. However, there's still a general limit on heap size.

Generic Collection Creations Now Supported

As of Spring '10, you can use generic sObjects to create a collection. For example, the following is now possible:

Set<Sobject> foo = new Set<Sobject>();
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Note: This is only available for classes saved using Salesforce.com API version 18.0 or later.

Improvements to sObjects

sObjects are now treated as Objects in Apex.

New setBestReply Method for Answers

Sets a specific reply for a specific question as the best reply. Because a question can have multiple replies, setting the best
reply helps users quickly identify the reply that contains the most helpful information. In the Salesforce.com user interface,
this is the same as setting a reply as the best answer.

New findSimilar Method for Answers

Returns a list of up to five similar questions based on the title of question Only ten findSimilar calls are allowed
per transaction.

New getUiTheme and getUiThemeDisplayed Methods for Userinfo

Use getUiTheme to determine the default theme set for the organization and getUiThemeDisplayed to determine
the theme currently displayed to the user.

Apex Triggers Available for the ContentVersion Object

Now you can define Apex triggers for the ContentVersion object.

To create triggers for the ContentVersion object, click Setup➤ Customize➤ Salesforce CRM Content➤ Triggers.

Debug Logs
For Spring '10 many improvements have been made to the debug log, including:

• The ability to set filters, that is, the category and level of information that gets recorded in the debug log. The combination
of category and level specify which events get logged. Each event may record additional information, such as the line and
character number where the event started, fields associated with the event, duration of the event in milliseconds, and so
on.

• A header that indicates the API version used to generate the log and the specified categories and levels.
• The start and end of the execution in the transaction cleared delimited by EXECUTION_START and EXECUTION_FINISHED.
• Discrete units of work inside the transaction indicated by CODE_UNIT_STARTED and CODE_UNIT_FINISHED. Code

units include Apex triggers, validation rules, Web service invocations, and so on.
• Cumulative resource usage as well as cumulative profiling information.

Implementation Tips

• Changing the category and level for a debug log only changes what gets recorded in future debug logs. It does not change
what is recorded in existing logs.

• Debug logs are recorded either for individual users (Setup➤Monitoring➤Debug Logs) or in the System Log console.
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About Debug Logs

Debug Log Details

After you generate a debug log, the type and amount of information listed depends on the filter values you set for the user.
However, the format for a debug is always the same.

A debug log has the following sections:

Header
The header contains the following information:

• The version of the API used during the transaction.
• The log category and level used to generate the log. For example:

The following is an example of a header:

18.0 DB,INFO;WORKFLOW,INFO;VALIDATION,INFO;CALLOUT,INFO;APEX_CODE,INFO;
APEX_PROFILING,INFO

In this example, the API version is 18.0, and the following debug log categories and levels have been set:

LevelCategory

INFODatabase

INFOWorkflow

INFOValidation

INFOCallout

INFOApex Code

INFOApex Profiling

Execution Units
An execution unit is equivalent to a transaction. It contains everything that occurred within the transaction.The execution
is delimited by EXECUTION_START and EXECUTION_FINISHED.

Code Units
A code unit is a discrete unit of work within a transaction. For example, a trigger is one unit of code, as is a webService
method, or a validation rule.

Note:  A class is not a discrete unit of code.

Units of code are indicated by CODE_UNIT_STARTED and CODE_UNIT_FINISHED. Units of work can imbed other
units of work. For example:

EXECUTION_STARTED
CODE_UNIT_STARTED|[EXTERNAL]execute_anonymous_apex
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CODE_UNIT_STARTED|[EXTERNAL]MyTrigger on Account trigger event BeforeInsert for null
CODE_UNIT_FINISHED <-- The trigger ends
CODE_UNIT_FINISHED <-- The executeAnonymous ends
EXECUTION_FINISHED

Units of code include, but are not limited to, the following:

• Triggers
• Workflow invocations and time-based workflow
• Validation rules
• Approval processes
• Apex lead convert
• @future method invocations
• Web service invocations
• executeAnonymous calls
• Visualforce property accesses on Apex controllers
• Visualforce actions on Apex controllers
• Execution of the batch Apex start and finish methods, as well as each execution of the execute method
• Execution of the Apex System.Schedule execute method
• Incoming email handling

Log Lines
Included inside the units of code. These indicate what code or rules are being executed, or messages being specifically
written to the debug log. For example:

Figure 3: Debug Log Line Example

Log lines are made up of a set of fields, delimited by a pipe (|). The format is:

• Timestamp—specified in the user's time zone, of the format HH:mm:ss.SSS
• Event identifier—the specific event that triggered the debug log being written to, such as SAVEPOINT_RESET or

VALIDATION_RULE, and any additional information logged with that event, such as the method name or the line
and character number where the code was executed.

Additional Log Data
In addition, the log contains the following information:

• Cumulative resource usage—Logged at the end of many code units, such as triggers, executeAnonymous, batch
Apex message processing,@future methods, Apex test methods, Apex web service methods, and Apex lead convert.

• Cumulative profiling information—Logged once at the end of the transaction. Contains information about the most
expensive queries (that used the most resources), DML invocations, and so on.

The following is an example debug log:

18.0 DB,INFO;WORKFLOW,FINEST;VALIDATION,INFO;APEX_CODE,FINE;APEX_PROFILING,FINE
13:17:05.382|EXECUTION_STARTED
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13:17:05.382|CODE_UNIT_STARTED|[EXTERNAL]TestHandleProductPriceChange.testPriceChange
13:17:05.383|DML_BEGIN|[5,1]|Op:Insert|Type:Invoice_Statement__c|Rows:1
13:17:06.084|DML_END|[5,1]|
13:17:06.085|DML_BEGIN|[13,1]|Op:Insert|Type:Merchandise__c|Rows:2
13:17:06.115|DML_END|[13,1]|
13:17:06.117|DML_BEGIN|[21,1]|Op:Insert|Type:Line_Item__c|Rows:2
13:17:06.331|DML_END|[21,1]|
13:17:06.332|DML_BEGIN|[26,1]|Op:Update|Type:Merchandise__c|Rows:2
13:17:06.371|CODE_UNIT_STARTED|[EXTERNAL]HandleProductPriceChange on Merchandise

trigger event AfterUpdate for a00D0000008dfOw, a00D0000008dfOx
13:17:06.382|SOQL_EXECUTE_BEGIN|[3,1]|Aggregations:0|
SELECT j.Price__c, j.Merchandise__r.price__c
FROM Line_Item__c j
WHERE j.Invoice_Statement__r.Status__c = 'Negotiating'
AND j.Merchandise__r.id IN :Trigger.new
FOR UPDATE
13:17:06.450|SOQL_EXECUTE_END|[3,1]|Rows:2|Duration:68
13:17:06.452|DML_BEGIN|[14,1]|Op:Update|Type:Line_Item__c|Rows:2
13:17:06.470|DML_END|[14,1]|
13:17:06.471|CUMULATIVE_LIMIT_USAGE
13:17:06.471|LIMIT_USAGE_FOR_NS|(default)|
Number of SOQL queries: 0 out of 100
Number of query rows: 0 out of 500
Number of SOSL queries: 0 out of 20
Number of DML statements: 4 out of 100
Number of DML rows: 7 out of 500
Number of script statements: 10 out of 200000
Maximum heap size: 0 out of 1000000
Number of callouts: 0 out of 10
Number of Email Invocations: 0 out of 10
Number of fields describes: 0 out of 10
Number of record type describes: 0 out of 10
Number of child relationships describes: 0 out of 10
Number of picklist describes: 0 out of 10
Number of future calls: 0 out of 10
Number of find similar calls: 0 out of 10
Number of System.runAs() invocations: 0 out of 20

13:17:06.471|TESTING_LIMITS
13:17:06.471|LIMIT_USAGE_FOR_NS|(default)|
Number of SOQL queries: 1 out of 20
Number of query rows: 2 out of 2000
Number of SOSL queries: 0 out of 0
Number of DML statements: 1 out of 20
Number of DML rows: 2 out of 200
Number of script statements: 4 out of 10400
Maximum heap size: 0 out of 200000
Number of callouts: 0 out of 10
Number of Email Invocations: 0 out of 10
Number of fields describes: 0 out of 10
Number of record type describes: 0 out of 10
Number of child relationships describes: 0 out of 10
Number of picklist describes: 0 out of 10
Number of future calls: 0 out of 10
Number of find similar calls: 0 out of 0
Number of System.runAs() invocations: 0 out of 20

13:17:06.471|TOTAL_EMAIL_RECIPIENTS_QUEUED|0
13:17:06.471|STATIC_VARIABLE_LIST
HandleProductPriceChange:openLineItems:400

13:17:06.471|CUMULATIVE_LIMIT_USAGE_END

13:17:06.472|CODE_UNIT_FINISHED
13:17:06.473|DML_END|[26,1]|
13:17:06.473|SOQL_EXECUTE_BEGIN|[29,1]|Aggregations:0|

SELECT id, Price__c FROM Line_Item__c WHERE id IN :lineItems
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13:17:06.481|SOQL_EXECUTE_END|[29,1]|Rows:2|Duration:8
13:17:06.482|CUMULATIVE_LIMIT_USAGE
13:17:06.482|LIMIT_USAGE_FOR_NS|(default)|
Number of SOQL queries: 1 out of 100
Number of query rows: 2 out of 500
Number of SOSL queries: 0 out of 20
Number of DML statements: 4 out of 100
Number of DML rows: 7 out of 500
Number of script statements: 13 out of 200000
Maximum heap size: 0 out of 1000000
Number of callouts: 0 out of 10
Number of Email Invocations: 0 out of 10
Number of fields describes: 0 out of 10
Number of record type describes: 0 out of 10
Number of child relationships describes: 0 out of 10
Number of picklist describes: 0 out of 10
Number of future calls: 0 out of 10
Number of find similar calls: 0 out of 10
Number of System.runAs() invocations: 0 out of 20

13:17:06.482|TESTING_LIMITS
13:17:06.482|LIMIT_USAGE_FOR_NS|(default)|
Number of SOQL queries: 1 out of 20
Number of query rows: 2 out of 2000
Number of SOSL queries: 0 out of 0
Number of DML statements: 1 out of 20
Number of DML rows: 2 out of 200
Number of script statements: 5 out of 10400
Maximum heap size: 0 out of 200000
Number of callouts: 0 out of 10
Number of Email Invocations: 0 out of 10
Number of fields describes: 0 out of 10
Number of record type describes: 0 out of 10
Number of child relationships describes: 0 out of 10
Number of picklist describes: 0 out of 10
Number of future calls: 0 out of 10
Number of find similar calls: 0 out of 0
Number of System.runAs() invocations: 0 out of 20

13:17:06.482|TOTAL_EMAIL_RECIPIENTS_QUEUED|0
13:17:06.482|STACK_FRAME_VARIABLE_LIST
Frame0

13:17:06.482|CUMULATIVE_LIMIT_USAGE_END

13:17:06.482|CODE_UNIT_FINISHED
13:17:06.482|EXECUTION_FINISHED
13:17:06.497|CUMULATIVE_PROFILING_BEGIN
13:17:06.497|CUMULATIVE_PROFILING|SOQL operations|
Trigger.HandleProductPriceChange: line 3, column 1:
[SELECT j.Price__c, j.Merchandise__r.price__c
FROM Line_Item__c j
WHERE j.Invoice_Statement__r.Status__c = 'Negotiating'
AND j.Merchandise__r.id IN :Trigger.new
FOR UPDATE]: executed 1 time in 68 ms

13:17:06.497|CUMULATIVE_PROFILING|No profiling information for SOSL operations
13:17:06.497|CUMULATIVE_PROFILING|DML operations|
Trigger.HandleProductPriceChange: line 14, column 1: Update:

LIST:SOBJECT:Line_Item__c: executed 1 time in 17 ms

13:17:06.497|CUMULATIVE_PROFILING|No profiling information for method invocations
13:17:06.497|CUMULATIVE_PROFILING_END
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Debug Log Filters
When using the System Log console or monitoring a debug log, you can specify the level of information that gets included
in the log. For Spring '10, specifying a combination of category and level specifies which events get logged.

About Debug Log Filters

Setting Debug Log Filters

Available in: Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“View All Data”To use the System Log console:

“Author Apex”To use the text entry box:

When using the System Log console or monitoring a debug log, you can specify the level of information that gets included
in the log.

Log category

The type of information logged, such as information from Apex or workflow rules.

Log level

The amount of information logged.

Event type

The combination of log category and log level that specify which events get logged. Each event may log additional
information, such as the line and character number where the event started, fields associated with the event, duration of
the event in milliseconds, and so on.

Debug Log Categories

You can specify the following log categories. The amount of information logged for each category depends on the log level:

DescriptionLog Category

Includes information about database activity, including every data manipulation
language (DML) statement or inline SOQL or SOSL query.

Database

Includes information for workflow rules, such as the rule name, the actions taken, and
so on.

Workflow

Includes information about validation rules, such as the name of the rule, whether the
rule evaluated true or false, and so on.

Validation
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DescriptionLog Category

Includes the request-response XML that the server is sending and receiving from an
external Web service.This is useful when debugging issues related to using Force.com
Web services API calls.

Callout

Includes information about Apex scripts and can include information such as log
messages generated by calls to the System.debug method, DML statements, inline

Apex Code

SOQL or SOSL queries, the start and completion of any triggers, and the start and
completion of any test method, and so on.

Includes cumulative profiling information, such as the limits for your namespace, the
number of emails sent, and so on.

Apex Profiling

Debug Log Levels

You can specify the following log levels. The levels are listed from lowest to highest. Specific events are logged based on the
combination of category and levels. Most events start being logged at the INFO level. The level is cumulative, that is, if you
select FINE, the log will also include all events logged at DEBUG, INFO, WARN and ERROR levels.

Note:  Not all levels are available for all categories: only the levels that correspond to one or more events.

• ERROR
• WARN
• INFO
• DEBUG
• FINE
• FINER
• FINEST

Debug Event Types

The following is an example of what is written to the debug log. The event is USER_DEBUG. The format is timestamp |
event identifier:

Figure 4: Debug Log Line Example

The event identifier is composed of the specific event that triggered the debug log being written to, such as SAVEPOINT_RESET
or VALIDATION_RULE, and any additional information logged with that event, such as the method name or the line and
character number where the code was executed.

In this example, the event identifier is made up of the following:

• Event name:

USER_DEBUG
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• Line and character number of the event in the code:

[1,1]

• Logging level the System.Debug method was set to:

DEBUG

• User-supplied string for the System.Debug method:

Hello world!

The following example of a log line is triggered by this code snippet.

Figure 5: Debug Log Line Code Snippet

The following log line is recorded when the test reaches line 5 in the code:

15:51:01.071|DML_BEGIN|[5,1]|Op:Insert|Type:Invoice_Statement__c|Rows:1

In this example, the event identifier is made up of the following:

• Event name:

DML_BEGIN

• Line and character number of the event in the code:

[5,1]

• DML operation type—Insert:

Op:Insert

• Object name:

Type:Invoice_Statement__c

• Number of rows passed into the DML operation:

Rows:1

The following table lists the event types that are logged, what fields or other information get logged with each event, as well
as what combination of log level and category cause an event to be logged.
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Level LoggedCategory LoggedFields or Information Logged With
Event

Event Name

INFO and aboveCalloutLine and character number of the event
in the code, request headers

CALLOUT_REQUEST

INFO and aboveCalloutLine and character number of the event
in the code, response body

CALLOUT_RESPONSE

INFO and aboveApex CodeNoneCODE_UNIT_FINISHED

INFO and aboveApex CodeLine and character number of the event
in the code, code unit name, such as

CODE_UNIT_STARTED

MyTrigger on Account trigger
event BeforeInsert for null

INFO and aboveApex ProfilingNoneCUMULATIVE_LIMIT_USAGE

INFO and aboveApex ProfilingNoneCUMULATIVE_LIMIT_USAGE_END

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING_BEGIN

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING_END

INFO and aboveApex CodeLine and character number of the event
in the code, operation (such as Insert,

DML_BEGIN

Update, and so on), record name or
type, number of rows passed into DML
operation

INFO and aboveApex CodeLine and character number of the event
in the code

DML_END

INFO and aboveApex CodeLine and character number of the event
in the code

EMAIL_QUEUE

INFO and aboveApex CodePackage namespaceENTERING_MANAGED_PKG

INFO and aboveApex CodeLine and character number of the event
in the code, exception type, message

EXCEPTION_THROWN

INFO and aboveApex CodeNoneEXECUTION_FINISHED

INFO and aboveApex CodeNoneEXECUTION_STARTED

ERROR and aboveApex CodeException type, message, stack traceFATAL_ERROR

FINESTApex CodeLine and character number of the event
in the code, number of bytes

HEAP_ALLOCATE

FINESTApex CodeLine and character number of the event
in the code

IDEAS_QUERY_EXECUTE

INFO and aboveApex ProfilingNamespace, following limits:
Number of SOQL queries
Number of query rows

LIMIT_USAGE_FOR_NS

Number of SOSL queries
Number of DML statements
Number of DML rows
Number of script statements
Maximum heap size
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Level LoggedCategory LoggedFields or Information Logged With
Event

Event Name

Number of callouts
Number of Email Invocations
Number of fields describes
Number of record type
describes
Number of child
relationships
describes
Number of picklist describes
Number of future calls
Number of find similar calls
Number of System.runAs()
invocations

FINESTApex CodeLine and character number of the event
in the code, method signature

METHOD_ENTRY

FINESTApex CodeLine and character number of the event
in the code, method signature

METHOD_EXIT

INFO and aboveDBLine and character number of the event
in the code, number of queryMore
iterations

QUERY_MORE_ITERATIONS

INFO and aboveDBLine and character number of the event
in the code, Savepoint name

SAVEPOINT_ROLLBACK

INFO and aboveDBLine and character number of the event
in the code, Savepoint name

SAVEPOINT_SET

INFO and aboveWorkflowNumber of cases, load time, processing
time, number of case milestones to
insert/update/delete, new trigger

SLA_END

INFO and aboveWorkflowMilestone IDSLA_EVAL_MILESTONE

INFO and aboveWorkflowNoneSLA_NULL_START_DATE

INFO and aboveWorkflowCase IDSLA_PROCESS_CASE

INFO and aboveDBLine and character number of the event
in the code, number of aggregations,
query source

SOQL_EXECUTE_BEGIN

INFO and aboveDBLine and character number of the event
in the code, number of rows, duration
in milliseconds

SOQL_EXECUTE_END

INFO and aboveDBLine and character number of the event
in the code, query source

SOSL_EXECUTE_BEGIN

INFO and aboveDBLine and character number of the event
in the code, number of rows, duration
in milliseconds

SOSL_EXECUTE_END
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Level LoggedCategory LoggedFields or Information Logged With
Event

Event Name

FINE and aboveApex ProfilingFrame number, variable list of the form:
Variable number | Value. For
example:

var1:50
var2:'Hello World'

STACK_FRAME_VARIABLE_LIST

FINESTApex CodeLine and character number of the event
in the code

STATEMENT_EXECUTE

FINE and aboveApex ProfilingVariable list of the form: Variable
number | Value. For example:

var1:50
var2:'Hello World'

STATIC_VARIABLE_LIST

FINESTApex CodeMode nameSYSTEM_MODE_ENTER

FINESTApex CodeMode nameSYSTEM_MODE_EXIT

INFO and aboveApex ProfilingNoneTESTING_LIMITS

FINE and aboveApex ProfilingNumber of emails sentTOTAL_EMAIL_RECIPIENTS_QUEUED

DEBUG and above by
default

Apex CodeLine and character number of the event
in the code, logging level, user-supplied
string

USER_DEBUG

Note:  If the user
sets the log level
for the
System.Debug
method, the
event is logged at
that level instead.

INFO and aboveValidationError messageVALIDATION_ERROR

INFO and aboveValidationNoneVALIDATION_FAIL

INFO and aboveValidationFormula source, valuesVALIDATION_FORMULA

INFO and aboveValidationNoneVALIDATION_PASS

INFO and aboveValidationRule nameVALIDATION_RULE

INFO and aboveApex CodeElement name, method name, return
type

VF_APEX_CALL

INFO and aboveApex CodeMessage textVF_PAGE_MESSAGE

INFO and aboveWorkflowAction descriptionWF_ACTION

INFO and aboveWorkflowTask subject, action ID, rule, owner, due
date

WF_ACTION_TASK
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Level LoggedCategory LoggedFields or Information Logged With
Event

Event Name

INFO and aboveWorkflowSummer of actions performedWF_ACTIONS_END

INFO and aboveWorkflowTransition type, EntityName:
NameField Id, process node name

WF_APPROVAL

INFO and aboveWorkflowEntityName: NameField IdWF_APPROVAL_REMOVE

INFO and aboveWorkflowEntityName: NameField IdWF_APPROVAL_SUBMIT

INFO and aboveWorkflowOwner, assignee template IDWF_ASSIGN

INFO and aboveWorkflowEntityName: NameField Id, rule
name, rule ID, trigger type (if rule
respects trigger types)

WF_CRITERIA_BEGIN

INFO and aboveWorkflowBoolean value indicating success (true or
false)

WF_CRITERIA_END

INFO and aboveWorkflowAction ID, ruleWF_EMAIL_ALERT

INFO and aboveWorkflowEmail template ID, recipients, CC
emails

WF_EMAIL_SENT

INFO and aboveWorkflowSummary of actions enqueuedWF_ENQUEUE_ACTIONS

INFO and aboveWorkflowCase ID, business hoursWF_ESCALATION_ACTION

INFO and aboveWorkflowNoneWF_ESCALATION_RULE

INFO and aboveWorkflowProcess name, email template ID,
Boolean value indicating result (true or
false)

WF_EVAL_ENTRY_CRITERIA

INFO and aboveWorkflowEntityName: NameField Id, object
or field name

WF_FIELD_UPDATE

INFO and aboveWorkflowFormula source, valuesWF_FORMULA

INFO and aboveWorkflowNoneWF_HARD_REJECT

INFO and aboveWorkflowOwner, next owner type, fieldWF_NEXT_APPROVER

INFO and aboveWorkflowNoneWF_NO_PROCESS_FOUND

INFO and aboveWorkflowEntityName: NameField Id, action
ID, rule

WF_OUTBOUND_MSG

INFO and aboveWorkflowProcess nameWF_PROCESS_NODE

INFO and aboveWorkflowEntityName: NameField Id, ownerWF_REASSIGN_RECORD

INFO and aboveWorkflowNotifier name, notifier email, notifier
template ID

WF_RESPONSE_NOTIFY

INFO and aboveWorkflowInteger, indicating orderWF_RULE_ENTRY_ORDER

INFO and aboveWorkflowRule typeWF_RULE_EVAL_BEGIN

INFO and aboveWorkflowNoneWF_RULE_EVAL_END

INFO and aboveWorkflowValueWF_RULE_EVAL_VALUE
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Level LoggedCategory LoggedFields or Information Logged With
Event

Event Name

INFO and aboveWorkflowFilter criteriaWF_RULE_FILTER

INFO and aboveWorkflowEntityName: NameField IdWF_RULE_INVOCATION

INFO and aboveWorkflowNoneWF_RULE_NOT_EVALUATED

INFO and aboveWorkflowProcess nameWF_SOFT_REJECT

INFO and aboveWorkflowNode typeWF_SPOOL_ACTION_BEGIN

INFO and aboveWorkflowEntityName: NameField Id, time
action, time action container, evaluation
Datetime

WF_TIME_TRIGGER

INFO and aboveWorkflowNoneWF_TIME_TRIGGERS_BEGIN

Monitoring Debug Logs
Many updates have been made to monitoring debug logs in Spring '10.

Limits

Instead of a limit of 20 debug logs per organization, the new limits are:

• Each user can have 20 debug logs.
• Each debug log can be 2 MB.
• Each organization can retain up to 50 MB of debug logs.

Debug Logs

The debug logs now contain more information. See Debug Logs on page 145.

Filtering

You can specify the categories and levels that should be used for generating all debug logs for a user. See Debug Log
Filters on page 150.

Implementation Tips

• After you have started retaining debug logs for a user, you can reset that user's debug log count back to 20 by clicking
Setup ➤ Monitoring ➤ Debug Logs, then clicking Reset next to the name of the user.

• After a user reaches the limit of 20 debug logs, their name is removed from the list of users whose debug logs are being
maintained. You need to re-add their name if you still want to maintain their debug logs.

System Log Console
For Spring '10 many improvements have been made to the System Log console, including:

• The ability to set filters, that is, the category and level of information that gets recorded in the debug log. The combination
of category and level specify which events get logged. Each event may record additional information, such as the line and
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character number where the event started, fields associated with the event, duration of the event in milliseconds, and so
on.

• The ability to maintain more than one log. You can select a specific log in order to view its details.

Implementation Tips

• Changing the category and level for a debug log only changes what gets recorded in future debug logs. It does not change
what is recorded in existing logs.

• Logs are only maintained for 60 minutes.

About the System Log Console

Using the System Log Console

Available in: Unlimited, Developer, and Enterprise Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“View All Data”To use the System Log console:

“Author Apex”To use the text entry box:

The System Log console is a separate window that can be used for debugging code snippets or tracking code execution during
a transaction. Access the System Log console from the Salesforce.com user interface by clicking System Log in the upper
right of any page. From the System Log console , you can:

• Click Show Filter Settings to specify which events you want recorded in future logs.
• Enter a snippet of Apex code you want to test and click Execute.
• If you have existing logs, select a log to view the details of it, or click Clear Log List to remove all existing debug logs from

the display window. Logs are only maintained for 60 minutes.

For more information on the debug log, see “What is a Debug Log?” in the Salesforce.com online help.

Any Apex code that you enter into the text entry box runs as if you had executed it using ExecuteAnonymous.

You cannot use the keyword static in code that you enter directly into the System Log console. In addition, although you
can have DML statements (such as insert or delete), those actions are not actually performed.

Caution:  If you are exercising methods defined as testMethod by calling the class that contains them using the
System Log console, all DML statements actually are executed. This may add unwanted data to your organization.

For more information on the syntax and use of Apex, see the Force.com Apex Code Developer's Guide.
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Visualforce Enhancements
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom controllers and standard controller extensions are not supported in Group or Professional Editions.

Spring '10 introduces several new features that enhance the capabilities of previous versions of Visualforce. For detailed
information on these new features, see the Visualforce Developer's Guide.

The following enhancements are now available:

New Possible Value for <apex:pageBlock> mode attribute

The <apex:pageBlock> mode attribute has a new possible value: maindetail. This value provides the same
functionality as detail, but provides more compatibility for the new look-and-feel. The Visualforce Component
Reference provides more information on its use.

New Page Request Limit

Starting with Spring '10, the maximum response size from a Visualforce page must be below 15 MB.

New Limits On Collection Size for Iterative Components

Starting with Spring '10, the maximum size of a data collection used with a <apex:pageBlockTable>,
<apex:dataTable>, <apex:panelBar>, <apex:repeat>, or <apex:dataList> component is 1,000.

Ext 3.0 Upgrade for <apex:enhancedList>

Visualforce pages and components created using Salesforce.com API version 18.0 or higher use <apex:enhancedList>
components that run Ext 3.0. Visualforce pages and components that use versions earlier than Salesforce.com API version
18 continue to use Ext 2.1.

Deprecation of bgcolor Attribute on <apex:pageBlockTable>

The bgcolor attribute can't be used by the <apex:pageBlockTable> component in Visualforce pages and components
running Salesforce.com API version 18.0 and above. The background-color CSS attribute should be used instead.

The <apex:form>Tag Can't Be Contained Within <apex:repeat>

As of Salesforce.com API version 18.0, the <apex:form> tag can't be a child component of the <apex:repeat> tag.

Due to performance issues, we don't recommend this practice on Visualforce pages and components running Salesforce.com
API versions earlier than 18.0.

Formula Expressions Always Return IDs with a Character Length of 18

Previously, when resolving organization, user, or record IDs in formula expressions within aVisualforce page, the ID
was a string of either 15– or 18 alphanumeric characters. Any Visualforce pages created against Salesforce.com API
version 18.0 or higher will always resolve expressions that return IDs with a length of 18 characters.

Salesforce.com Stylesheets No Longer Called for PDFs

Starting with Salesforce.com API version 18.0, PDFs generated using the renderAs attribute on <apex:page> no
longer import Salesforce.com stylesheets. Components that use these stylesheets, such as <apex:pageBlock>, won't
appear on PDFs at all.

159

Custom Cloud Visualforce Enhancements

http://www.salesforce.com/us/developer/docs/pages/index.htm
http://www.extjs.com/products/extjs/


For more information on components compatible with PDF rendering, see the new chapter titled Best Practices for
Rendering PDFs in the Visualforce Developer's Guide.

Most Recent Version of WinZip is Required when Creating Static Resources

If you are using WinZip when creating static resources, be sure to install the most recent version. Older versions of
WinZip may cause a loss of data.

Deprecation of S-Controls
Available in: All Editions

Starting with Spring '10, organizations that have never created s-controls, as well as new organizations, won't be allowed to
create them. Existing s-controls remain unaffected, and can still be edited.

Only s-controls in unmanaged packages created before January 1st, 2010 can be installed by subscribers.

Visualforce pages are considered the next-generation of s-controls and should be used instead of s-controls whenever possible,
both for their increased performance and the ease with which they can be written. The following table outlines the differences
between Visualforce pages and s-controls.

S-ControlsVisualforce Pages

HTML, JavaScript, AJAX ToolkitHTML, XMLRequired technical skills

Procedural codeTag markupLanguage style

Write HTML and JavaScript for entire
page

Assemble standard and custom
components using tags

Page override model

NoYesStandard Salesforce.com component
library

NoYes, through the standard controllerAccess to built-in platform behavior

No

Developers can't bind an input
component with a particular field.

Yes

Developers can bind an input component
(such as a text box) with a particular field

Data binding

Instead, they must write JavaScript code(such as Account Name). If a user saves
that uses the API to update the database
with user-specified field values.

a value in that input component, it is also
saved in the database.

No, must bring in Salesforce.com
stylesheets manually

YesStylesheet inheritance

Yes, if coded in JavaScript using a
describe API call

If a user attempts to save a record that
violates uniqueness or requiredness field

Yes, by default

If a user attempts to save a record that
violates uniqueness or requiredness field
attributes, an error message is

Respect for field metadata, such as
uniqueness

attributes, an error message is onlyautomatically displayed and the user can
try again.
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S-ControlsVisualforce Pages

displayed if the s-control developer wrote
code that checked those attributes.

Indirect, by using Apex webService
methods through the API

Direct, by binding to a custom controllerInteraction with Apex

Less responsive because every call to the
API requires a round trip to the

More responsive because markup is
generated on the Force.com platform

Performance

server—the burden rests with the
developer to tune performance

In an iFrameNativePage container

For more information on migrating away from s-controls, see this article from theDeveloper Force website.

Force.com Development as a Service
Available in: Enterprise, Unlimited, and Developer Editions

Force.com Development as a Service (DaaS) provides the tools and technologies used by professional developers who build
applications for the Force.com platform, as well as those who migrate application changes between development organizations
and production. The DaaS feature area includes support for creating, retrieving, and deploying changes to your organization's
metadata.

New Metadata Types

The following metadata types are new in Metadata API version 18.0:

DescriptionMetadata Type

Represents a data category group.DataCategoryGroup

Caution: Using Metadata API to deploy category changes from one organization
to another permanently removes categories and record categorizations that are not
specified in your XML file. Salesforce.com recommends that you manually create
data categories and record associations in an organization using Setup➤Customize
➤Data Categories rather than deploying changes from a sandbox to a production
organization.

Represents an entitlement template. Entitlement templates are predefined terms of customer
support that you can quickly add to products. For example, you can create entitlement

EntitlementTemplate

templates for Web or phone support so that users can easily add entitlements to products
offered to customers.

Updated Calls

The following changes have been made to Metadata API calls in version 18.0:
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DescriptionChangeFieldArgument or
Result Object

Call

Indicates whether the problem is an error or a
warning. Prior to version 18.0, there was no

New fieldproblemTypeDeployMessagedeploy()

distinction between warnings and errors. All
problems were treated as errors and prevented a
successful deployment.

Indicates whether a warning should allow a
deployment to complete successfully (true) or

New fieldignoreWarningsDeployOptionsdeploy()

not (false). Defaults to false. Prior to version
18.0, there was no distinction between warnings
and errors. All problems were treated as errors
and prevented a successful deployment.

The API version for the metadata listing request.
If you don't specify a value in this field, it defaults

New
argument

N/AasOfVersionlistMetadata()

to the API version specified when you logged in.
This field allows you to override the default and
set another API version so that, for example, you
could list the metadata for a metadata type that
was added in a later version than the API version
specified when you logged in.

Updated Metadata

The following metadata fields have been added or changed in Metadata API version 18.0:

DescriptionChangeFieldMetadata Type or Related
Object

The following enumeration value was added to
FieldType:

Updatedtype (FieldType)CustomField

• Html

A list of action overrides on a standard or custom
object.

NewactionOverridesCustomObject

Represents a list of columns on a customized
dashboard table component.

NewdashboardTableColumnDashboardComponent

The following enumeration value was added:UpdatedaccessTypeFolder
• PublicInternal. This folder is accessible

by all users, excluding portal users.This setting
is available for report and dashboard folders in
organizations with a partner portal or
Customer Portal enabled.

Indicates whether this value lets users email a
quote PDF (true), or not (false). This field is
only relevant for the Status field in quotes.

NewallowEmailPicklistValue
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DescriptionChangeFieldMetadata Type or Related
Object

A picklist value corresponding to a reverse role
name for a partner. If the role is “subcontractor”,

NewreverseRolePicklistValue

then the reverse role might be “general contractor”.
Assigning a partner role to an account in
Salesforce.com creates a reverse partner
relationship so that both accounts list the other as
a partner. This field is only relevant for partner
roles.

The following enumeration value was added:UpdatedsenderTypeWorkflowAlert
• DefaultWorkflowUser

The API version of the outbound message. This
is automatically set to the current API version

NewapiVersionWorkflowOutboundMessage

when the outbound message is created. Valid API
versions for outbound messages are 8.0 and 18.0
or later.

This API version is used in any API calls back to
Salesforce.com using the enterprise or partner
WSDLs. The API Version can only be
modified by using the Metadata API.

Force.com IDE

Available in: Enterprise, Unlimited, and Developer Editions

Spring '10 includes new enhancements to the Force.com IDE. For complete details, visit the Force.com IDE release notes
page at http://wiki.developerforce.com/index.php/Force.com_IDE_Release_Notes.

Note: The Force.com IDE for Spring '10 will be released after all instances have been upgraded. Release notes and
downloads are not available until that time.

Sandbox to Production—Change Sets Beta

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in Enterprise, Unlimited, and Free Editions

Use change sets to move configuration changes using the Web interface. If you've struggled with moving changes from sandbox
to production, or have been searching for an easier tool to use than the Force.com IDE or the Force.com Migration Tool,
change sets will drastically increase your productivity.
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New enhancements in Spring '10 include:

Clone

Clone an existing change set to create a new change set with the same components. Because you can't modify an uploaded
change set, a particularly useful case for using clone is when you want to add dependent components to a change set that
you previously uploaded.

Cross-version Upload

When a new version of the platform is released, your production and sandbox organizations may be upgraded at different
times. If change sets are sent between organizations that are not on the same version, this feature will allow you to deploy
components that are valid in both organizations.

Delete

You can delete change sets that have not been uploaded. Once a change set is uploaded, it can't be deleted.

Expiration Date

Change sets expire after six months of being uploaded, and at that time are permanently deleted. There is no expiration
date on change sets that have not been uploaded. Once the change set is deployed in the target organization, the expiration
date is reset to another six months. The expiration date can't be changed.

Implementation Tips

Permissions required to use change sets
To send a change set to another organization, a user must have “Create and Upload Change Sets,” “Create AppExchange
Packages,” and “Upload AppExchange Packages” profile permissions.

To deploy a change set received from another organization, a user must have the “Deploy Change Sets” profile permission.

Authorization required to upload changes
Before you can deploy a change set from one organization to another, an administrator in the target organization must
authorize uploads across the deployment connection between the two organizations.

Deployment Connections list displays all connections
The Deployment Connections list is automatically populated with your production organization and all sandboxes. It
is possible to deploy between any of these organizations, but no other organizations.

Change set connections unavailable during maintenance
Authorizing deployment connections and uploading pages require information from the production organization, and
are unavailable when production is undergoing maintenance. During this time you can construct outbound change sets
but not upload them.

Sandboxes must be available
If an organization has no sandboxes provisioned, the user may see an Insufficient Privileges error on the Deployment
Connections page.

Deployment is a one-way transaction
A change set is deployed in a single transaction. If the deployment is unable to complete for any reason, the entire
transaction is rolled back. After a deployment completes successfully, all changes are committed to your organization
and the change set cannot be rolled back.
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Profiles not supported
Change sets don't currently support uploading or deploying profiles, which control the visibility and access levels of some
components such as tabs, objects, and fields.Therefore, after deploying a change set to an organization, new components
don't automatically appear to non-administrator users. To allow end users to view these components, edit their profiles
and adjust the visibility and access levels accordingly.

Uploaded change sets can't be modified
Change sets can only be modified or deleted before they are uploaded; once you upload the change set, you can't add or
delete components. You also can't delete the change set.

Best Practices

Deploy all dependent components
Make sure each change set contains all interdependent components that don't exist in the target organization. If you try
to deploy a component that refers to another component missing from the target organization and from the change set,
the deployment fails.

Change sets give you fine-grained control over what you deploy. For example, you can migrate custom fields individually.
To deploy a custom object and all of its fields, you must add the custom object and every field to the change set; adding
just the custom object to the change set won't cause deployment to fail, but results in an empty custom object.

Clone a change set to add dependent components to an uploaded change set
After you upload a change set, you can't change its contents. If you need to add dependent components to a change set
you already uploaded, clone the change set, add the dependent components, and then upload it again.

Plan deployments around maintenance schedule
Plan your deployment activities around the maintenance schedule for both your production and sandbox organizations.
Some features require information from your production organization when accessed from a sandbox.

View change set details
If you deploy an inbound change set in the target organization that was uploaded by someone else, and the deployment
fails, you may want to contact the person who uploaded it so they can fix the problem. To find out who uploaded the
change set, look in the Uploaded By field.

Change sets limited to 2500 components and 400 MB
Change sets are limited to 2500 components and a total file size of 400 MB. If your change set exceeds either of these
limits, you can create separate change sets for email templates, dashboards, and reports. These components are often the
most numerous and have fewer dependencies. For more information, see Migrating Files in Batches.

Deleting and renaming components
You can't use change sets to delete or rename components. To delete components, use the Web interface on the target
organization. To rename a component, first delete the component on the target organization and then upload the new
component in a change set.
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Salesforce.com Certificate and Key Management
Available in: All Editions

Salesforce.com certificates and key pairs encrypt sensitive data whenever Salesforce.com communicates with an external website.
You only need to generate a Salesforce.com certificate and key pair if you're working with an external website that wants
verification that a request is coming from a Salesforce.com organization.

Implementation Tips

• After you successfully save a Salesforce.com certificate, the certificate and corresponding keys are automatically generated.

• After you create a Salesforce.com certificate, you can only change the Label and the Unique Name. You can't change
the type, key size, and so on. The certificate and the keys aren't regenerated when you edit a Salesforce.com certificate.

Best Practices

• When setting the key size for a new Salesforce.com key pair, you can select a key size of either 1024 (valid for one year)
or 2048 (valid for two years). Salesforce.com recommends that you select 2048 for security reasons.

About Certificate and Key Management

About Salesforce.com Certificates and Keys

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates and keys:

Salesforce.com certificates and key pairs encrypt sensitive data whenever Salesforce.com communicates with an external website.
You only need to generate a Salesforce.com certificate and key pair if you're working with an external website that wants
verification that a request is coming from a Salesforce.com organization.

Salesforce.com offers two types of certificates: self-signed and CA-signed.

Self-signed

A self-signed certificate is signed by Salesforce.com. Not all external websites accept self-signed certificates.

CA-signed

A CA-signed certificate is signed by an external certificate authority (CA). Most external websites accept CA-signed
certificates. You have to first generate the certificate signing request to send to a CA, and then import the signed version
of the certificate before you can use that certificate.
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To work with Salesforce.com certificates and keys, click Setup➤ Security Controls➤Certificate and Key Pair Management.
From the Certificate and Key Management page, you can do any of the following:

• Click Create Self-Signed Certificate to create a new self-signed Salesforce.com certificate.
• Click Create CA-Signed Certificate to start the process of creating a CA-signed certificate.

Note:  After you create a CA-signed certificate and certificate request, the certificate is not Active and you can't
use it until it's been signed by a certificate authority and uploaded into your organization.

• Click Edit to edit a certificate, or Del to delete a certificate.

Note: You can't delete a CA-signed certificate after you've uploaded the signed certificate.

Note:  Client authentication certificates should only be used with workflow outbound messaging. Generally, use
Salesforce.com certificates and keys for all your certificates.

Creating Salesforce.com Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates and keys:

Salesforce.com offers two types of certificates: self-signed and CA-signed.

Self-signed

A self-signed certificate is signed by Salesforce.com. Not all external websites accept self-signed certificates.

CA-signed

A CA-signed certificate is signed by an external certificate authority (CA). Most external websites accept CA-signed
certificates. You have to first generate the certificate signing request to send to a CA, and then import the signed version
of the certificate before you can use that certificate.

To create a Salesforce.com certificate:

1. Decide which type of certificate to create based on whether your external website accepts self-signed certificates, or if it
requires CA-signed. You can't change the type of a certificate after you've created it.

2. Click Setup➤ Security Controls➤Certificate and Key Management, then click either Create Self-Signed Certificate
or Create CA-Signed Certificate. This selects the type of certificate, and cannot be changed later.

3. Enter a descriptive label for the Salesforce.com certificate. This name is used primarily by administrators when viewing
certificates.

4. Enter the Unique Name. This name is automatically populated based on the certificate label you enter. This name can
contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a
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letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. Use the Unique
Name when referring to the certificate using the Force.com Web services API or Apex.

5. Select a Key Size for your generated certificate and keys. Selecting 1024 generates a certificate using 1024-bit keys and
is valid for one year. Selecting 2048 generates a certificate using 2048-bit keys and is valid for two years. Salesforce.com
recommends that you specify 2048 for security reasons.

Note:  Once you save a Salesforce.com certificate, you can't change the key size.

6. If you're creating a CA-signed certificate, you must also enter the following information. These fields are joined together
to generate a unique certificate.

DescriptionField

The fully qualified domain name of the company requesting
the signed certificate. This is generally of the form:
http://www.mycompany.com.

Common Name

The email address associated with this certificate.Email Address

Either the legal name of your company, or your legal name.Company

The branch of your company using the certificate, such as
marketing, accounting, and so on.

Department

The city where the company resides.City

The state where the company resides.State

A two-letter code indicating the country where the company
resides. For the United States, the value is US.

Country Code

7. Click Save.

After you successfully save a Salesforce.com certificate, the certificate and corresponding keys are automatically generated.

After you create a CA-signed certificate, you must upload the signed certificate before you can use it.

Editing Salesforce.com Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates and keys:

After you create a Salesforce.com certificate, you can only change the Label and the Unique Name. You can't change the
type, key size, and so on. The certificate and the keys aren't regenerated when you edit a Salesforce.com certificate.
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Caution: Apex and the API use the Unique Name to access the certificate. Changing the Unique Name could cause
your code to break.

To edit a Salesforce.com certificate, click Setup ➤ Security Controls ➤ Certificate and Key Management, then click Edit
next to the name of an existing Salesforce.com certificate.

After you make changes to the names of a Salesforce.com certificate, click Save.

Viewing Salesforce.com Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates and keys:

To view the details of a Salesforce.com certificate, click Setup ➤ Security Controls ➤ Certificate and Key Management,
then click the name of a certificate.

From the certificate detail page, you can do any of the following:

• Click Edit to edit the label or unique name of the certificate.
• Click Delete to delete the certificate.

Note: You can't delete a CA-signed certificate after you've uploaded the signed certificate.

• Click Download Certificate to download the full Base-64 encoded certificate. This is only available for active certificates.
For CA-signed certificates, you must first upload the signed certificate before you can download or use it.

• Click Download Certificate Signing Request for CA-signed certificates that have not yet had the signed certificate
uploaded.

• Click Upload Signed Certificate to upload the CA-signed certificate.

My Domain—Limited Release
Available in: Unlimited,  Enterprise, and Developer editions.

Important:  My Domain is currently available through a limited release program. All customers can select and register
a domain name, but some customers will be required to wait for permission from salesforce.com before they can roll
it out to users. For more information, contact salesforce.com.

With My Domain, you can add a custom domain name to the URLs you use to log into and navigate Salesforce.com.  For
example, the login URL for a company called Universal Containers would be:
https://universalcontainers.my.salesforce.com/. You can use up to 40 characters.Your domain name not only
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gives you another way to feature your brand, but also makes your data more secure. Rollout is easy: after registering for your
domain name, you can test it before opening it up to users. Built-in redirection tools help make the rollout seamless.

Implementation Tips

• If you have customized your Salesforce.com UI with features such as custom buttons or Visualforce pages, make sure you
test thoroughly before you roll out your new domain name. Your customizations should not use instance-based URLs.

• After you roll out your new domain name, use My Domain's redirect tools to gradually phase it in. For example, choose
the Redirected with a warning option to make sure users update their bookmarks. When your organization is ready
to use the new domain URLs exclusively, return to setup and choose the Blocked option so users can't use their old URLs.

• If you block application page requests that don't use the new Salesforce.com domain name URLs, let your users know they
need to either update old bookmarks or create new ones for the login page and any tabs or links within the application.
Users will be required to use the new URLs if you block page requests.

• If you choose to redirect page requests to new URLs and provide a warning message, let your users know that they should
update their bookmarks the first time they're redirected.

Check out the Using My Domain tip sheet for more information about what your new URLs will look like.

Best Practices

• If you are using My Domain, you can identify which users are logging in with the new login URL, and when. Click Setup
➤ Manage Users ➤ Login History and look at the Username and Login URL columns.

The Using My Domain tip sheet tells you how to get system performance and maintenance information at
trust.salesforce.com.

About My Domain

My Domain Overview

Available in: Unlimited,  Enterprise, and Developer editions.

Important:  My Domain is currently available through a limited release program. All customers can select and register
a domain name, but some customers will be required to wait for permission from salesforce.com before they can roll
it out to users. For more information, contact salesforce.com.

Using My Domain, your organization can select a custom Salesforce.com domain name that highlights your brand, or a
different term that represents your business. Using a custom domain name provides other important advantages, such as
increased security and better support for single sign-on.

Your domain name uses the standard URL format, including:

• The protocol: https://
• The subdomain prefix: your brand or term
• The domain: my.salesforce.com

For example, the login URL for a company called Universal Containers would be:
https://universalcontainers.my.salesforce.com/. You can use up to 40 characters.
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It's a snap to set up a custom domain name. After you decide on the name or term you want to use, My Domain checks to
make sure your subdomain is available. Then it registers the domain name and publishes it to the internet. After a brief period,
you'll receive an email to let you know your new domain name is ready for testing. Log in using the new URL and test the
URLs for other pages in the application.

When deploy, you have options for how you want to handle page requests that don't use the new domain name. You can block
them entirely or redirect them to the new URL—with or without a message.

Important:  Once you deploy your new domain name, you can't reverse it. After deployment, all users will be redirected
to your new domain.

Setting up a Domain Name

Available in: Unlimited,  Enterprise, and Developer editions.

User Permissions Needed

“Customize Application”To set up a domain name:

Important:  My Domain is currently available through a limited release program. All customers can select and register
a domain name, but some customers will be required to wait for permission from salesforce.com before they can roll
it out to users. For more information, contact salesforce.com.

To set up a domain name for your organization:

1. Click Setup ➤ Company Profile ➤ My Domain.
2. Enter the name you want to use within the sample URL.  For example, the login URL for a company called Universal

Containers would be: https://universalcontainers.my.salesforce.com/. You can use up to 40 characters.
3. Click Check Availability. If your name is already taken, choose a different one.
4. Click Terms and Conditions to review your agreement, then select the checkbox.
5. You'll receive an email when your domain name is ready for testing. (It can take up to 72 hours.) Click the URL in the

email to login to Salesforce.com using your new domain name.
6. Test the new domain name by clicking tabs and links that you use within your application. You'll notice that all the tabs

and pages show your new domain name.
7. When you finish testing your new domain name, click Setup ➤ Company Profile ➤ My Domain and click Deploy to

Users to roll out the new domain name to your organization.
8. Click Edit in the Domain Name Settings related list. If you want to accept logins from your new domain only, select the

Require Login checkbox. If you don't require users to log in from the new domain, they'll be blocked or redirected
based on your redirect setting.

9. Select a redirect policy. If you want to redirect page requests that don't use the new domain name, select a redirect option.
Users can access application pages with or without a message explaining the URL change.

10. Click Save.

Tip:  If you block page requests for URLs that don't use the new domain name, let your users know they need to
update their bookmarks for tabs and other links within the application.
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Important:  Once you deploy your new domain name, you can't reverse it. After deployment, all users will be redirected
to your new domain.

Patch Updates for Packages—Limited Release
Available in: Developer Edition

Note:  Patch updates and patch organizations are currently available through a pilot program. You may request to be
added to the pilot program by contacting Salesforce.com support. You must be a registered Salesforce.com partner to
use this feature. Not all participants or requests will be allowed to use this pilot feature.

A push upgrade is a method of automatically upgrading your customers to a newer version of your package. A package subscriber
doesn't need to do anything to receive the push upgrade. The only indication a subscriber receives after a successful push
upgrade is that the patch number has changed in the package's Version Number. Any upgrades that fail must be resolved
by the developer initiating the push.

Push upgrades minimize the potential risk of having multiple subscriber organizations running variations of the same major
release. Rather than asking each subscriber to manually install the upgrade, a push guarantees that all subscribers are running
the same patch version for a major release by automatically upgrading subscribers.

You can push an upgrade to any number of organizations that have installed your managed package.

What is a Patch Version?

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade, or create a patch organization:

Note:  Patch updates and patch organizations are currently available through a pilot program. You may request to be
added to the pilot program by contacting Salesforce.com support. You must be a registered Salesforce.com partner to
use this feature. Not all participants or requests will be allowed to use this pilot feature.

A patch version enables a developer to change the functionality of existing components in a managed package, while ensuring
subscribing organizations that there are no visible behavior changes to the package. Patches should be considered as minor

upgrades to a Managed - Released package and only used for fixing bugs or other errors.

Patch versions can only be created for major release packages. Subscribers can receive patch upgrades just like any other package
version. However, you can also distribute a patch by using push upgrades to automatically upgrade all eligible customers
running the same major release.
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When you create a patch, the patchNumber on a package's Version Number increments by one. For example, suppose you
release a package with the version number 2.0. When you release a patch, the number changes to 2.0.1. This value cannot be
changed manually. It also can't be accessed by Apex.

Patch Organizations

Every patch is developed in a patch organization, which is the organization where patch versions are developed, maintained,
and uploaded. To start developing a patch, you need to create a patch development organization. To do this, see “Creating
and Uploading Patches” in the Salesforce.com online help. Patch organizations are necessary to permit developers to make
changes to existing components without causing incompatibilities between existing subscriber installations.

A patch organization can only view the patch versions developed in that organization. Certain attributes, such as the name of
the package or the Version Number, can't be changed when developing a patch.

A patch organization can upload an unlimited number of patches. Only one patch organization can exist per major release of
your package. Thus, a patch organization created for a package with a version number of 4.2 can only work on patches such
as 4.2.1, 4.2.2, 4.2.3, and so on, but not on version 4.1 or 4.3. The main development organization has read-only access to all
versions uploaded from the patch organizations.

The following diagram illustrates the workflow of creating a patch and integrating any work into future versions:

After a package is released from version 1.0 to version 2.0, the developer creates a patch. The package version number in the
patch organization starts at 2.0.1. As the main development organization moves towards a released version of 3.0, a second
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patch is created. Finally, the developer merges the changes between the main development organization and the patch
organization and releases the package as version 3.0.

Integrating Patch Development
If you are developing your packages using the Force.com IDE, you can take advantage of revision control systems in Eclipse
to compare and merge different project branches.

Salesforce.com recommends using the Subversion plug-in. To install Subversion for the Force.com IDE:

1. Go to http://subclipse.tigris.org to get the latest Eclipse Update Site URL compatible with your version of
Eclipse.

2. In the Force.com IDE, navigate to Help➤ Software Updates, and select the Available Software tab. Click Add Site, and
enter the URL from the previous step.

3. Select the new site and click Finish to fetch the latest version of the Subclipse plug-in. Select the required Subclipse plug-in
from the list returned from the site.

4. Click Next, accept the terms, and click Next again.
5. Click Finish to begin the installation, and then Install All when prompted. You will be required to restart Eclipse once

the installation completes.

You have now linked your Force.com IDE environment to Subclipse. The next step is to connect your repository to the
environment:

1. Open the SVN Repository Exploring perspective in the IDE, which will open the SVN Repositories view.
2. Use the Add SVN Repository icon on the far right to configure Subclipse to access the local repository.The URL to access

your repository locally is file:///svn_repos.

The subversion repository tracks changes made to stored projects. Because working with patches involves two different
branches—a main development organization and a patch development organization—you need to combine your changes for
a future release. To view the different versions of your package:

1. Open the Project Explorer perspective.
2. Navigate to a file in your main development project that you want to compare, and use the context menu to select Compare

With... ➤ Branch/Tag....
3. In the Compare to field, select the patch version of the file.
4. Click Graphical, then click Ok.

The changes between the main development organization's file and the file stored in the patch organization are highlighted.
You can use this view to merge any differences between the two projects.

For more information on using the Force.com IDE, see the Platform Developer's Guide.
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Creating and Uploading Patches

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade, or create a patch organization:

Note:  Patch updates and patch organizations are currently available through a pilot program. You may request to be
added to the pilot program by contacting Salesforce.com support. You must be a registered Salesforce.com partner to
use this feature. Not all participants or requests will be allowed to use this pilot feature.

Patch versions are developed and maintained in a patch development organization.

To create a patch version:

1. Click Setup ➤ Create ➤ Packages.
2. In the Development Organization section, click New.
3. Select the package that you want to create a patch version for in the Patching Major Release drop-down list. The release

type must be Managed - Released for a patch to be created.
4. Enter a Username for a login to your patch organization.
5. Enter an Email Address associated with your login.
6. Click Save.

Note:  If you ever lose your login information, click Reset on the package detail page under Development
Organizations to resetthe login to your patch organization.

After you receive an email indicating Salesforce.com has created your patch organization, you can click Login to begin
developing your patch version.

When you finish developing your patch, in your patch organization:

1. Click Setup ➤ Create ➤ Packages and click the name of the package you want to reintegrate.
2. Click Upload. On the Upload Package page, do the following:

a. Enter a Version Name, such as June 2009.This field is required for managed and unmanaged packages.The version
name is the marketing name for a specific release of a package and allows you to create a more descriptive title for the
version.

b. Notice that the Version Number has had its patchNumber incremented.
c. For managed packages, select a Release Type:

• Choose Managed - Released to upload an upgradeable version. After upload, some attributes of Salesforce.com
components are locked. For a list of locked attributes, see “Component Attributes in Managed Packages” in the
Salesforce.com online help.

• Choose Managed - Beta if you want to upload a version of your package to a small sampling of your audience for
testing purposes. You'll still be able to change the components and upload additional beta versions. For information
on beta versions, see “What are Beta Versions of Managed Packages?” in the Salesforce.com online help.
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Note:  Beta packages can only be installed in Developer Edition or sandbox organizations, and thus can't
be pushed to customer organizations.

d. Change the Description, if necessary.
e. Optionally, enter and confirm a password to share the package privately with anyone who has the password. Don't

enter a password if you want to make the package available to anyone on AppExchange and share your package publicly.
f. Salesforce.com automatically selects the requirements it finds. In addition, select any other required components from

the Package Requirements and Object Requirements sections to notify installers of any requirements for this
package.

g. Click Upload.

Restrictions on Patches

Development in a patch organization is limited. The following is a list of restrictions when developing patches in a patch
organization. If you try to upload a patch that violates any of these restrictions, the upload fails.

• The package definition, such as its name, description, or version can't change.
• New package components can't be added.
• Existing package components can't be deleted.
• API and dynamic Apex access controls can't change for the package.
• No deprecation of Apex, objects, or fields.
• Global Apex method signatures can't change.
• No new Apex class relationships, such as extends, can be added.
• No new Apex access modifiers, such as virtual or global, can be added.
• No new Web services can be added.

Scheduling Push Upgrades

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade, or create a patch organization:

Note:  Patch updates and patch organizations are currently available through a pilot program. You may request to be
added to the pilot program by contacting Salesforce.com support. You must be a registered Salesforce.com partner to
use this feature. Not all participants or requests will be allowed to use this pilot feature.

Before you can schedule a push upgrade of your managed package, you must first create a patch version of your package.

After you receive an email indicating Salesforce.com has created your patch development organization, you can log in and
begin developing your patch release. Patch releases are limited to certain restrictions. >Review the full list of patch specifications
at Restrictions on Patches.

When you finish developing your patch, in your patch organization:
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1. Click Setup ➤ Create ➤ Packages and click the name of the package you were developing.
2. Click Upload. Notice that you can change the Version Name, and the Version Number's patchNumber was

incremented. Click Continue. Your patch version is now created.

To schedule a push upgrade:

1. Log back into your main development organization.
2. Under Setup ➤ Create ➤ Packages, click the name of the package that has a patch you want to push. On the package

detail page, click Push Upgrades.
3. Click Schedule Push Upgrades.
4. Select a package version to patch from the Patch Version drop-down list. Only packages that have been uploaded from

a patch organization are available in this list.
5. Enter a Scheduled Start Date indicating when a push upgrade should begin.
6. Optionally, click Ignore Apex test failures during upgrade.

Caution:

This checkbox should be selected in rare cases when a push upgrade is failing due to an Apex test failure. Only
select this option if both you and your subscriber have reviewed the package you want to upgrade and both agree
that upgrading to the new version is safe. For more information on why your install might have failed, see the
packaging FAQ.

7. In the Select Target Organizations section, select the organizations to receive your push upgrade. The list view displays
25 eligible organizations per page. If an organization already received a push upgrade for the selected package version, it
won't appear in this list. You can select organizations by:

• Entering a term that filters based on an organization's name or ID. Names can match by partial string, but IDs must
match exactly.

• Choosing between production and sandbox organizations from the Organizations drop-down list
• Clicking on individual organizations, or the Select All and Deselect All checkboxes

This section also lists the following information (in alphabetical order):

DescriptionField

The current package version an organization has installed.Current Version

The ID that uniquely identifies the organization to
salesforce.com.

Organization ID

The name of the organization. Clicking this name shows
the upgrade history for the organization.

Organization Name

The name of the contact who installed the package.Primary Contact

Tip:  Push the patch to your own organization first so that you can test and fix any failures before upgrading
subscribers.

8. Click Schedule.
9. After your patch is successfully distributed to subscriber organizations, deprecate any previous versions of the package.
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On the Push Upgrade History page, the Recent Push Jobs section displays a list of recent scheduled pushes for the package.
While a push upgrade is in progress, you can click Abort to stop it.

Best Practices

Consider the following when scheduling a push:

• Pushes can be scheduled to run immediately, or at a future date.
• Visible changes to a package shouldn't be made. Subscribers aren't notified of push upgrades, and it's your responsibility

to notify them of any visual or behavioral changes.
• Only ignore Apex tests after confirming with your customer that it's safe to upgrade.
• Visualforce pages that are viewed during a push upgrade lose their view state if the page or controller is changed.
• Beta versions aren't eligible for push.
• While a push upgrade is in process, the subscriber organization is locked from setup, and can't install any other packages

or perform administrative operations like creating objects or fields. We strongly suggest that you push an upgrade during
off-peak hours.

If an organization is already locked, the push upgrade attempts to retry the push up to five times. If after five times the
push isn't successful, it fails.

• A push upgrade succeeds even if a package license has expired.
• To push new translations for existing components, add the languages for those translations to the package when you upload

it as a major release. Then, add the individual translations in patch releases.

Sophisticated Data Modeling with Multilevel Master-Detail
Relationships

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in : Contract Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

In Spring '10, master-detail relationships are enhanced to include multiple levels. For example, in addition to defining a
two-object master-detail relationship, such as Account-Expense Report, you can extend the relationship to subdetail records,
such as Account-Expense Report-Expense Line Item. You can then perform operations across the master-detail-subdetail
relationship.

About Multilevel Master-Detail Relationships

With multilevel master-detail relationships, you can:

• Create complex data models with linked master-detail relationships
• Create reports with data from all levels of your complex data model
• Perform cascading deletes when the master record is deleted, removing the need to delete "orphaned" subdetail records
• Include line-item records that reside in the subdetail objects in roll-up mathematical calculations
• Define custom report types that use data across the multilevel master-detail relationship
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Multilevel Master-Detail Relationship Examples

Using this master-detail-subdetail relationship example, you can calculate the candidate's total rating or overall average based
on the Review object data:

• Candidate (master custom object)-Job Application (detail custom object)-Review (subdetail custom object)

This example represents an account with an opportunity to sell a product with accessories at a defined price:

• Master object Account-Detail object Opportunity-Subdetail custom object Product-Subdetail custom object
Accessories-Subdetail custom object Price

Rules for Multilevel Master-Detail Relationships

The rules for multilevel master-detail relationships are similar to the rules for master-detail relationships, but extend to linked
subdetail records:

• When a master record is deleted, the related detail and subdetail records are also deleted.
• The Owner field on the detail and subdetail records is not available and is automatically set to the owner of the master

record. Custom objects on the “detail” side of a master-detail relationship cannot have sharing rules, manual sharing, or
queues, as these require the Owner field.

• The security settings for the master record control the detail and subdetail records.
• The master-detail relationship field (which is the field linking the objects) is required on the page layout of the detail and

subdetail records.
• The master object can be a standard object, such as Account or Opportunity, or a custom object.

Additional considerations and implementation notes

• To create multilevel master-detail relationships, you need the "Customize Application" user permission.
• When you define a master-detail relationship, the custom object on which you are working is the “detail” side. Its data can

appear as a custom related list on page layouts for the other object.
• If a custom object is detail or subdetail component a master-detail relationship, it cannot also be the master of a different

master-detail relationship.
• You can have up to three custom detail levels.
• Standard objects cannot be on the detail side of a custom object in a master-detail relationship.
• An object can appear once in multilevel master-detail relationships. For example, a subdetail object in one multilevel

master-detail relationship cannot also be the owner of the master object in another multilevel master-detail relationship.
A subdetail object cannot also be the master object of the subdetail object's detail object.

• You cannot create a master-detail relationship if the custom object already contains data. You can, however, create the
relationship as a lookup and then convert it to master-detail if the lookup field in all records contains a value.

• Converting relationships from lookup to master-detail, or from master-detail to lookup behaves the same as for two-object
master-detail relationships. That is, the two linked objects in the detail-subdetail1, or subdetail1-subdetail2 relationship
have the same conversion limits as the master-detail relationship.

• Roll-up summary fields work as in two-object master-detail relationships. A master can roll up fields on detail records;
however, it cannot directly roll up fields on subdetail records.To achieve this, the detail record must have a roll-up summary
field for the field on the subdetail record, allowing the master to roll up from the detail's roll-up summary field.

• You can use multilevel master-detail relationships in custom report types.The Allow Reports checkbox must be checked
when you create the custom object. Custom report types created for multilevel master-detail relationships count towards
the organizations custom report type limit and no reports are generated if this limit is exceeded. See “Salesforce.com
Editions and Limits” in the Salesforce.com online help.

• “Custom junction objects” in the Salesforce.com online help, cannot have detail objects. That is, a custom junction object
cannot become the master object in a multilevel master-detail relationship.

• You cannot delete a custom object if it is on the master side of a master-detail relationship.
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• When you delete a custom object that is on the detail side of a master-detail relationship, the relationship is converted to
a lookup relationship. If you restore the custom object, you must manually convert it to a master-detail. See “Changing
Custom Field Type” in the Salesforce.com online help.

• Undeleting the master record also undeletes detail and subdetail records.

Rich Text Support—Beta
Available in: Personal, Professional, Enterprise, Unlimited, and Developer Editions

You asked for it! This enhancement is an idea from the IdeaExchange.

Note: This release contains a beta version of the rich text area field that is production-quality but has known limitations.
The most significant limitation is the inability to convert long text area fields to rich text area fields.

In Spring '10, rich text area custom fields are available in beta release. With the use of a tool bar, users can format the field
content and add images and hyperlinks. The toolbar allows the user to undo, redo, bold, italicize, underline, strike-out, add
a hyperlink, upload or link to an image, modify alignment, add a numbered or non-numbered list, indent, and outdent. The
maximum field size is 32,000 characters, inclusive of all the formatting and HTML tags. The maximum size for uploaded
images is 1MB. Only gif,jpeg and png file types are supported. See “Adding Fields and Relationships” in the Salesforce.com
online help.

Implementation Tips

Before creating rich text area custom fields, note the following:

• Salesforce.com supports up to 32,000 characters for each rich text area field, including the HTML tags. If desired, you
can set a lower limit.

• When you view or print content, Salesforce.com preserves the formatted version of the HTML in rich text area fields.
• Searches of content that contains rich text area fields ignore images and tags.
• When exporting to an Excel spreadsheet, rich text area field data is exported as text and truncated after 255 characters.
• Deleting a rich text area field moves it to the Deleted Fields section on the custom object or Salesforce Knowledge article

types.
• The maximum field size is 32,000 characters, including formatting and HTML tags.
• Maximum size for uploaded images is 1 MB. Only gif, jpeg and png file types are supported.
• There is no support for disabling specific rich text area features. For example, you can't disable support for hyperlinks or

images on certain fields.
• HTML code is not supported in the editor. HTML code is treated as text.
• JavaScript or CSS is treated as text. For example, if you're creating an Idea through the API, any JavaScript or CSS code

is removed without warning.
• If you're creating an Idea through the API, some tags and attributes are filtered without warning. Salesforce.com supports

a limited number of approved HTML tags.
• Inline editing is not supported for rich text area fields.
• Rich text area fields can be filtered and summarized in reports, but the HTML tags are included as text.
• Rich text area fields aren't available in self service portals. They are available in partner portals and customer portals.
• Images uploaded within a rich text area field are extracted in the organization's weekly export and included in the exported

data.
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• The mobile application treats the rich text area field like a long-text area field, which doesn't support formatted HTML
content and images. The mobile application truncates the field at 1,000 characters, and the 1,000 character limit includes
HTML markup. Administrators should consider removing rich text area fields from mobile page layouts. If a mobile user
edits a rich text area field containing an existing text entry over 1,000 characters, the mobile application will truncate the
text in the field.

Beta Limitations

• You can't convert rich text area fields into any other data type.
• The text part of rich text area fields counts towards data storage for the entity that contains the field. The uploaded images

within the rich text area fields are counted towards file storage for the entity that contains the field.
• The rich text area field is available in the API but without support for uploading images.
• You can't publish rich text area fields in Salesforce to Salesforce.

Best Practices

• You can specify how big the editor box should be for this field by configuring the “Number of lines displayed” property in
the field’s setup.

• We recommend using the rich text area field in a one column page layout; the field's formatting toolbar is ideal for a single
column.

Sites Enhancements
Available in: Developer, Enterprise, and Unlimited Editions

Spring '10 includes new features that improve the capabilities of Force.com sites. To access these features, Force.com sites
must be enabled for your organization.

• Workflow for Sites
• Force.com Sites: Authenticated Sites Generally Available
• Sites Additions in the Force.com Web Services API

About Sites Enhancements

Workflow for Sites

User Permissions Needed

“Customize Application”To create or change workflow rules:

“Customize Application”To create and edit Force.com sites:

With workflow for sites, you can create workflow rules that trigger email alerts when certain site-related criteria are met. For
example, create a rule that sends your site administrator an email alert when bandwidth usage reaches 80% of the daily bandwidth
limit or when a site's status changes from the active state.
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Setting up the right site usage workflow rules can help you keep your sites from exceeding rolling 24-hour limits for bandwidth
and service request time, and monthly limits for page views. Workflow rules that are created on the Site object are evaluated
every hour for all sites within the organization, unless your criteria is limited to certain sites. Workflow rules that are created
on the Organization object are evaluated every three hours. Workflow rules are also evaluated whenever a site is edited or
saved.

Only email alerts actions are supported for site usage workflow rules. Other workflow actions, such as field updates, tasks, and
outbound messages, are not available.

To create a site usage workflow rule:

1. Click Setup ➤ Create ➤ Workflow & Approvals ➤ Workflow Rules.
2. Click New Rule.
3. Choose a workflow object:

• Use the Site object for site detail, daily bandwidth and request time, monthly page views allowed, and other fields
• Use the Organization object for monthly page views allowed and used fields

4. Click Next.
5. Enter a rule name.
6. Optionally, enter a description for the rule.
7. Enter your rule criteria by doing one of the following:

• Choose criteria are met and select the filter criteria that a site must meet to trigger the rule. For example, to
trigger the rule every time the active status changes for a site within your organization, set the filter to Site Status
not equal to Active. To add more rows or to set up Advanced Filter Conditions, click Advanced
Options....

• Choose formula evaluates to true and enter a formula. The rule is triggered if the formula returns “True.”
For example, the following formula triggers the rule when bandwidth usage reaches 80% of the daily bandwidth limit:

1000000 * DailyBandwidthUsed >= 0.8 * DailyBandwidthLimit

Note:  In this example, since DailyBandwidthUsed is measured in bytes and DailyBandwidthLimit is
measured in megabytes, a factor of one million is included in the first part of the formula.

8. Click Save & Next.
9. In the Periodic Workflow Actions section, click Add Workflow Action and choose New Email Alert or Select

Existing Action.

Tip: To create custom email templates using Site merge fields, click Setup ➤ Communication Templates ➤
Email Templates, then New Template. When configuring the template, use Site merge fields by selecting Site
Fields in the Select Field Type drop-down list of the Available Merge Fields section.

10. Configure the workflow action and click Save.
11. Click Done when you have finished adding workflow actions.
12. To activate the rule, click Activate on the workflow rule detail page.
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Force.com Sites: Authenticated Sites Generally Available
With Spring '10, the Authenticated Website User user license is generally available. Authenticated site users are limited-access
portal users intended for organizations with many thousands to millions of portal users. Unlike other portal users, authenticated
site users don't have roles, eliminating performance issues associated with role hierarchy calculations. For more information,
see High Volume Customer Portal Users on page 102.

Sites Additions in the Force.com Web Services API
In Spring '10, the Force.com Web Services API includes new Site and SiteHistory objects, and the Organization object
includes two new site-related fields. For more information, see Force.com Web Services API Enhancements on page 133.

Portal Health Check
Available in: Enterprise, Unlimited, and Developer Editions

Customer Portals and partner portals let you collaborate with and provide services to your customers and partners. With
portals, you share and capture information from third-party users. To ensure that you don't expose more information than
intended, it's important to follow best practices for portal implementation.

Your customers and partners can access your information via portals in many ways. In Spring '10, administrators can use portal
health check reports to easily monitor this access. Portal health check reports show your security-related portal settings and
provide information you can use to improve portal security.

Note:  Currently, portal health check reports show sensitive administrative and user permissions, object permissions,
field-level security, organization-wide default settings, and custom sharing rules. Your portal users can access records
via other means, including manual sharing, Apex managed sharing, territories, list views, groups, queues, teams, content
workspaces, and folders.

To view portal health check reports, click Setup ➤ Security Controls ➤ Portal Health Check, then click the report you
want.

The following reports are included:

• Administrative and User Permissions
• Object Access and Field-Level Security
• Sharing Organization-Wide Defaults
• Sharing Rules

Note: The portal health check reports don't include information for High Volume Customer Portal users, Authenticated
Website User users, or Self-Service portal users.
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About Portal Health Check Reports

Viewing the Administrative and User Permissions Report

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

To view portal health check reports:

“Manage Users”

AND

“Modify All Data”

Profile permissions are powerful, as they expand users' access to data. It's important to use caution when setting permissions
for a profile.

The Administrative and User Permissions report—one of the portal health check reports—shows portal profiles and their
critical permission settings. For each profile, the report lists the number of portal users assigned to it, and the following
permission settings:

• Delegated Portal User Administrator
• Send Email
• Convert Leads
• Edit Events
• Edit Opportunity Product Sales Price
• Edit Tasks
• Transfer Cases
• Portal Super User
• View Articles
• API Enabled
• Password Never Expires
• Create Workspaces
• View Content in Portals
• Export Reports
• Run Reports

Note:  Depending on your organization's settings, some permissions may not appear in the report.
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From the report, you can drill down to portal profile detail pages, where you can edit or clone a profile, or view the users
assigned to a profile.

To view this report:

1. Click Setup ➤ Security Controls ➤ Portal Health Check.
2. Click Administrative and User Permissions.

From the report page, you can do any of the following:

• To view a profile detail page, click the profile name.
• To show a filtered list of items, select a predefined view from the drop-down list.
• To return to the list of reports, click Back to list: Portal Health Check Reports.

Viewing the Object Access and Field-Level Security Report

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

To view portal health check reports:

“Manage Users”

AND

“Modify All Data”

Object permissions specify the access that users have to standard and custom objects. The following object permissions respect
the sharing model:

• Read—users can only view records of this type
• Create—users can read and create records
• Edit—users can read and update records
• Delete—users can read, edit, and delete records

Field-level security specifies the access that users have to specific fields in object records.

The Object Access and Field-Level Security report—one of the portal health check reports—shows the number of portal
profiles that can access each standard and custom object in your organization. You can view each object's field-level security
settings and permissions. The object-specific reports list portal profiles, showing the number of users assigned to each profile,
the number of visible fields in an object, and the object permissions. You can drill down to portal profile detail pages, where
you can edit or clone a profile, or view the users assigned to a profile. You can also drill down to field-level security detail
pages, where you can edit the settings.

To view this report:

1. Click Setup ➤ Security Controls ➤ Portal Health Check.
2. Click Object Access and Field-Level Security.
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3. From the report page, click an object name to view its field-level security settings and permissions by profile.

On the object detail page, you can do any of the following:

• To view a profile detail page, click the profile name.
• To view a profile's field-level security detail page, click visible fields.
• To return to the high-level object access and field-level security report, click Object Access and Field-Level Security.

From both report pages, you can do any of the following:

• To show a filtered list of items, select a predefined view from the drop-down list.
• To return to the list of reports, click Back to list: Portal Health Check Reports.

Viewing the Sharing Organization-Wide Defaults Report

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

To view portal health check reports:

“Manage Users”

AND

“Modify All Data”

“Manage Users”

AND

To set default sharing access:

“Customize Application”

Organization-wide default settings specify each object's default access level for users in your organization. If an object's default
access level is Public, users with enabled object permissions (“Read,” “Create,” “Edit,” or “Delete”) may be able to access records
that they don't own. For example, if the default access setting for the account object is Public Read/Write, then any user with
the “Read” permission on the account object can view any account record. When setting organization-wide defaults, you want
to make sure you don't let portal users see objects they shouldn't access.

The Sharing Organization-Wide Defaults report—one of the portal health check reports—lists standard and custom objects
and the default access setting for each object. You can use this report to review and edit the organization-wide default settings
that may expose records to portal users.

To view this report:

1. Click Setup ➤ Security Controls ➤ Portal Health Check.
2. Click Sharing Organization-Wide Defaults.

The report lists the default access setting for each object. If an object's default access is Public, Show Details (for calendar),
or Use (for price book), any portal users with enabled object permissions can access other users' records, and the Security
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column indicates a weak organization-wide default setting. You can view the specific object permissions granted to portal
profiles in the Object Access and Field-Level Security report.

If the object's default access is Private, Hide Details (for calendar), or No Access (for price book), the Security column
indicates a strong organization-wide default setting.

Note:  Even with a strong organization-wide default setting, portal users may have access to other users' records
through exceptions such as sharing rules.

If the Grant Access Using Hierarchies box is checked, any user above a record owner in a territory or role hierarchy can
access the owner's records for that object.

From the report page, you can do any of the following:

• To change the organization-wide sharing settings for any object, click Edit, then change the settings on the
Organization-Wide Sharing Defaults Edit page.

• To show a filtered list of items, select a predefined view from the drop-down list.
• To return to the list of reports, click Back to list: Portal Health Check Reports.

Viewing the Sharing Rules Report

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

To view portal health check reports:

“Manage Users”

AND

“Modify All Data”

“Manage Users”To set sharing rules:

Administrators can use sharing rules to give sets of users access to records they don't own. In a sharing rule, records owned
by a set of users (such as a group, role, or territory) are shared with another set of users. When creating sharing rules, you want
to make sure you don't let portal users see records they shouldn't access.

The Sharing Rules report—one of the portal health check reports—lists all sharing rules that give portal users access to records
they don't own. For each sharing rule, the report specifies whether any portal users have access to records, and lets you edit
access levels for the rule. For some types of user sets (like groups, roles, and territories), you can drill down to detail pages,
where you can edit, delete, or manage the users in the set.

To view this report:

1. Click Setup ➤ Security Controls ➤ Portal Health Check.
2. Click Sharing Rules.
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The Sharing Set Includes Portal Users checkbox indicates whether the sharing rule gives access to any portal users. Portal
users gain access if they are specified in the rule, or if they are above other users in the role or territory hierarchy and Grant
Access Using Hierarchies is enabled for the object. If any users in this set have enabled object permissions (“Read,”
“Create,” “Edit,” or “Delete”), they can access records exposed by the rule.

Note: This report doesn't check portal users' object permissions. You can view the specific object permissions
granted to portal profiles in the Object Access and Field-Level Security report.

From the report page, you can do any of the following:

• To change the access level in a sharing rule, click Edit, then change the settings on the sharing rule edit page.
• To view the details of a user set in a sharing rule, click the link in the Owned By or Shared With column.
• To show a filtered list of items, select a predefined view from the drop-down list.
• To return to the list of reports, click Back to list: Portal Health Check Reports.

Note:  Account and account territory sharing rules can grant access to contacts, opportunities, and cases associated
with the shared accounts.The Sharing Rules report shows access levels only for top-level objects, not associated objects.

Additional Custom Cloud Enhancements
Enhanced Security for Custom Object Permissions

Available in: Enterprise, Unlimited, and Developer Editions

Spring '10 introduces enhanced security for custom object permissions. In Enterprise, Unlimited, and Developer Editions,
when you create a custom object, the “Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” permissions for that
object are disabled for any profiles in which “View All Data” or “Modify All Data” is disabled. This ensures that all users don't
immediately get full access to custom objects.

You can change these permissions in custom profiles, but not standard profiles. That is, users with standard profiles (except
System Administrator) can't access new custom objects—you must assign them custom profiles and edit the profiles.To enable
access to custom objects, do one of the following:

• For users with standard profiles:

1. Clone the profiles of the users whose object permissions you want to change.
2. Edit the custom profiles, enabling the permissions you want.

Tip: If enhanced profile management is enabled for your organization, you can edit multiple profiles from the
list view.

3. Edit the users' accounts, assigning the appropriate cloned custom profiles.

• For users with custom profiles, simply edit their profiles, enabling the permissions you want.

Note: In Contact Manager, Group, and Professional Editions, when you create a custom object, the “Read,” “Create,”
“Edit,” and “Delete” permissions for that object are enabled for all profiles.
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Globalization Enhancements

Bulgarian and Greek—New Languages Supported

Available in: All Editions

In Spring '10, Bulgarian (bg) and Greek (el) are now available upon request as Salesforce.com end user languages.

Users can update their personal language settings as follows:

1. Click Setup ➤ My Personal Information ➤ Personal Information.
2. Click Edit.
3. Select a language from the Language picklist.
4. Click Save.

Translation Workbench Enhancements

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Spring '10 introduces a new translation workbench. The translation workbench lets you specify languages you want to
translate, assign translators to languages, create translations for customizations you’ve made to your Salesforce.com
organization, and override translations from managed packages. Everything from custom picklist values to custom fields
can be translated so your global users can use all of Salesforce.com in their language..

Enabling the workbench makes some changes to your Salesforce.com organization:

• Picklist values must be edited individually. This means you can’t mass edit existing picklist values, though you can
still mass add new values.

• When picklist values are sorted alphabetically, the values are alphabetical by the organization's default language.
• Reports have a Language drop down on the filter criteria page when any filter criteria uses the "starts with", "contains",

or "does not contain" operators.
• Import files have a Language drop down and all records and values within the import file must be in that language.
• Web-to-Lead and Web-to-Case have a Language drop down before you generate the HTML.

To enable the translation workbench:

1. Click Setup ➤ Translation Workbench ➤ Translation Settings.
2. On the welcome page, click Enable.

To disable the translation workbench, click Setup ➤ Translation Workbench ➤ Translation Settings ➤ Disable.

Note:  In a Developer organization with a managed package containing translations, once the Translation
Workbench is enabled, it can't be disabled.
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Global Visualforce Email Templates

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Spring '10 introduces Visualforce email templates translation based on, for example, the recipient user's language or the
language specified for an account.

To translate Visualforce email templates based on recipients' or related objects' languages, use the
<messaging:emailTemplate> tag's language attribute (valid values: Salesforce.com supported language keys, for
example, “en-US”). The language attribute accepts merge fields from the email template's recipientType and
relatedToType attributes. You create custom language fields for use in the merge fields. The translation workbench
is required to translate email templates.

This example uses a merge field to obtain a language attribute for the contact receiving the email:

<messagingmessaging:emailTemplate subject="Welcome to Dreamforce!" recipientType="Contact"
relatedToType="Account" language="{!recipient.language__c}">
<messaging:plainTextEmailBody>
{!$Label.greeting}
</messaging:plainTextEmailBody>
</messaging:emailTemplate>

Increased Maximum Limit for Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Organizations can now create a maximum of 1000 rules, increased from 500. Limits apply to any combination of workflow,
assignment, auto-response, and escalation rules, both active and inactive.

Lookup Filter Beta Enhancements

Available in: All Editions

In Winter '10, Salesforce.com introduced a beta version of lookup filters—administrator settings on lookup, master-detail,
and hierarchical relationship fields that restrict the valid values and lookup dialog results for the field. In Spring '10 you can:

Define Optional Lookup Filters
Define fields with optional lookup filters. For fields with optional lookup filters, only values that match the lookup filter
criteria appear in the lookup dialog initially; however, users can click a Show all results link in the lookup dialog to
remove the filter and view all search result values for the lookup field. Also, optional lookup filters allow users to save
values that do not match the lookup filter criteria, and do not display an error message if a user tries to save such values.

On the Fields page, a funnel icon with an asterisk ( ) denotes fields with active required lookup filters, while a funnel
icon without an asterisk ( ) denotes fields with active optional lookup filters.
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Salesforce.com does not limit the number of active optional lookup filters for each object; however, the limit of five
active required lookup filters per object still applies.

As with required lookup filters, the filter criteria for optional lookup filters can include fields from both the lookup object
and objects directly related to the lookup object (one level only). Unlike required lookup filters, optional lookup filters
don't count against the limit on the number of unique relationships allowed per object.

Create Lookup Filters that Reference Assets, Entitlements, Quotes, and Service Contracts
Create lookup filters that reference assets, entitlements, quotes, and service contracts, which were unsupported in Winter
'10.

Select Profile Names in Filter Criteria
If you enter Current User Profile: Name or Profile: Name in the Field column of your lookup filter criteria,
Salesforce.com displays a lookup icon in that row. Click the lookup icon to select from a list of existing profiles rather
than typing profile names.

Number of Remote Access Application Authorizations Increased

Available in: All Editions

In Spring '10, users can authorize a remote access application to access their Salesforce.com data more than once. The default
limit is five. You must grant access to your Salesforce.com data from each device you use, such as a laptop and a desktop
computer. If a user tries to grant access to an application more than the organization limit, the access token for that application
that hasn't been used for the longest period of time is revoked.

No Framing Allowed on Login Page

Available in: All Editions

As of Spring '10, Salesforce.com no longer allows framing of the login page.

Sites Doesn't Support SAML

Sites doesn't support SAML, which means you can't setup single sign-on for Sites in Spring '10.

Search Enhancements

Available in: All Editions

Enable Sidebar Search Auto-Complete Setting
If this setting is enabled, when users start typing search terms, the sidebar search displays a matching list of recently
viewed records. This feature is enabled by default at Setup ➤ Customize ➤ Search ➤ Search Settings.

Enable Single-Search-Result Shortcut Setting
If this setting is enabled, users skip the search results page and go directly to the record's detail page when their search
returns only a single item. To enable this feature, go to Setup ➤ Customize ➤ Search ➤ Search Settings.

Auto-Complete Enhancements
Spring '10 includes the following improvements to auto-complete:
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• Lookup auto-complete now works with inline editing. In previous releases, auto-complete was only supported in
standard edit mode. See “Editing Data Using Inline Editing” in the Salesforce.com online help.

• Auto-complete now matches against a larger set of your most recently viewed items (up to 100 items per object).
• Auto-complete now includes enhanced interaction with auto-complete results. For example, auto-complete now

matches the beginning of any word in a record, not just the first word.

Packageable Standard Action Overrides

You asked for it! This enhancement is an idea from the IdeaExchange.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Standard action overrides on buttons and links are now packageable for custom objects. Developers can also create action
overrides using the Metadata API. Through this, it's possible to include a custom UI with your apps. Subscribers can accept
these overrides in an installed package, create their own, or revert to the standard Salesforce.com behavior.

Workflow Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

Personalized Email Alerts
You can now set the From Email Address in email alerts to the address of the default workflow user.

To use the default workflow user's address as your From Email Address in an email alert:

1. Click Setup ➤ Create ➤ Workflow & Approvals ➤ Email Alerts
2. Click Edit to update an existing email alert. If you don't have any email alerts yet, see “Creating Email Alerts for

Workflow, Approvals, or Milestones” in the Salesforce.com online help.
3. Scroll down to the From Email Address field. The default value is Current User's email address.
4. Select Default Workflow User's email address.
5. Optionally, select the Make this the default From email address for this object's email

alerts checkbox.

Note:  If you select Make this the default From email address for this object's email alerts, it overrides the
From Email Address for all email alerts associated with that object. Upon saving, a dialog box prompts
you to confirm your selection. You can still customize individual email alerts to use a different From Email
Address.

6. Click Save.

API Version Added to Outbound Messages
In Spring '10, outbound messages include a new API Version field. Previously, all outbound messages used API
version 8.0. Now, the API Version field is automatically set to the current API version when the outbound message
was created. This API version is used in any API calls back to Salesforce.com using the enterprise or partner WSDLs.
The API Version can only be modified by using the Metadata API.
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New: The Force.com Workbook
The Force.com Workbook includes a set of ten thirty-minute tutorials that introduce the Force.com Platform to administrators
and new Force.com developers. These tutorials take you step-by-step through the creation of a custom inventory application
for a book warehouse, culminating in the creation of a public Web store front (using sites) and a stand-alone desktop application
using Adobe Flash Builder for Force.com.

The complete list of tutorials includes:

• Creating a Warehouse Application
• Adding Relationships
• Using Formulas and Validation Rules
• Using Workflow and Approvals
• Adding Business Logic with Apex
• Adding Tests to Your Application
• Building a Custom User Interface with Visualforce
• Creating a Public Web Page with Force.com Sites
• Creating a Desktop App with Adobe Flash Builder for Force.com

You can access the Force.com Workbook online from the Developer Force Documentation page.

New: Developer Cheat Sheets

You asked for it! This enhancement is an idea from the IdeaExchange.

Spring '10 also introduces four new cheat sheets for developers. Each one- to four-page PDF includes handy reference
information for the most commonly used Apex, Visualforce, API, and formula syntax:

• Apex Developer's Cheat Sheet

• Formula Developer's Cheat Sheet

• Visualforce Developer's Cheat Sheet

• Web Services API Developer's Cheat Sheet

You can access developer cheat sheets from the Developer Force Documentation page or from developer.force.com/cheatsheets.

DOCUMENTATION ENHANCEMENTS
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Update: Force.com Fundamentals
The latest edition of Force.com Fundamentals includes more features and functionality than ever before, including a newly
expanded final chapter that shows how non-programmers can use Visualforce and sites to create richer, more powerful
functionality in their applications. Other newly incorporated features include:

• The enhanced page layout editor
• The approval process visualizer
• The “Modify All Records” and “View All Records” permissions
• Delegated administration groups

Anyone can access Force.com Fundamentals online from the Developer Force Documentation page, or Developer Force members
can download a PDF and the sample data files at developer.force.com/books/fundamentals.

Update: Force.com Cookbook
The Force.com Cookbook is a compilation of code samples that show you how to extend your Force.com apps using workflow,
approvals, Apex, Visualforce, the API, email, and sites. This edition includes updated recipes as well as these new recipes:

• Updating a Field on a Parent Record
• Creating Custom Help
• Redirecting to a Standard Object List Page
• Referencing an Existing Page
• Defining Skeleton Visualforce Templates
• Using Batch Apex to Reassign Account Owners
• Using Custom Settings to Display Data
• Integrating Visualforce and Google Charts
• Creating a Sitemap File
• Creating a Web-to-Lead Form for Your Force.com Site
• Implementing Single Sign-On for Clients
• Retrieving Information from Incoming Email Messages
• Creating Records from Information in Incoming Email Messages
• Retrieving Email Attachments and Associating Them with Records
• Creating Email Templates and Automatically Sending Emails

Anyone can access the Force.com Cookbook online from the Developer Force Documentation page, or Developer Force members
can download a PDF at developer.force.com/books/cookbook.

Update: How to be Successful with Salesforce.com
The table of contents of How to be Successful with Salesforce.com, the comprehensive PDF guide for users and administrators,
is now reorganized to make it easier to find the information you want based on the apps you're using. The top-level sections
now include:

• Welcome
• Working in Salesforce.com
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• Building Apps
• Selling
• Marketing
• Reporting
• Providing Support
• Partner Selling
• More Resources
• Checkout

You can access How to be Successful with Salesforce.com from the Help & Training window in Salesforce.com.

Update: Salesforce.com Style Guide for Documentation
and User Interface Text

The Salesforce.com Style Guide for Documentation and User Interface Text includes guidelines for writing about Salesforce.com
features and functionality. You can use this guide to write text that sounds just like Salesforce.com. The table of contents for
this guide is now reorganized into a glossary format, from A to Z. The guide also now includes grammar guidelines.

You can access the Salesforce.com Style Guide for Documentation and User Interface Text from the Developer Force Documentation
page.

Update: Salesforce.com Field Reference

You asked for it! This enhancement is an idea from the IdeaExchange.

The Salesforce.com Field Reference now includes a definitive list of all the standard fields for standard objects in Salesforce.com.
The label, API name, data type, maximum length, precision, and scale are listed for each field. Previously, this guide did not
include a complete list of all standard objects and fields.

You can access the Salesforce.com Field Reference from the Developer Force Documentation page.

Update: Syntax Highlighting and Clipboard Copy for
Developer Guides

Spring '10 also introduces syntax highlighting and clipboard copy for code samples in HTML versions of the following
developer reference guides:

• Adobe Flash Builder for Force.com Developer's Guide

• AJAX Toolkit Developer's Guide

• Force.com Apex Code Developer's Guide

• Force.com Bulk API Developer's Guide

• Force.com Cookbook

• Force.com Fundamentals

• Force.com Migration Tool Guide
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• Force.com Web Services API Developer's Guide

• Force.com Workbook

• Visualforce Developer's Guide

To use clipboard copy, click the Copy this code ( ) icon above any syntactically correct code sample. You can then paste
the code sample into the editor of your choice with all formatting intact.

Clipboard copy relies on Flash 10 to render appropriately in all browsers that Salesforce.com supports. If you don't have Flash
installed, the icon won't display.

You can access all developer reference guides from the Developer Force Documentation page.

Update: Documentation on Supported Locales, Currencies,
and Time Zones

In Spring '10, you can find all supported locales, currencies, and time zones in the online help.
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